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How to Use This Manual

The Tutorials of the manual go through every menu item in the Menu Bar.

Depending on the product you have purchased (AutoDeblur Gold, AutoDeblur Silver, 
AutoDeblur 2D, or AutoVisualize) some sections may not apply to you (this will be clearly indi-
cated at the beginning of the corresponding tutorial).
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Installation, Transferring a License, Uninstalling, and 
Hardware Requirements

Sales Information

AutoQuant Imaging, Inc.
877 25th Street
Watervliet, NY 12189

E-mail: sales@aqi.com
Website: www.aqi.com
Ph.: 518-276-2138
Fax: 518-276-3069

Technical Support

Internet: support.aqi.com
Ph.: 518-276-2138
Fax: 518-276-3069

Software and Hardware Requirements - Windows Systems

Windows 98/ME/2000/XP. 256MB RAM, minimum (1GB RDRAM, PC800 or faster recom-
mended). 1GB free disk space (10GB recommended (for image storage)). A minimum of an Intel 
Pentium 3 processor, recommended Pentium 4 1.5GHz processor or better. A minimum screen 
resolution of 1024x768 (1280x1024 recommended). A 24-bit SVGA display. CD-ROM drive.

Larger memory sizes are recommended for improved performance, keeping in mind that the oper-
ating system, the window interface and potential tasks of other concurrent tasks make strong 
demands on memory resources.

The sample 3D images that are supplied with the software require approximately 350MB of disk 
storage. It is recommended that due to the inherently large size of 3D images, the images be 
stored on large volume expandable media such as CD-ROMs, rewritable CDs or DVDs. For rou-
tine use, a disk drive of capacity 2GB or larger is recommended.

The Volume Projection - Hardware selection in the 3D viewer requires a video card which sup-
ports OpenGL extensions. It is recommended that an ATI Radeon 9600 series or higher be used 
for the 3D Visualization. Following is an non-inclusive list of consumer level video cards which 
support OpenGL coding:

-ATI Radeon 8500, 9000, 9700
-Diamond FireGL1
-nVidia GeForce 256, GeForce 2, GeForce 2 MX, GeForce 3, GeForce 4, all Quadro lines
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-3D Labs Oxygen GVX1 and Wildcat family
-Matrox Parhelia

Software Installation

To install complete the following procedure:

(1) Insert the software CD-ROM into your CD-ROM drive.

(2) Choose the Start button on the taskbar (usually located at the lower left-hand corner of 
your screen) and select Run.

(3) Type the letter of your CD-ROM drive followed by a colon (:) and type Setup, 
 (E.g. E: Setup). Then choose OK. 

Note: E represents the letter of your CD-ROM drive. If the letter of your CD-ROM drive is not E, 
type the correct letter in its place.

The Setup wizard will then proceed with the installation of the software to your hard disk drive 
(usually the C drive). You can find the installed folder by looking in the following directories: 
C:\Program Files\AutoQuant\AutoQuant Combination Suite 9.3

Dongle Installation and Requesting a Permanent License

All AutoQuant products will run for one month following their initial installation on your com-
puter. During this time you will need to contact AutoQuant for a permanent license so that you 
can continue using your software beyond the initial trial period. Once you have purchased a per-
manent license, you will receive a CD and dongle, at which point you can follow the instructions 
below.

Installing Version 9.0 and Subsequent Releases

(1) Make sure that the dongle is not plugged into the USB port. It will be plugged in after 
installation has completed.

(2) Run the setup.exe program from the installation CD.

(3) Follow the instructions that come up during installation. If the new version is being 
installed on a machine that already has the demo version installed, a Maintenance Setup screen 
will appear, providing the following options: Modify, Repair, and Remove. Select Repair; this 
will re-install the application using the dongle version of the program.

(4) When Setup has finished, the dongle may then be plugged into an open USB port on your 
machine to allow the software to run.
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Note - You can install the software onto as many machine as you would like, and activate the soft-
ware by plugging the dongle into the machine you wish to use.

Transferring (Moving) a License

For versions 9.0 and later, refer to Installing Version 9.0 and Subsequent Releases in the previous 
section.

For all versions prior to 9.0:

Floppy Disk License Transfers:
Floppy disk license transfers require a floppy disk, an authorized copy of your product installed 
on the source PC, and an unlicensed copy of your product on the target PC.

The transfer process does not jeopardize your license in any way and is completely secure 
because the floppy disk is registered to a specific PC in a specific location. This ensures the 
license can only be transferred to the target PC you specify.

Example: You want to transfer a license from PC 1 to PC 2.

(1) Ensure you meet the stipulations outlined above under Floppy Disk License Transfers.

(2) Start the program on PC 2, and select Kill License, then select Transfer Into Computer. 
Supply the floppy disk path. The program imprints its registration on the disk. 

(3) Remove the floppy disk from PC 2, and insert it into PC 1.

(4) Start the program on PC 1, and select Transfer Out of Computer. Supply the floppy disk 
path. The program reads the registration imprint file and writes a matching file to the floppy, dec-
rementing the license at the source or discontinuing it (if a single user license).

(5) Remove the floppy disk from PC1, and return it to PC 2.

(6) Click Transfer Into Computer to complete the transfer and discard the intermediate 
imprint files.

Updating the Dongle

If you have purchased additional functionality, or an extension to your maintenance or license 
agreement, you will need to update your dongle to reflect the changes in you license.

(1) Click Start->Programs->AutoQuant->AutoQuant Imaging Suite->Dongle Update.

(2) You will be presented with the following screen:
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(3) Contact AutoQuant Imaging, Inc. Provide the User Registration ID and Dongle ID shown 
in the Dongle Update Utility dialog.

• By Email: licenses@aqi.com
• By phone: 518-276-2138

(4) If the change that must be made has been approved, you will receive an update code in the 
form of a long string of letters and numbers. Enter this string into the Dongle Update Code text 
box and click Update Dongle.

(5) Upon successful update, you will receive confirmation, and the update will take effect the 
next time you run your AutoQuant product.

Starting the AutoQuant Software - Windows Systems

To start:

(1) Choose the Start button at the lower left-hand corner of your screen and select Programs.

(2) In the AutoQuant Folder, select the name of the application (either AutoDeblur or Auto-
Visualize). 

AutoUpdate

AutoQuant’s products incorporate an AutoUpdate feature, which will once a month connect to the 
internet to search for product updates automatically. If you wish to search for an update without 
waiting for the default time to pass, you can select Search for Update from the Help menu. See the 
Help chapter for more information on the AutoUpdate feature.
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Uninstalling the Software

Go to Add/Remove Programs under the Control Panel of your Operating System. The Add/
Remove Programs box will list all currently installed programs. Find and click on the name of the 
program you wish to remove. Once the name of the program you want to remove is highlighted, 
click on the Change/Remove button. The InstallShield Wizard will remove the program from your 
computer. 
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Limitation of Liability

Limitation of Liability Notice

To the maximum extent permitted by applicable law, AutoQuant Imaging, Inc. disclaims all war-
ranties, either expressed or implied, including, but not limited to implied warranties of merchant-
ability and fitness for a particular purpose with respect to the AutoQuant software package, the 
accompanying written materials, and any accompanying hardware. Specifically, the AutoQuant 
software is not guaranteed to work on every 3D microscopy image, even if it is of a type that the 
AutoQuant software is stated to be intended for in this manual.

Information furnished by AutoQuant Imaging, Inc., in this manual is believed to be accurate and 
reliable; however, AutoQuant Imaging, Inc. assumes no responsibility for its use; nor for any 
infringements of patents or other rights of third parties, which may result from its use.

No license is granted by implication or otherwise under any patent rights of AutoQuant Imaging, 
Inc.

AutoQuant Imaging, Inc. shall not be liable in any event for incidental or consequential damages 
in connection with, or arising out of the use of, the furnishing, performance, or use of this docu-
mentation, the AutoQuant software or any additional software provided for use with the Auto-
Quant software. 

To the maximum extent permitted by applicable law, in no event shall AutoQuant Imaging, Inc., 
or its dealers be liable for any damages whatsoever (including, without limitation, damages for 
loss of business profits, business interruption, academic prestige, academic funding, loss of busi-
ness information, or any pecuniary or other loss) arising from the use or inability to use this Auto-
Quant Imaging, Inc. product, even if AutoQuant Imaging, Inc. has been advised of the possibility 
of such damages. Because some states/jurisdictions do not allow the exclusion or limitation of lia-
bility for consequential or incidental damages, the above limitation may not apply to you. (In the 
event that AutoQuant is liable under implied warranty or incidental damages, the period is limited 
to one year from date of purchase).

This notice will be governed by and interpreted in accordance with the laws of the State of New 
York in the United States of America.
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Copyright Notice

© Copyright 1995 – 2003 by AutoQuant Imaging, Inc.

MANUAL: All rights reserved. This manual may not be reproduced, stored in a retrieval system, 
or transmitted, in any form, by any means, electronic, mechanical, by photocopying, recording, or 
otherwise, in whole or in part, without the written permission of AutoQuant Imaging, Inc.

SOFTWARE: United States copyright laws and international treaty provisions protect the 
AutoDeblur software package. It is illegal to copy the software except as specifically allowed in 
the License Agreement stated below. Any person found storing or using an unlicensed copy of 
this software is liable to be sued by AutoQuant Imaging, Inc. to the maximum extent permissible 
under applicable US and International laws and International Treaty Provisions.

Software License Agreement

This is a legal agreement between you (either an individual or an entity), the end user and Lic-
ensee, and AutoQuant Imaging, Inc. (“AQI” or we), the Licensor. BY OPENING THE SEALED 
MEDIA PACKAGE or by installing this software on a computer, YOU ARE AGREEING TO BE 
BOUND BY THE TERMS OF THIS AGREEMENT. By doing so, the user is acknowledging that 
he/she has carefully read and considered all the provisions of this Software License Agreement 
and agrees they are fair and reasonably required to protect AQI’s interests. The end user thereby 
agrees to all of the terms spelled out in this Agreement. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS AGREEMENT, RETURN THE UNOPENED MEDIA PACKAGE AND THE 
ACCOMPANYING DOCUMENTS TO AQI. The following information is important and should 
be treated as valuable property. Please save the following information for future use.

1. GRANT OF LICENSE: Subject to the terms of this Software License Agreement, Auto-
Quant Imaging, Inc. (“AQI”) hereby grants to a single user Licensee non-transferable (except as 
expressly provided in Section 4 below) and non-exclusive license to use and execute the Auto-
Quant software (“SOFTWARE”) on a single computer or facility (“COMPUTER”) at any time 
during the period of validity of this license. This software may only run on one computer. If you 
have a multiple-user license, the SOFTWARE may be run simultaneously by no more persons 
than the number of users licensed.

2. COPYING RESTRICTIONS: In order to affect your license rights granted in Section 1 
above, you may install the SOFTWARE by copying it onto the hard disk drive of one computer. 
You may make a full or partial backup or archival copy of the SOFTWARE for your own use, or 
use at the facility to which the SOFTWARE is licensed. You AGREE that: (i) your use and pos-
session of such copies shall be solely under the terms and conditions of this Agreement, and (ii) 
you shall place the same proprietary and copyright notices and legends on all such copies as 
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included by AQI on the media containing the authorized copy of the SOFTWARE originally pro-
vided by AQI. You may not copy or provide copies of the SOFTWARE, in whole or in part, to any 
other party.

3. SOFTWARE USE RESTRICTIONS: (a) Reverse engineering and tampering: You may 
not reverse engineer, de-compile, modify, translate, or disassemble the SOFTWARE. Any tamper-
ing with the license protection system, such as the license protection key that attaches to your 
printer parallel port, or of the SOFTWARE is not permitted. Violators will be prosecuted to the 
maximum extent permitted by applicable laws. (b) Not a Medical Device: This software is not 
intended for usage as a Medical Device. The definition of a Medical Device appears in section 
201(h) of the FD&C Act. A Medical Device is “an instrument, apparatus, implement, machine, 
contrivance, or other related article, including a component, part, or accessory, which is: (i) recog-
nized in the official National Formulary, or the United States Pharmacopoeia, or any supplement 
to them, (ii) intended for use in the diagnosis of disease or other conditions, or in the cure, mitiga-
tion, treatment, or prevention of disease, in man or other animals, or (iii) intended to affect the 
structure or any function of the body of man or other animals, and which does not achieve any of 
its primary intended purposes through chemical action within or on the body of man or other ani-
mals and which is not dependent upon being metabolized for the achievement of any of its pri-
mary intended purposes…”. (c) Usage with Confocal Microscopes: This software may be used for 
visualizing or analyzing datasets from a confocal optical microscope so long as that confocal 
microscope is licensed in conjunction with U.S. Patent No. Re. 34,214. Most confocal microscope 
manufacturers have such a license. It is the responsibility of the customer to determine if their 
confocal microscope is licensed in conjunction with U.S. Patent No. Re. 34,214, which may be 
done by enquiring with their confocal microscope manufacturer. This software may not be used 
with confocal microscopes that do not have such a license. AutoQuant will not be responsible for 
any infringement nor appearance of such infringement. This restriction does not in any way imply 
any acknowledgment by AQI of the validity of U.S. Patent No. Re. 34,214.

4. OWNERSHIP OF SOFTWARE AND MEDIA: You agree and acknowledge that AQI 
transfers no ownership interest in the SOFTWARE or in any SOFTWARE copy, to you under this 
Agreement or otherwise, and that AQI and its licensors reserve all rights not expressly granted to 
you hereunder. After you pay the applicable license fee and /or purchase price for the SOFT-
WARE, you will own the media on which the SOFTWARE was originally provided to you here-
under and on which you subsequently copy the SOFTWARE (duly exercising the restrictions 
noted in Section 2 above). AQI and its licensors shall retain ownership of all SOFTWARE and 
copies of the SOFTWARE or portions thereof embodied in or on such media, including ownership 
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of all copyrights, mask work rights, patents, trademarks, trade secrets and all other intellectual 
property rights subsisting in the SOFTWARE, documentation, enhancements, adaptations and any 
modifications thereto. 

5. TRANSFER RESTRICTIONS: You may not distribute, rent, sell, sublicense or lease or 
otherwise transfer the SOFTWARE without express written permission from an authorized AQI 
official. 

6. ENFORCEMENT OF TERMS, TERMINATION: If you fail to fulfill any of your 
material obligations under this Agreement, AQI and/or its licensors may pursue all available legal 
remedies to enforce this Agreement, and AQI may, at any time after your default of this Agree-
ment, terminate this Agreement and all licenses and rights granted to you under this Agreement. 
You agree that if AQI terminates this Agreement for your default, you will, within thirty (30) days 
after any such termination, deliver to AQI all software provided to you hereunder and copies 
thereof embodied in any medium.

7. GOVERNING LAWS: This Agreement will be governed by and interpreted in accor-
dance to the laws of the State of New York in the United States of America. 

8. LIMITATION OF LIABILITY NOTICE: THE SOFTWARE IS PROVIDED ON AN 
"AS IS" BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE 
QUALITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS FOR A PAR-
TICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF TRADE, 
COURSE OF DEALING OR OTHERWISE. SPECIFICALLY, THE SOFTWARE IS NOT 
GUARANTEED TO WORK TO SATISFACTION ON EVERY 3D MICROSCOPY IMAGE, 
EVEN IF THE IMAGE IS OF A TYPE THAT THE SOFTWARE IS STATED TO BE 
INTENDED FOR. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF 
THE SOFTWARE IS ASSUMED BY YOU. NEITHER AQI, OUR DEALERS, REPRESENTA-
TIVES, LICENSORS OR SUPPLIERS SHALL HAVE ANY LIABILITY TO YOU OR ANY 
OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL OR ECO-
NOMIC LOSS, EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR THEY ARE FORESEEABLE. WE ARE ALSO NOT RESPONSIBLE FOR 
CLAIMS BY A THIRD PARTY. OUR MAXIMUM AGGREGATE LIABILITY TO YOU AND 
THAT OF OUR DEALERS, SUPPLIERS AND LICENSORS SHALL NOT EXCEED THE 
AMOUNT PAID BY YOU FOR THE PRODUCT. THE LIMITATIONS IN THIS SECTION 
SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR DEFAULT IS A 
BREACH OF A FUNDAMENTAL CONDITION OR TERM OF A FUNDAMENTAL 
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BREACH. SOME STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITA-
TION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE 
ABOVE LIMITATION MAY NOT APPLY TO YOU.

Information furnished by AQI, in the SOFTWARE manual is believed to be accurate and reliable. 
However, no responsibility is assumed by AQI for its use; nor for any infringements of intellec-
tual property rights or other rights of third parties that may result from its use.

No license is granted by implication or otherwise under any patent rights of AQI.

9. CHOICE OF LAW: This notice will be governed by and interpreted in accordance with 
the laws of the State of New York in The United States of America.

10. US GOVERNMENT RESTRICTED RIGHTS: Use, duplication, or disclosure by the 
US Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) 
and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as appli-
cable. Manufacturer of this SOFTWARE is AutoQuant Imaging, Inc., 877 25th Street, Watervliet, 
NY 12189, Federal ID Number 14-1772880.
 
11. COPYRIGHT NOTICE: © Copyright 2003 by AutoQuant Imaging, Inc.
The SOFTWARE package is protected by United States copyright laws and international treaty 
provisions. It is illegal to copy the software except as specifically allowed in this Software 
License Agreement. Any person found storing or using an unlicensed copy of this software is lia-
ble to AQI to the maximum extent permissible under applicable US and International laws and 
International Treaty Provisions.

Should you have any questions to this Agreement, please contact AutoQuant Imaging, Inc., 877 
25th Street, Suite 2008AB, Watervliet, NY 12189, (518)-276-2138.

12. TERM: This Software License Agreement shall remain in effect only for so long as you 
are in compliance with the terms and conditions of this Agreement. This Agreement will termi-
nate if you fail to comply with any of its terms or conditions. You AGREE, upon termination, to 
destroy all copies of the SOFTWARE. 

13. GENERAL: This Software License Agreement is the entire agreement between us, super-
seding any other agreement or discussions, oral or written, and may not be changed except by a 
signed agreement. If any provision of this Software License Agreement is declared by a Court of 
competent jurisdiction to be invalid, illegal, or unenforceable, such a provision shall be severed 
from the Software License Agreement and the other provisions shall remain in full force and 
effect.

14. WARRANTY: AutoQuant offers a 90-day warranty of the software product. For this 90-
day period the software may be returned by the end-user to the representative for reasonable 
cause, and must be returned with all product materials included in the shipping, including the soft-
ware media (e.g., CD), manual (if shipped), hardware key and any other product materials 
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shipped. The complete set of product materials must be returned for the 90-day warranty to be 
valid and for a refund to be entitled. The 90-day period begins on the day of shipment of the soft-
ware to the end user from the Representative or from AutoQuant, whoever ships the product to the 
end user. No return or refund is entitled after the 90-day period has expired. Upon such a valid 
return, the dealer is obligated to refund the price of the product less shipping costs. The Represen-
tative will return the product materials to AutoQuant and AutoQuant will refund the discounted 
price of the product, less shipping costs, to the Representative.
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Introduction

What is 3D Deconvolution 

Also known as “deblurring” or “3D image restoration”, deconvolution is a computational tech-
nique for removing out-of-focus haze from stacks of optical sections. The out-of-focus haze can 
be mathematically modeled as a “point spread function (PSF)”. Deconvolution methods can 
therefore be thought of as methods for inverting the unavoidable and natural blurring effect of the 
point spread function (PSF). 

For example, suppose we focus a microscope having a fine depth of field (DOF) of about 0.4 
micrometers, onto a plane in a microscope sample which may be anywhere from a few microme-
ters (e.g. chromosomes or epithelial cells) to on the order of 50 to 200 micrometers (e.g. neurons 
or brain slices). The acquired image will contain both sharp, in focus features originating from the 
plane of focus, as well as hazy, blurry features originating from out-of-focus planes that are above 
and below the plane-of-focus. After capturing this image electronically, we can refocus the micro-
scope to an adjacent plane that is on the order of a depth of field (DOF) away, and acquire a sec-
ond image. This process can be repeated until the entire specimen has been scanned. The resulting 
dataset will be a “3D dataset”, or in other words, a “3D image”. However, it will be a rather poor 
image, because it will contain all of the out-of-focus haze and blur. 

The purpose of deconvolution is to remove the haze and blur and to restore sharpness and clarity 
to the image, as illustrated for a neuron image below. 

Figure 1: Illustrating the removal of background haze by deconvolution. The image on the left is a 2-D 
projection of a 3D transmitted-light brightfield image of a neuron sample. The picture is shown with the 
gray levels inverted for clarity. The image on the right is the result of deconvolving the image on the left.
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The effects of deconvolution are usually most pronounced in the axial direction (z-axis), as illus-
trated for a confocal image of a rat neuron below. 

The improved axial resolution becomes especially important when accurate morphometry is 
desired.

Figure 2: Confocal image of a CA3 hippocampal rat neuron. Panels a and b show the projections of 
the dataset from the top and side respectively. Panels c and d show the same dataset after deconvo-
lution.

(a)  Top View            (b)   Side View           (c)  Top View           (d)  Side View

Figure 3: On the left is a rendering of the 3D image of a fluorescent dye-filled micropipette imaged 
by a laser-scanning confocal microscope. On the right is the same object after deblurring. The axis 
running from left to right corresponds to the microscope axial direction.
March, 2004                     Page 28



AutoQuant Imaging, Inc.                   Manual and Tutorials
The improved axial resolution due to deblurring is illustrated in Figures 3 and 4 for the case of a 
known object (a dye-filled micropipette).

Deconvolution can often reveal fine details that are not directly observable. Figure 5 shows an 
example of this fact.

Figure 4: Showing the improved morphometry made possible by deblurring for 
the image of a known object (fluorescent dye-filled micropipette). (a) Cross-sec-
tions through the raw undeblurred dataset (the sectioning positions are indicated 
by the white lines). (b) Cross-sections through the segmentation of the dataset at 
the same slices. Panels (c) and (d) show cross-sections through the deblurred 
dataset. Note the symmetry of the latter result, which agrees well with known 
reality. 

(a)                    (b)                        (c)                     (d)                 
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Application of the AutoDeblur Deconvolution Package

The AutoDeblur software package can be used to perform 3D deconvolution in the context of the 
following forms of microscopy:

1. Transmitted-Light Brightfield Microscopy (TLB);
2. Widefield Epi-Fluorescence Microscopy (WF); 
3. Confocal Pin-Hole Laser-Scanned Epi-Fluorescence Microscopy (CLSM);
4. Spinning Disk Scanning Confocal; and
5. Two-Photon Fluorescence.

For the confocal fluorescence microscope, images of adjacent planes are sequentially digitized 
and optically sectioned in a manner that is generally similar to the widefield case, except that each 
frame is collected by way of a raster-scanned laser spot and a photomultiplier pinhole detector. 
Each confocal optical section is, by itself, already relatively deblurred in the sense that the confo-

Figure 5: Example of improved detail revealed by deconvolution. The upper panel shows 
the top and side projectional views of a portion of a neuron. The lower panel shows the 
same views after deconvolution. Notice how the spines of the neuron become observable.
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cal optics rejects most of the out-of-focus light. However, in spite of this improvement over the 
widefield microscope, the confocal microscope has its own limitations. 

(1) While it indeed rejects most of the out-of-focus light, it by no means rejects all of it, and 
thereby retains an obvious haze, even though this haze is much reduced from that of the widefield 
microscope. 

(2) Another effect of this imperfect out-of-focus light rejection is that the image retains sub-
stantial axial smearing. For an image which is not diffraction limited, this smearing appears akin 
to a linear motion blur in the axial direction. For an image which is diffraction limited, as with 
empty magnification, this smearing appears as a substantial nonisotropic blur (or nonisotropic 
spatial resolution), with most of the smearing along the axial direction. 

(3) Owing to this light rejection, far fewer photons are detected, so a rather substantial quan-
tum-photon noise component may be seen in the raw dataset. This noise component routinely 
causes limitations in protocols where very fine structures need to be seen. For instance, it limits 
our ability to detect a void in the fluorescence concentration that is often useful to pinpoint 
impalement sites of electrophysiology probes [Turner, Szarowski et al., 1991], and it limits our 
ability to determine if a dendritic spine is present. It is difficult to judge whether a void in the 
image intensity is due to a fine structure that is really there or if it is due to erroneous, random 
fluctuations caused by the statistical nature of quantum noise. 

In the case of confocal fluorescence microscopy, it is the purpose of deblurring algorithms to 
reduce these three undesirable effects and to thereby improve the utility of the microscope.

Deblurring is best carried out when the dataset is seemingly oversampled. In other words, best 
results are achieved when the pixel or optical section spacing is finer than what would be used 
normally, without deblurring. In-plane deblurring is most successful when the sample spacing is 
finer than 1/2 the Rayleigh width. If in-plane deblurring is desired, we will sample at 0.1 µm, or 
finer, when the 1/2 Rayleigh width is ~0.25 µm.   Axial deblurring is substantial with widefield 
optics regardless of the z sampling. The rule of thumb for confocal datasets, without deblurring, is 
to have the optical sections spaced according to the confocal spot size along z, which is the reso-
lution element along the z-direction calculated by the following equation [Webb et al, 1995]:

where λ is the wavelength in microns (µm), η is the refractive index of the immersion medium, 
and NA is the numerical aperture of the objective lens. If ∆z is 0.5 µm, we will sample at 0.5 µm 
or finer per slice. The noise suppression mentioned above requires this type of fine sampling.

∆z
1.4λη( )
NA2

-------------------=
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What is Blind Deconvolution?

Blind deconvolution is a term that is used to describe methods of deconvolution, which do not 
require the point spread function (PSF) of the system to be explicitly known prior to the deconvo-
lution. AutoDeblur is based on blind deconvolution. Indeed, a reconstructed estimate of the PSF 
is produced by AutoDeblur concurrently with the deconvolved image dataset. There is no need to 
provide AutoDeblur with a PSF of any kind. 

The important practical implication of blind deconvolution is that it adapts to the real PSF of the 
microscope system, which can be significantly different from the theoretical PSF (see Figure 6), 
and from previously measured PSFs due to specimen and instrument variations. The AutoDeblur 
blind deconvolution system is able to adapt to PSF changes within a specimen itself. Thus, the 
deconvolved results are superior to those of methods that utilize theoretical or previously mea-
sured PSFs.

Direct, experimental measurement of the PSF is an arcane and difficult procedure that is not 
straightforward [Hiraoka, Sedat et al., 1990] for routine usage and thereby impedes the wide 
usage of deblurring algorithms that require it. The PSF measurement method typically involves 
imaging a sub-resolution fluorescent microsphere. This approach has several limitations. First, 
noise in the imaging system also shows up in the measured PSF. This can be overcome to some 
extent, by averaging over several microspheres and/or frames. This is time-consuming and effort-
intensive. Second, photobleaching of the microspheres limits the strength of the obtainable signal. 
Third, the actual PSF changes when the microsphere sample is removed and the biological speci-
men is inserted. Fourth, the PSF measurement must be done for each sample collection session, 
and for every optical configuration used. This is because the PSF is a function of the refractive 
index of the sample or medium, and its nonhomogeneity [Gibson and Lanni, 1991]. Finally, the 
PSF may vary spatially, especially along the optic axis.

All of the above complications are compounded with confocal microscopy, where light levels are 
especially low and where the dependency of the PSF to the sample refractive index is especially 
strong [Visser, Oud et al., 1992]. 

Figure 6: Shown on the left is a theoretical PSF for a confocal microscope. On the right is the PSF as 
revealed by AutoDeblur.
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By using blind deconvolution methods, AutoDeblur eliminates the need for Point Spread Func-
tion (PSF) measurement, improving both the accuracy, as well as convenience of deconvolution. 
This is a major advantage of using this package instead of those utilizing non-blind deconvolution 
methods.

Another clear practical advantage of AutoDeblur is that it inherently reduces noise in the image, 
especially in severely noisy cases. This is partly because its mathematical foundations have quan-
tum photon noise as a fundamental assumption. Intuitively, this may be explained in that the 
microscope represents a bandlimited system, which means that any good light signal will lie only 
inside the bandlimit. Much of the undesirable noise energy lies outside of the bandlimit, and the 
algorithm inherently recognizes this and automatically rejects the out-of-band noise, while prop-
erly constraining the deblurred image to have only nonnegative values. This advantage is espe-
cially important for confocal microscopy, where images often have a large noise component.

Important Features of AutoDeblur

Resolution Improvement and Noise Reduction: AutoDeblur improves the resolution of the 
microscope in the x, y, and z dimensions. Additionally, datasets from the microscope system may 
be especially noisy, as is often the case with confocal datasets and with fluorescent widefield 
datasets using an intensified CCD camera. AutoDeblur greatly reduces this noise.

Statistical Optimality: Because AutoDeblur is based on Constrained Maximum Likelihood Esti-
mation theory, it is, in this sense, statistically optimal. Intuitively, the algorithm searches for the 
most likely 3D dye concentration, which caused the collected image dataset.
 
Correct Modeling Assumptions and Constraints: The AutoDeblur design is based on carefully 
justified mathematical modeling of the optical system, including Poisson statistical modeling of 
the noise component in the detector electronics. The Poisson model not only works well with low-
photon-count datasets; it also properly constrains the probe concentration and PSF to be nonnega-
tive. This is something that is not done by methods based on Gaussian image models (e.g., Least-
squares, Jansson Van Cittert). The model in AutoDeblur also takes into account the optical char-
acteristic of the dataset collection system (including the sample) and ensures that the estimated 
probe concentration and PSF agree with the physical system. 

Advantage of an Iterative Method: Because the method is iterative and nonlinear it is capable 
of properly constraining the solution (i.e., constraining the probe concentration and PSF solu-
tions) to be nonnegative. This is especially important for both quantitation, and for resolution 
improvement (especially z resolution). Our algorithm is capable of optimally restoring the miss-
ing cone of frequencies that are inherent in the PSF for widefield microscopes. For a detailed 
description of the problem of missing cone of frequencies, the reader is referred to the paper by 
Streibl (see Bibliography). Linear methods, such as the well-known Nearest Neighbor method and 
the Inverse Filtering methods [see references] are not capable of implementing such constraints, 
and are thereby not nearly as suitable for quantitation or resolution improvement. However imple-
mentations of both of these simple and fast deconvolution methods are included in AutoDeblur.
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Dark Current (Bias) and Flatfield Corrections: The data correction utility is a component in 
AutoDeblur. This provides features for automatic data correction, including automatic bias and 
flatfield correction. This component corrects data from video rate and cooled CCD cameras.

Processing Many Datasets: AutoDeblur allows the sequential processing of many datasets by 
using its Batch Processing feature. 

Basic Principles Underlying the AutoDeblur System

The basic mathematical and conceptual principles underlying the AutoDeblur system have been 
widely published in scholarly journals and conference proceedings worldwide. 
Constrained Maximum Likelihood Estimation may be thought of in two ways. First, consider a 
3D fluorescent sample. We may think of the true 3D probe concentration as an unknown random 
quantity. In an intuitive sense, the image reconstruction algorithm is searching for the 3D fluores-
cent probe concentration, which is “the most likely one” to have caused the raw optically sec-
tioned image dataset, taking advantage of any available constraints. In a mathematical sense, the 
algorithm is based on the formulation of a mathematical function, called the likelihood function. 
This likelihood function depends on both the unknown 3D fluorescent probe concentration and 
the 3D PSF. The algorithm iteratively solves for the 3D image that maximizes this likelihood 
function. In other words, the likelihood function is solved for the correct probe concentration and 
PSF that provide this maximum value solution. This solution then, in effect, becomes our recon-
structed 3D probe concentration and PSF. This optimization model is based on an assumption that 
the noisy camera data follow a Poisson random signal model. This assumption is physically justi-
fied; assuming a quantum photon limited photo detector, which is certainly the case in many situ-
ations, especially for very noisy low light level situations. Thus, AutoDeblur has a sound 
mathematical basis, which makes it statistically optimal. Partly due to this, the algorithm inher-
ently reduces noise in the dataset. Additionally, it incorporates numerous improvements and valu-
able features. 
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Guidelines for Collecting 3D Image Datasets

Overview

For transmitted-light brightfield and widefield-fluorescence microscopy, the main considerations 
are the following:

• Collection of the optical sections
• Collection of bias frames
• Collection of the flat field frame
• Vibration control

It is important to follow the guidelines outlined in the following sections. The adage of “garbage-
in garbage-out” is true for following these guidelines. Even though AutoDeblur is relatively 
robust against non-adherence to any of these guidelines, with each guideline that is not followed, 
and depending upon how severely the guideline is broken, the microscopist increases his/her 
chances of having unsatisfactory experimental results. 

It is best to follow each and every guideline, to the letter, wherever possible. Do not violate a 
guideline for the sake of convenience. Break only those guidelines for which you have no choice 
but to break, because of restrictions caused by your experimental conditions. Remember that with 
each guideline broken, the risk of having unsatisfactory results increases. 

Optics Alignment

Before beginning any procedure, be sure that the entire optical train is well aligned. Follow the 
instructions provided by your microscope manufacturer on proper adjustment and alignment of 
the optical elements. This should be performed daily, prior to each experiment, and should be re-
checked throughout the day if the microscope is receiving heavy usage. Make certain of the fol-
lowing: 

-The fluorescence excitation lamp is properly centered and focused (if fluorescence is being 
used).

-The trans-illumination lamp is properly centered and focused (if transmitted-light brightfield is 
being used). 

-The condenser is properly centered and focused (if transmitted-light brightfield is being used).

-For transmitted-light brightfield: Adjust the condenser iris diaphragm (numerical aperture, NA) 
according to the following:
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For 3D digital imaging, as performed here, it is best to have the transmitted-light be as incoherent 
as possible. This implies opening the NA, as far as possible.

For direct eye viewing, on the other hand, it is best to eliminate scattered and stray light in order 
to improve contrast, and this implies closing the NA to a point just below the NA of the objective 
lens. DO NOT DO THIS! As a rule of thumb, it is recommended to simply open your condenser 
NA as far as it will go. If doing so makes viewing the sample overly difficult, then lower the con-
denser NA, until it is at about 1.2 (20% higher) of the objective lens NA. If you are using an oil 
objective lens having an NA that is greater than 1.0, and using a condenser that allows usage of 
oil, then you will need to do so (i.e., you will need to place a drop of oil on the condenser) in order 
to ensure this condition. If you are using an oil objective lens for which the NA is higher than the 
highest available NA of the condenser (for example, a 1.4 NA objective lens and a 1.25 NA con-
denser), then use the highest available NA that your condenser will allow and use a drop of oil on 
the condenser (assuming your condenser allows you to use oil with it).

Collecting Optical Sections

Setting the Top and Bottom of the Sample, and of the Scan

You need to select the top and bottom slice of the sample. By performing a through-focus opera-
tion, with either direct-eye or video camera viewing, you should judge where the top and bottom 
of the sample are. 

Note: The top and bottom of the scan are not necessarily the same as the top and bottom of the 
sample.

The rule of thumb for selecting the top and bottom of the scan is described below, using the terms 
illustrated in Figure 1 below. 

Figure 1: Shows the geometry, and illustrates the terms used for 3D widefield dataset collection.

Note: The actual axial distance that is scanned is about twice that of the sample. The top and bot-
tom are over-scanned by approximately half the thickness of the sample. The above rule of thumb 
provides the best results. If you have limited disk or memory space, then you may not be able to 
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follow this rule of thumb. In that case, scan the depth of the sample, plus any additional amount 
allowed by your free hard disk space.

Setting the Top and Bottom of the Scan

For best results, the rule of thumb in setting the axial distance between slices is to have this dis-
tance equal to the Rayleigh depth of field (DOF) as given by the following equation:

where λ is the wavelength (if unknown, use a value of 0.5 micrometers), η is the refractive index 
of the immersion medium (1.0 for air, 1.33 for water, 1.515 for oil) and NA is the numerical aper-
ture of the objective lens.

The total number of slices required, then, will be equal to the thickness of the scan, selected as 
described earlier, divided by the chosen axial distance between slices. If you have limited disk 
storage space, you may not be able to follow the above rule of thumb. In that case, you may set 
your axial distance between slices equal to a number larger than the depth of field. AutoDeblur 
will still work in that case. However, as a trade-off, you can expect to experience some degrada-
tion in image quality. The extent of the degradation will depend upon the axial sampling distance 
chosen relative to the DOF.

Deblurring is best carried out when the datasets are seemingly oversampled. In other words, best 
results are achieved when the pixel or optical section spacing is finer than what would be used 
normally, without deblurring. In-plane deblurring is most successful when the sample spacing is 
finer than 1/2 the Rayleigh width. If in-plane deblurring is desired, sample at 0.1 µm, or finer, 
when the 1/2 Rayleigh width is ~0.25 µm.   Axial deblurring is substantial with widefield optics 
regardless of the z sampling. The rule of thumb for confocal datasets, without deblurring, is to 
have the optical sections spaced according to the confocal spot size along z, which is the resolu-
tion element along the z-direction calculated by the following equation [Webb et al, 1995]:

where λ is the wavelength in microns (µm), η is the refractive index of the immersion medium, 
and NA is the numerical aperture of the objective lens. If ∆z is 0.5 µm, sample at 0.5 µm or finer 
per slice. The noise suppression mentioned above requires this type of fine sampling.
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Setting the Exposure, Gain and Offset

Cooled CCD Cameras

With cooled CCD cameras, the exposure time is usually adjustable. Consult the manufacturer’s 
manual to determine how to change the exposure time. To set the exposure time for collecting 
optical sections, use the following procedure.

Focus onto a point near the center of the sample (see Figure (1)). Adjust the illumination light to a 
setting that you desire. If you are using a transmitted-light brightfield microscope, adjust the light 
so that you can view the sample comfortably through the eyepiece. Next, try an exposure time set-
ting. Usually, if you have done this before, you can start with a setting that has worked well for 
you in the past. If you are doing this for the first time, or if an approximate setting is not known, 
start with an exposure time around 0.05 seconds. Grab and view a single frame at this setting. If 
the picture on your screen appears too dark, increase the exposure time and repeat the frame grab-
bing and viewing procedures. Be careful not to saturate (make too bright) any portions of the 
image. Saturated regions can usually be identified as bright, flat, white regions in the picture, as 
seen in Figure (B). 

Figure (A) A successful, unsaturated image 
Figure (B) A saturated image of the same sample. Note the obvious bright, flat, white back-
ground. Note that the highlighted background features (marked ‘1’) in Figure A are erroneously 

Figure 1-1 

Figure A Figure B
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eliminated in the saturated image. Note that other features of the sample (marked ‘2’) are eroded 
in the saturated image.

A reliable method for detecting saturation is to compute and display the image intensity histo-
gram. A straight vertical spike/line at the end of the abscissa (see illustration in Figure C) is an 
indication of saturation, which is to be avoided.

Figure C: Histogram of gray values in an image frame that has saturated pixels. The maximum 
gray value of the frame and the maximum possible gray value coincide. Typically, though not 
always, a spike will appear in the histogram, as shown above.

If you observe saturated pixels, lower the exposure time and repeat the grabbing and viewing pro-
cedure. 

As a rule of thumb, adjust the exposure time so that the brightest pixel is at approximately 75% of 
the well capacity of the CCD camera.This condition is often detectable (depending upon the sam-
ple), again, by using a histogram. The 75% well capacity condition is detected by noting that the 
highest abscissa value having a non-zero histogram value is at 75% of the range of the abscissa. 
An example of this is shown in Figure D below.
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Figure D: Histogram of gray values in an image frame with no saturation. Adjust the camera/
frame-grabber gain and/or illumination level such that the maximum gray value in the image 
frame is between 75% to 85% of the maximum-possible gray value. For instance, for an 8-bit 
camera (most RS-170 camera/frame grabbers), the maximum gray value is 255. For a 12-bit 
cooled CCD camera, the maximum possible gray value is 4095.

If your cooled CCD camera provides gain adjustments or frame averaging, follow the manufac-
turer’s directions to achieve the above-described intensity histogram profile. 

RS-170 Cameras

Many RS-170 cameras provide some control over the video gain. Some cameras provide a gain 
adjustment device on the camera itself while others provide this adjustment as part of a camera 
electronic control box. Often, frame grabber cards provide a software selectable gain factor. 
Finally, the lamp brightness control and the neutral density excitation filter control provide yet 
two more mechanisms for selecting the gain. Please look through the manuals provided by your 
microscope, camera and frame grabber manufacturers to determine which if these options are 
available to you, and methods to access them.

Similarly, cameras and/or frame grabber cards provide an offset (black level) adjustment mecha-
nism. Again, please refer the manufacturers’ manuals on methods to access the offset adjustment.
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Once you have determined the above information, the following procedure is recommended for 
setting these adjustments.

(1) Set the illumination light intensity (for transmitted light brightfield) or the neutral density 
filter (for fluorescence) first. Do this by direct eye viewing and selecting the intensity so you can 
comfortably view the sample through the eyepiece. If you are trying to maintain a very low light 
level, to minimize photobleaching with a fluorescence sample, this might not be possible. Instead 
you may have to simply set the light level to a suitably low level which cannot be seen by eye. 

(2) Set the offset value on the video camera and/or frame grabber. Ideally, you want the offset 
to be adjusted so that a zero light level corresponds to a zero value on a histogram of gray values. 
Block all light to the camera. This may be accomplished either by turning the lamp power switch 
off (for transmitted-light brightfield) or by closing the excitation shutter (for fluorescence). It may 
also be accomplished by sliding the position of your dichroic mirror filter set. Next, adjust the off-
set, or black level position(s) on your camera and/or frame grabber card. If possible, to keep mat-
ters simple, adjust only the setting of the camera and leave the rest of the system alone. Make this 
adjustment so that you see a spike in the gray-level histogram right at the zero (left most) value of 
the abscissa, as shown in Figure E. Avoid a completely saturated histogram as shown in Figure F. 
This is identified by having only a single spike at the abscissa value of zero and having no spike 
of finite width.

(3)  Set the gain. As mentioned, you may have essentially three independent ways to control 
the gain (camera, frame grabber, and light intensity/neutral density filter). To keep matters simple, 
try adjusting only one of the gains. If fluorescence is being used with an intensified camera, we 
recommend adjusting only the camera gain, keeping the excitation light as low as possible. If 
transmitted-light brightfield is being used with an ordinary video-rate CCD camera, such as an 
RS-170 camera, we recommend adjusting only the illumination light level. Open the light to the 
camera. Adjust the gain (or illumination level) setting until the highest gray level (abscissa) on the 
histogram, which has a non-zero value (ordinate), is at about 75% of the range of the abscissa, as 
shown in Figure D. Avoid/minimize saturated pixels using the procedures described earlier in this 
section.
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Figure E: Histogram condition for setting the offset (black level) of the camera/frame grabber. 
Look for an unsaturated spike at or near zero. There may also be a saturated spike at zero.
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Figure F: A zero-saturated histogram. This condition is to be avoided when setting the offset 
(black level).

Performing the Axial Scan

Begin grabbing images at each optical section. Start by focusing onto one end of the sample. Grab 
a frame. Do this with frame averaging if this feature is available on your setup. This is especially 
important if the datasets are noisy due to low light levels. It is recommended that you average 255 
frames if possible. Refocus the microscope to the next adjacent frame and grab the next image, 
and so on. Refer to file formats that are compatible with AutoDeblur. If a TIFF format is used, for 
instance as with some standard frame grabber cards, store each frame in a file, in sequentially 
numbered files with a numeric suffix, i.e., files with names of the form IMAGE.1, IMAGE.2, and 
so forth. If a raw 16-bit integer format is used, for instance as with some of the cooled CCD cam-
eras, then store all of the frames in sequential order and contiguously in the same file having an 
extension .deb. Repeat this image-grabbing and storing sequence until you have scanned the 
entire sample. Scan the entire depth that was chosen according to Figure 1.

After collecting the datasets, check the computer’s directory for the file names that were chosen, 
as a diagnostic check to be certain that all of the datasets were saved. Check for their expected file 
sizes in numbers of bytes. For instance, if a raw 16 bit binary format is used, as with a cooled 
CCD camera, and if the image size is 1024 by 1024 with 85 slices, then the number of bytes 
shown in the directory for this file ought to be 1024 x 1024 x 85 x 2=178257920.
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Be careful to move the plane of focus the exact same distance for each intermediate frame. Check 
the specifications of your microscope and identify the amount of movement effected by a revolu-
tion of the fine focus knob (i.e., the micrometers per revolution). For example, for the Olympus 
BH-2, the movement is 200 micrometers per full revolution of the fine focus knob. These are well 
indicated by graduations on the knob, with the knob having 100 graduations. Thus, the stage will 
move 2 micrometers for every graduation that the knob is turned.

It is important to have a reliable axial scanning mechanism, with some way of verifying the step 
sizes. The accuracy of the average step size is critical. This should be within 5% of the specified 
step size. The accuracy of individual step sizes is not nearly as critical. As a rule of thumb, these 
ought to be within 20% of the specified step size, but their average value (to emphasize the point) 
needs to be within 5%. For example, suppose that you specify that the step sizes are 0.2 microme-
ters, and that the scan will be 50 planes deep. Then, by using a position gauge on the stage or by 
monitoring the focus-knob graduations, you should record and verify that the stage moved within 
5% of the 10 micrometers (between 9.5 and 10.5 micrometers). With a high-resolution gauge hav-
ing a resolution of 0.01 micrometers you may be able to verify the individual step sizes. However, 
with lesser expensive gauges, having a resolution of 0.1 micrometers, it will be sufficient to verify 
the larger step sizes, of 1 micrometer or more. By specifying step sizes of 1 micrometer and 
higher, verify that these steps are indeed within 20% of the 1 micrometer (within 0.8 and 1.2 
micrometers). However, make sure that the deviation from this step size is randomly dispersed 
about the 1 micrometers so that the average step size is still within 5% of the 1 micrometers.

A position measurement device, such as a Mitutoyo (Aurora, Illinois, USA, 708-978-5385) MU-
Checker and digital Minichecker having resolutions of 0.1 micrometers, should be used to verify 
the average step size.   Heidenhain sells a number of position gauges as well. A resolution in the 
measurement of 0.1 micrometers is sufficient, because it is the average of the step sizes that is 
most critical value. One of the common malfunctions that can occur in dataset collection is gear 
slippage. The slippage of the microscope gears or slippage of any linkage between the motor con-
troller and the microscope can be a critical error in dataset collection. A position measurement 
device will check for this error. If a positioning gauge is not available, then the next best way of 
checking the positions is to record the position of the graduations on the fine-focus controller. 
Each graduation specifies a certain number of microns. A careful recording of these graduation 
positions will allow you to identify slippage in the motor controller and in the linkage between the 
motor and the microscope, but it will not allow you to determine if there is slippage in the micro-
scope gears themselves. 

Check with your microscope's manufacturer to determine what type of gear mechanism is used, 
and if this gearing may be prone to slippage. Regardless of the design of this gearing, any micro-
scope may have problems, since any gearing mechanism may become stripped, and easily so if it 
experiences harsh usage such as in educational environments. Some microscope models, have 
ball bearing friction linkages between the focus control and the stage, and thereby are prone to 
slippage under normal conditions. 

There are a number of manufacturers that sell turnkey 3D dataset collection systems, which 
includes both the needed hardware and software, for widefield microscopy. These products carry 
out the above instructions automatically. Some of the manufacturers to check are listed here (Uni-
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versal Imaging Corporation, Downington, PA; Compix, Cranberry Township, PA; MediaCyber-
netics, Silver Spring, MD; Nikon, Melville, NY; Leica, Bannockburn, IL.

Avoiding Backlash and Hysteresis

While stepping the focus, always scan “against the load.” If you have a stage-focusing micro-
scope (where the stage moves up and down as the focus knob is moved), then always step the 
focus in the direction where the stage is moving upward. This will cause you to scan the sample in 
the direction from top to bottom. If you have a nosepiece focusing microscope, then always step 
the focus in the direction where the nosepiece is moving upward. This will cause you to scan the 
sample in the direction from bottom to top. 

When adjusting the focus from one sequential slice to the next, move the knob very slowly and 
cautiously. Also be careful to move the knob only in one direction during the scan. 

Once you have started grabbing frames, never reverse the direction of the fine-focus knob (not 
even a miniscule amount, and not even just once!). Doing so by even a very small amount will 
ruin the scan due to backlash and hysteresis of the focusing system. 

To compensate for erroneous hysteresis effects, do the following before grabbing the first frame. 
First, focus into the specimen. If you have a stage-scanning microscope, first move the stage 
down by 20 micrometers or more below the position where you wish to grab the first frame. Then, 
being careful to move the knob in only one direction (as mentioned earlier, once you are in this 
stage of operation, never reverse the direction of the knob), slowly and carefully move to the posi-
tion where you want to grab the first frame. This operation counteracts a hysteresis that is inherent 
in the microscope’s focusing mechanism.

Collecting Bias and Flatfield Frames

Cooled CCD Cameras

Bias and flatfield dataset frames are used by AutoDeblur to automatically calculate the cooled 
CCD camera’s dark current distribution, pre-amplifier bias and flatfield non-uniformity. This pro-
cedure needs to be repeated every day, or preferably, for every dataset collection. This process 
compensates for potential misalignments in the optics, which may drift from day to day, and to 
compensate for dust that may settle in the optical train, which also changes from day to day.

Collect two bias frames and one flatfield frame. The bias frames are taken with the camera shutter 
closed, or with light to the camera blocked. Select a charge integration time for the first bias 
frame. The accuracy of the bias frame dataset will increase with increasing charge integration 
time. As a rule of thumb, use 60 seconds for the first bias frame. The charge integration time for 
the second bias frame needs to be twice that of the first bias frame, so as a rule of thumb use 120 
seconds for the second bias frame.
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Collect a flatfield frame. This will be used to calculate the flat-field non-uniformity of your cam-
era. A flat field “sample” can be provided in a number of ways. When using transmitted-light 
brightfield, the simplest way is to remove the sample from the microscope and grab an image of a 
blank stage. A rather simple method, with transmitted-light brightfield, is to take the biological 
sample extremely out of focus, to a point where the image shows a completely flat field. When 
using fluorescence, the most reliable way is to prepare a “flatfield” slide by placing a drop of flu-
orescent dye onto a microscope slide and sealing it with a coverslip. In case any debris particles 
may be contained in this droplet, it is best to grab this image with the droplet well out of focus. 
Some care must be taken to ensure that no out-of-focus remnants of debris appear in the image, 
and that no other particles on the slide happen to come into focus. See Table 1: Figure (a) and Fig-
ure (b) for an illustration of these conditions. In setting the exposure time, when using transmit-
ted-light brightfield, first try the same exposure time that was used in collecting the optical 
sections during the axial scan. Adjust the exposure time to ensure the conditions described in Fig-
ure C and Figure D. When using fluorescence, since the drop of dye will likely fluoresce at a dif-
ferent intensity than the biological sample, it is especially important to carefully adjust the 
exposure time to ensure the conditions described in Figure C and Figure D. To emphasize, it is 
important that the maximum gray value in the image is at about 75 - 85% of the well capacity of 
the camera, and that there are no saturated pixels in the image.

Carefully record all exposure times and file names for the bias and flatfield images since you will 
need them later.

RS-170 Cameras

The bias and flatfield frame collection procedure needs to be repeated every day, and for every 
dataset collection session. This process is used to compensate for potential misalignments in the 
optics, which will drift from day to day, and to compensate for dust that may settle in the optical 
train, which will change from day to day. Collect one bias frame and one flat field frame.

The bias frame is taken with light to the camera blocked. This may be accomplished by shifting 
the dichroic mirror filter set, by turning off the trans-illumination lamp (if transmitted light bright-
field is used) or by shuttering the excitation lamp (if fluorescence is used). If you are using frame 
averaging, average as many frames as possible. As a rule of thumb, average 255 frames.

Collect a flat-field frame. This will be used to calculate the flat-field non-uniformity of your cam-
era. A flat field can be provided in a number of ways. When using transmitted- light brightfield, 
the simplest and most reliable way is to remove the sample from the microscope and grab an 
image of the blank stage. Another way, which will take more care is to take the sample extremely 
out of focus, to the point where, in effect, the camera image shows a flat field (see Table 1). We 
recommend doing this only if it is not possible to remove the sample without disrupting your 
experiment setup. Otherwise, one should avoid this method, because it is more prone to errors and 
misjudgment. For example, Table 1: Figure (a) shows a common mistake, which is quite often 
made. This occurs when the sample is brought well out of focus, but an obscure out-of-focus rem-
nant of the sample is still present. Avoid this situation. It is extremely important to have a flatfield 
image that represents a totally flat field as shown in Table 1 (b). When using fluorescence, the 
most reliable way to prepare a flat-field sample is to place a drop of dye onto a slide and to seal it 
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with a coverslip. Although, in principle, it may be possible to take the lens out of focus with the 
sample in place, for a flat field, we do not recommend doing so with fluorescence. Doing so is 
prone to problems. With fluorescence, it is much more difficult and prone to errors, to judge that 
the field is completely flat. Also, it is difficult (and often impossible) to collect an out-of-focus 
(flat-field) picture that has sufficient signal level, because the signal level decreases as the sample 
is taken out of focus. This signal-level problem may be compensated for, by increasing your video 
gain or by increasing your exposure time, doing so is prone to errors and is best avoided. 

To summarize: For a flat-field brightfield image, remove the sample. For a fluorescence flat-field 
image, use a drop of dye with a coverslip. Only if doing so is not possible due to experimental 
constraints, try taking the sample well out of focus until you have a completely flat field (Table 1). 
However, be especially careful that there is no out-of-focus remnant of the sample and make cer-
tain that (for fluorescence) your exposure times and gains are set so that you have enough signal 
level in the flat-field image.

In selecting the camera gain (or gain on the frame grabber, illumination intensity or neutral den-
sity filter), refer to the discussion given earlier under Setting the Exposure, Gain, and Offset. 
When using transmitted-light brightfield, first try the same gain that was used for collecting the 
optical sections during the axial scan. Adjust the gain to ensure the condition described earlier in 
Figure D. When using fluorescence, since the drop of dye will likely fluoresce at a much different 
intensity than the biological sample, it is especially important to carefully adjust the gain to ensure 
the condition described in Figure D. To emphasize, it is important that the maximum gray value in 
the image is at about 75 - 85% of the well capacity of the camera, and that there are no saturated 
pixels in the image as shown in Figure C.

Make a careful record of all gains and file names for the bias and flatfield images in your labora-
tory notebook. Record all exposure times and numbers of frames averaged for all datasets col-
lected, including the flatfield frames, bias frames and the optical sections of the sample.
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Table 1: Figure (a): An incorrect attempt at a flatfield image by taking the sample well out of 
focus. This image is not far enough out of focus. An out-of-focus remnant of the sample is still 
visible. 

Table 1: Figure (b) A correct attempt at a flatfield image by taking the sample well out of focus. 
Note that no out-of-focus remnant of the sample is apparent. This image will be used to correct 
the optically sectioned dataset for non-uniform pixel sensitivity and for the dust spots that are 
highlighted.

Spatial Calibration

Important parameters that are entered into the AutoDeblur program are the x and y pixel sizes 
(distance between pixel centers). This may be obtained by using a microscope stage micrometer 
(e.g. Edmund Scientific product number J30,593 or J30,088). Collect two images of the stage 
micrometer, using the same lens with which you collected the optical sections. You will need to 
perform two calibrations - one for the x dimension and one for the y dimension. 

Be sure that the graduations of the stage micrometer are properly aligned with the x and y axis. 
This is done by repetitively adjusting the angle of the camera position on the optical tube, and 

Table 1: 

Figure (a) Figure (b)
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grabbing an image, until it is clear that the graduation lines are perfectly vertical or horizontal (see 
Table 2) for the x and y axis calibration, respectively. The stage micrometer will have a specifica-
tion of micrometers per graduation. Denote this specification as ∆xg micrometers/graduation.

AutoDeblur or AutoVisualize can be used to measure the x-y locations of pixels on a screen using 
a ROI box, the width of the box will be displayed on the Status bar of the main window. If the 
number of pixels between graduations along the x and y directions is n x and n y, respectively, then 

Table 2: 

Table 2: Stage micrometer image used for calibrating the pixel size. The distance between 
the first and the last of the six lines on the upper half of this image was measured to be 
11.5cm (Wg) on a video screen. The stage micrometer dimension was known from the man-
ufacturer to be 10µm/graduation. The width of the entire screen (Ws) was measured to be 
12.7cm on the video screen. The resulting calculations are illustrated above.

Ng 25graduations=

Nx 512pixels=

xp
10 25 12.7××

11.5 512×
----------------------------------- 0.54µm pixels⁄==∆
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the number of micrometers per pixel along the x and y directions, denoted ∆xp and ∆yp, respec-
tively, is given by:

If you do not have a stage micrometer available then you can use the following method to approx-
imate the pixel spacing. From the manual for your CCD camera determine the size of the each 
pixel (e.g., 6 -10 microns is typical). Divide this number by the lens magnification and the camera 
zoom you are using. This will approximate the pixel spacing in your image. For example, a 40x 
lens with a 1.5x camera zoom and 6 micron CCD pixels will give you a pixel spacing for the 
image of 0.1um/pixel. The equation is camera pixel size / (lens magnification * camera zoom). 
6um/(40x *1.5x) = 0.1um/pixel

Vibration Control

To maximize the quality of the dataset acquisition, it is recommended that the imaging micro-
scope system be isolated from vibrational disturbances to the extent possible. 

The best approach to vibration control is to use a professional anti-vibration table (“air table”), 
(e.g. see the Ernest Fullam Inc. catalog, Latham, NY, or the Newport Catalog, Irvine, CA). Often, 
sufficient vibration control can be achieved for video microscopy systems without these air tables. 
The following section offers some insight into the vibration isolation.

Most vibration-related dataset collection problems arise from relative motion between microscope 
components. This type of relative motion can often be caused by external energy sources.

Mounting the instrument on a maximally rigid platform can minimize relative motion between 
microscope components. Remember that two types of rigidity are relevant - dynamic and static. 
Ideally, the platform should be as rigid as possible, dynamically as well as statically, and yet be as 
light as possible, and respond minimally to effects such as temperature changes. For example, 
Newport manufactures a special honeycomb sandwich structure that has these desirable proper-
ties. In most quiet, climate-controlled laboratories, an aluminum platform with a minimum thick-
ness of 0.5 - 1 inch may suffice. Thicker platforms have higher static rigidity. Try to minimize the 
length and width of the structure to the minimum necessary amount.

x∆ p micrometers pixel⁄( )
x∆ g micrometers graduation⁄( )

nx pixels graduation⁄( )
---------------------------------------------------------------------------------=

y∆ p micrometers pixel⁄( )
y∆ g micrometers graduation⁄( )

ny pixels graduation⁄( )
---------------------------------------------------------------------------------=
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In addition to placing the microscope on a rigid platform, it is desirable to isolate the platform 
from external vibrations. For this, it is useful to be aware of the sources of vibrational energy 
around the microscope. 

Also, vibrations (usually from cooling fans) can be transmitted to the microscope via unavoidable 
accessories, such as electrical cables. While most of the vibrational disturbances are vertical, it is 
possible to have disturbances that are along the horizontal direction. 

Finally, one must consider shock control in addition to vibration control. Shocks often occur in a 
laboratory environment due to heavy footsteps nearby, when buildings are being repaired, or 
when heavy equipment is being moved. 

Keep in mind that vibration isolation equipment must be considered not only for the microscope 
system itself, but also for laboratory vibration sources such as computer and electronic systems 
containing fans and relays. It is important to note that vibrations are best controlled at the source, 
if at all possible.

Practical and Inexpensive Solutions

Inexpensive vibration isolator components are available, based on a variety of principles, ranging 
from pneumatic through those based on the use of viscoelastic polymers, (see Edmund Scientific 
[Barrington NJ]; catalog no. A35, 264 Sorbothane Vibration Mounts). Such vibration mounts may 
be simply placed under a heavy pallet made of wood, ceramic, Plexiglas, slate, aluminum, or 
some other convenient (preferably heavy) material. 

Many laboratories have mounted tennis balls on such pallets as vibration isolators. We recom-
mend first deflating the tennis balls by drilling a small hole on one end. Otherwise, we have expe-
rienced that inflated tennis balls are too rigid and do not sufficiently dampen building vibrations. 

Collecting Confocal Datasets

When collecting confocal datasets that will be used in conjunction with deblurring the following 
rules-of-thumb apply. We emphasize that these are recommended rules-of-thumb for optimal 
operation. Owing to the difficult trade-offs among experimental conditions of signal-to-noise, 
photobleaching, photo-damage, field size, and many other considerations, you may find it neces-
sary to bend these rules. These are recommended conditions and not hard rules. You should go 
ahead and bend them, if necessary. Because of the robustness of AutoDeblur your deblurred 
results may still turn out fine, but this will depend on many factors, including your sample type, 
and is less predictable than if you follow the rules. To emphasize, keep in mind the following 
adage garbage-in = garbage-out. AutoDeblur is designed to be robust against breakage of these 
guidelines. Breakage of say one or two of them may cause no problem. However, with each addi-
tional guideline that is broken, your chances of achieving satisfactory experimental results 
decreases. As a general rule, do not break any of the guidelines for sake of convenience. Break 
only those guidelines for which your experimental design restrictions absolutely prevent you from 
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following these guidelines. In other words, only break a guideline if you have no choice but to do 
so.

Sampling Issues

As a rule of thumb, the in-plane sampling ought to be equal to the resolution element (resel) size, 
or spot size, of the image. According to Webb et al:

and

where ∆dxy and ∆dz are the spot sizes in micrometers, for the in plane (XY) and axial (z) dimen-
sions, respectively, and where λ and NA are the wavelength and numerical aperture, respectively. 
The least critical deviation is to make ∆dxy larger than that indicated by the above equation. This 
is because most of the noticeable smearing in images is along the axial dimension, which is not 
affected by making ∆dxy larger. The next least critical deviation from this rule is to make ∆dz 
smaller than indicated by the above equation. In fact, there are distinct advantages in doing so. 
Generally speaking, the finer the sampling is along z, the better is the deblurring along z. The 
above rule is considered the optimal trade-off between this axial deblurring and the potential pho-
tobleaching and other problems (such as extra disk space required) that may be caused by having 
finer axial sampling. The next least critical deviation is to make ∆dz larger than indicated by the 
above equation. Doing so lessons the amount of deblurring that is possible along the axial dimen-
sion, but there should still be substantial deblurring that is noticed. For example, it is common to 
process datasets that have ∆dz equal to 2 or 4 times that indicated by the above equation, and sub-
stantial deblurring and noise reduction is still usually obtained, albeit generally to a lesser degree. 
Making ∆dxy smaller than as indicated by the above Equation is the most critical deviation from 
the rule. Generally, it is best to avoid bending this rule, even though it has mixed advantages and 
disadvantages. Making the in plane sampling finer than the Rayleigh resolution limit will improve 
the in-plane deblurring. For confocal datasets, however, this desired improvement may come at 
the cost of degrading the axial resolution, depending upon how well the other rules-of-thumb are 
followed as explained below. In principle, so long as the confocal pinhole aperture is stopped 
down to a point that the microscope is considered to be fully confocal, then there should not be 
any problem with making this in-plane sampling finer. In fact, doing so will ordinarily improve 
the in plane deblurring as explained. On the other hand, it is very often the case (arguably most of 
the time) that the confocalist does not have his/her pinhole aperture stopped down to the fully 
confocal position (because he/she usually wants to detect more light to improve sensitivity). 
Therefore, as a general rule of thumb for optimal results we do not recommend making the in-
plane resolution any finer than as indicated in the above equation. If you do so, we recommend 

∆dxy 1resel
0.4λ
NA

-----------==

∆dz
1.4λη
NA

2
---------------=
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that special care be taken to be sure that your confocal microscope aperture is stopped down so 
that it is in the fully confocal position.

See the next two sections for recommended sampling when the aperture setting is other than fully 
confocal.

Confocal Aperture

AutoDeblur runs on the mathematical assumption that you have a fully confocal microscope. This 
condition is true so long as the confocal pinhole photodetector aperture is closed down to a size 
that is less than or equal to the “waist” of the scanning spot (diameter of the Airy disk). In the 
specimen plane, for a 1.4 NA lens, this spot size is around 0.25 micrometers and the recom-
mended confocal aperture diameter (after projection onto the specimen plane) is then 0.25 
micrometers or less. This number, however, does not represent the actual physical diameter of the 
aperture. For example: The Molecular Dynamics SarastroTM confocal scanning system, for a 60X 
1.4 NA lens, a spot size of 0.25 micrometers in the specimen plane is magnified to approximately 
50 micrometers in the detector plane. Thus the recommended true aperture size is 50 micrometers 
for this particular setup. 

Please check the specifications of your confocal microscope to determine the aperture settings 
needed to ensure fully confocal behavior. This condition will differ among confocal manufactur-
ers.

It is well understood that often times this aperture size requirement may not be met. Because of 
signal-to-noise, photobleaching and other considerations, the confocal aperture is often opened 
wider. The main point to emphasize is that you should not do so casually, and only if it is neces-
sary. The dataset may still deblur fine, but this will depend upon your sample and other experi-
mental conditions and is not extremely predictable. Remember that the AutoDeblur system is 
very robust against noise. It is generally more robust against noise than it is against improper con-
focal settings, so if you have a choice between fully confocal behavior and noise, for deblurring 
purposes it is better to sacrifice signal level (noise) for a proper confocal behavior. Remember that 
AutoDeblur “thinks” that you have a fully confocal microscope, so it will try to reconstruct a fully 
confocal PSF. As you open the pinhole aperture, your microscope behavior begins to lean towards 
widefield behavior and the true PSF begins to have widefield character, such as a flaring, hour-
glass like shape. This behavior, in a sense, “confuses” the AutoDeblur software and it will still 
attempt to reconstruct a fully confocal PSF, so you should avoid this condition, if possible. If this 
condition cannot be avoided, AutoDeblur still has the robustness that it may provide a nice 
deblurred result, but this will be dependent on your sample and other experimental setups and is 
less predictable than with fully confocal settings. Consider the signal-to-noise requirements 
explained below. 

Less Than Fully Confocal Conditions

If you find it unavoidable to have the aperture setting opened wider than the fully confocal posi-
tion, then we recommend likewise broadening your XY sample spacing by the same amount. For 
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instance, if your confocal aperture is broadened to twice the diameter of its fully confocal posi-
tion, then you should broaden your XY sample spacing (microns per pixel) to twice the above 
mentioned “optimal” sample spacing (~0.5 micrometers for a 1.2 NA lens or higher). Of course, 
other experimental conditions may prevent you from doing this, and this may be alright, but as 
with other rules of thumb, this is the so-called recommended optimal setting.

Signal-To-Noise Considerations

AutoDeblur will operate with a wide range of signal-to-noise levels. The Expert Settings have a 
Noise Smoothing feature to handle different signal-to-noise levels. Widefield datasets generally 
contain low levels of noise, therefore the default setting is Low. Confocal datasets generally con-
tain medium levels of noise, therefore the default setting is Medium.

For Signal to Noise Ratio (SNR) levels of 10 or below, a Noise Smoothing setting of High should 
be selected. This will cause AutoDeblur to be extremely robust against the noise. For SNR levels 
between 10 and 100 the Noise Smoothing setting of Medium should be selected. For SNR levels 
of 100 or higher, the Noise Smoothing setting of Low should work well. See Table 3 to identify 
noise levels approximately by visual comparison. 

Table 3 (Left to Right). Simulated SNR of 160:1, 40:1 and 10:1 respectively.

Table 3: 

SNR 160:1 SNR: 40:1 SNR 10:1
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2-Photon Dataset Collection

Guide for Obtaining the Correct Collection Parameters

Sampling Criterion for X, Y

Sample at 1/2 the Airy disk width with a wavelength that is the excitation wavelength. The excita-
tion optics determine the width of the PSF. This will be approximately (0.61λ)/(NA x 2). Where λ 
is the emissive wavelength and NA is the numerical aperture. Generally the result is 163 nanome-
ters or finer (assuming a 1.4 NA lens). If you can sample finer (say 80 nanometers or 40 nanome-
ters) try this also, as an experiment. It is expected that you may improve the x, y resolution by at 
least 2 and possibly by 4 (80 nanometers). To improve the “optical” resolution by 4 (to 80 nanom-
eters) you need to increase the spatial sampling by 8 (40 nanometers).

Sampling Criterion for Z

Sample at 1/2 of the PSF axial width, which approximately follows the formula: 
 (1.4)λη /(NA2). Where η is the refractive index of the lens and NA is the numerical aperture. This 
is the formula for the axial width of a confocal PSF. For 2-photon microscopy, use the excitation 
wavelength in this formula. Assuming a 1.4 NA lens, this distance is approximately 800 nanome-
ters. For more substantial deblurring along z, experiment with even finer sampling. For example, 
400 or 200 nanometers or finer.
 
Keep in mind that the above rules are only rules of thumb for ensuring that deconvolution will 
show substantial deblurring. If, on the other hand, the experimental objectives do not call
for an improved x, y resolution but they do call for an improved z resolution, then follow the Sam-
pling Criterion for Z and sample as you otherwise normally would do along x, y. If the experi-
mental objectives do not call for an improved z resolution but they do call for an improved x, y 
resolution, then follow the Sampling Criterion for X,Y and sample as you otherwise normally 
would do along z.
 
The modality setting of AutoDeblur, which is found under the menu item Deconvolution - 
Deconvolution Settings - Standard Settings, on the right side of the Optics Settings Microscope - 
Modality should be set to Two Photon Fluorescence. This is because the optical PSF of the typical 
2-photon microscope, theoretically (assuming the detector aperture is wide open), is equivalent to 
that of a confocal PSF, except that it is determined by the excitation wavelength rather than the 
emission wavelength.
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Tutorials for File Menu Items

For this tutorial  you may use your own data type  (Fluorescence [Widefield], Laser Scanning 
Confocal, Brightfield [Transmitted Light], Spinning-Disk Scanning Confocal, Two-Photon 
Fluorescence or 2 Dimensional images) or you may follow along with the recommended dataset 
to use.

Open 

This function opens to a list of directory of files, from which a chosen file can be loaded into 
AutoDeblur and AutoVisualize for processing. For a list of file types that can be opened see 
“Guidelines for naming your file(s)” below.

Opening Your Image

Note: When opening a folder in any of the following tutorials, if the folder appears empty select 
All Files in the Files of type field.

(1) From the File menu select Open or from the Toolbar  click on the Open File Icon.

(2) From the Tutorial Data directory select the Widefield folder.  Select the dataset 
FitcDapi_crop.tif and click on Open.

Note: Various file formats may be handled such as: AutoDeblur File, AutoVisualize File, 12 bit 
data, 12 bit swapped data, 16 bit data, 16 bit swapped data, IPLab File, PGM File, Bio-Rad PIC, 
TIFF File, 8 bit character data, 32 bit float, AVI File, (Bitmap) BMP File, and STK File. If your 
dataset is stored in a series of slice files, the software will recognize the series, and ask if you wish 
to load the entire series, or simply the file that you selected. If your dataset was stored as 12 bit 
data on a UNIX machine, and you are running the software on a PC, you must select 12 bit 
swapped (for UNIX) as the file type. This is also true for 16 bit data, and when transferring 12 bit 
and 16 bit data from a PC to a UNIX machine. 

(3) The dialog box shown below will appear.

 

March, 2004                     Page 56



AutoQuant Imaging, Inc.                   Manual and Tutorials
Select Yes to answer the question for the FitcDapi_crop.tif dataset.

(4) The FitcDapi_crop.tif dataset will be loaded and displayed in the XY Max Projection 
view.

Note: If it is necessary to enter the dimensions of a particular dataset the first time it is loaded, 
you will be prompted to do so. The next time that dataset is selected, the dimensions will automat-
ically be recalled for you.

Once a file is opened, subsequent files with the same name (but from a different directory) will be 
numbered chronologically in the order they are opened. For example, if you have pollen.deb 
opened from the widefield folder, then you open another file name pollen.deb from a different 
directory, that file would be named pollen.deb(2), and subsequent pollen.deb files would be 
named pollen.deb(3), pollen.deb(4) etc.

Open Movie

(1) From the File menu, select Open Movie. Set the Files of type to *.avm

(2) From the Movies directory, select Colrpollenrs.avm and click Open. 

Note: The *.avm file extension indicates an AutoVisualize movie header file. This header file con-
tains the necessary information to playback the movie. By selecting this file the entire movie will 
be loaded.

(3) The first frame of the movie is then displayed. Click the Play button  to play the 
movie. The movie will play once through then automatically stop.

(4) To stop a movie that is currently playing click the Stop button .

(5) Click the Loop Mode button  to put the movie playback into Looping Play. Click the 
Play button and the movie will continuously play in a Looping motion until the Stop button is 
clicked.

(6) Click the Rock Mode button  to put the movie playback into Rocking Play. Click the 
Play button and the movie will continuously play in a Rocking motion until the Stop button is 
clicked.

Close

This function closes the current active view. To close the dataset, make the image the active view, 
and select Close from the File menu. 

With the focus on Colrpollenrs.avm, select Close from the File menu to close the movie.
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Launch Imaris

If you have Imaris installed on your machine, you will have a Launch Imaris option on your file 
menu, as well as an icon  to launch Imaris. If you do not have Imaris installed on your 
machine, you will not have these options.
If you have these options, load a dataset into the AutoDeblur/AutoVisualize workspace that you 
want to load into Imaris. Either click the Launch Imaris icon, or select Launch Imaris from the 
File menu. You will be prompted to save the dataset as an .ids file. Once the dataset is saved as an 
.ids file, Imaris will launch, and the dataset will be opened in the Imaris workspace. If you select 
not to save the dataset as an .ids file, then you will be returned to the AutoDeblur/AutoVisualize 
workspace, and Imaris will not be launched.

Save As

This function saves an image or sequence of images as a specified file type.
If the FitcDapi_crop.tif file is not still open from the Open tutorial, open it now.

(1) Select Save As from the File menu and type BlueGreen as the File name. Click on the 
Save as type drop-down arrow and select STK FILE (*.stk). 

(2) Click the Save button. This will save the file in the (*.stk) format.

Note: Do not close BlueGreen.stk. Please continue on to the next section.

Guidelines for naming your file(s):

Note: AutoDeblur and AutoVisualize follow the same naming conventions as standard Windows 
applications.

To move an AutoDeblur or AutoVisualize file into and out of a UNIX computer follow the file 
naming conventions of the UNIX operating system. For example, using an underscore for file 
names greater than 8 characters, and not using spaces or special characters.

The dataset file can be saved as any of the following types:

AutoDeblur File (*.deb) - AutoQuant’s AutoDeblur format that uses an accompanying 
*.hdr file which contains the settings and other information about the AutoDeblur file.

AutoVisualize File (*.avz) - AutoQuant’s AutoVisualize format that uses an accompany-
ing *.hdr file which contains the settings and other information about the AutoVisualize 
file.

8 bit character data (*.*) - This is a raw binary file type with 8 bits per pixel.
March, 2004                     Page 58



AutoQuant Imaging, Inc.                   Manual and Tutorials
12 bit data (*.*) - This is a raw binary file type with 12 bits per pixel. Many cooled CCD 
cameras produce datasets stored in this form.

12 bit swapped (for UNIX) (*.*) - This is a byte swapped format originating from a 
UNIX computer.

16 bit data (*.*) - This is a raw binary file type with 16 bits per pixel. Many cooled CCD 
cameras produce datasets stored in this form.

16 bit swapped (*.*) - This is a byte swapped format originating from a UNIX computer.

32 bit float (*.*) - This is a raw binary file type with 32 bits per pixel. This allows you to 
store intensity values as real numbers with a precision of 6 or 7 significant digits.

TIFF (*.tif) - Tagged Image File Format. This is a common file type for standard image 
file format.

STK (*.stk) - This is the Metamorph file format. It is a proprietary format of Universal 
Imaging.

SEQ (*.seq) - This is the Image Pro file format. It is a proprietary format of MediaCy-
bernetics.

Fluoview (*.tif) - This is a 16 bit TIFF file. It is a proprietary format of Olympus Instru-
ments.

Bio-Rad PIC (*.pic) - This file format is a proprietary format of Bio-Rad.

IPLab (*.*) - This is a file format produced by Scanalytics, Inc.

PGM (*.pgm) - This is a commonly file type with UNIX computer systems. It uses 8 bits 
per pixel.

Bitmap File (*.bmp) - This is a Windows file format for images.

Note: When you select Save As, if your dataset is in a Slice Viewer Projection and you have 
changed either the gamma, brightness, or flip settings, a dialog box will appear with the question 
Save data as shown? “No” will discard the gamma, brightness and flip adjustments. Selecting Yes 
will keep the gamma, brightness and flip adjustments.

Save Current View

This function is similar to taking a print screen or a snap shot of the image in the viewing window. 
When working with a dataset that was saved as Save Current View, the XZ and ZY views are 
unselectable. This is useful for use in publications or presentations.
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(1) From the File menu select Save Current View. Name the file BlueGreen2d.stk. The file 
will be saved as a 2 dimensional picture or an image made up of just one slice. 

(2) Close all datasets before going on to the next section.

Import Multi-Channel Data

This function allows you to import up to eight channels of data into one image set for viewing. 
Selecting Import Multi-Channel Data from the File menu will launch the Combine Channels dia-
log.

Combine Channels Dialog

Load Channels
This section contains the controls with which to add, change, and remove channels from the Com-
bine Channels dialog.
Add
Click this button to add channels to the Combine Channels dialog. Clicking this button will 
launch the Import Channel dialog.
Change
This button allows you to change the attributes of a selected channel already added to the Com-
bine Channels dialog. Select the channel to change by highlighting it, then click the Change but-
ton. Only one channel can be selected when you click the Change button. Clicking this button will 
launch the Import Channel dialog.
Import Channel Dialog
Clicking either the Add or Change button will open the Import Channel dialog. In this dialog, 
channels can be opened, selected, and assigned a channel specification.
Select Data
Clicking this button will open an Available Datasets window. If datasets are currently open, those 
datasets will appear in the workspace with their complete file path. As datasets are added, they 
will appear in the workspace.
Available Datasets
When the Select Data button in the Import Channel dialog is clicked, this window opens. From 
here, you can add channels to the dataset.
Open File
Click this button to add a file to the workspace. A windows browser will open. Browse to the 
desired file, and click Open. The selected file will be added to the workspace.
Select All
This button is not active in this window.
OK/Cancel
To add a channel to the composite, select that file by highlighting it, then click the OK button. 
Only one channel can be selected. This will bring you back to the Import Channel dialog, with the 
selected channel loaded, and ready for channel specification. To close the Available Data Sets 
window without adding a channel to the Import Channel dialog, click the Cancel button.
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Channel Specification
In the Channel Specification section of the Import Channel dialog, you can assign a color/probe/
wavelength to each channel. Click the radio button next to a selection, this will activate a drop 
down menu that contains the color/probe/wavelength projections available for that option. Click 
on the arrow next to the selected method (Colormap, RGB/Color Composite (depending on the 
dataset loaded, one or the other will be available), Fluorescent Probes, Emissive Wavelength) and 
select the desired color/probe/wavelength. Clicking Cancel anytime before clicking OK will close 
the Import Channel window without affecting any changes. Clicking OK will close the Import 
Channel window and the rendering in the Generate Datasets will update with the chosen channel 
displayed in the selected color/probe/wavelength.
Remove
Click this button to remove a channel from the Combine Channels dialog. Select the channel(s) to 
be removed by highlighting it (multiple channels can be selected by holding the shift key while 
clicking on the desired channels), then click the Remove button. The channel will be removed 
from the dialog, as well as the renderings in the Generate Datasets section of the dialog.
Change Intensities
This section contains the controls with which to change the intensities of the channels in your 
composite image. Above the graph are numbers, which correspond to the channel number. Below 
each number is a red circle. Use the mouse to click and drag the circle up or down to change the 
intensity of that channel: moving the circle up will increase the intensity, moving it down will 
decrease the intensity. Beneath the graph are percentages which will update as the red circle is 
moved, indicating the intensity of that channel.
Generate Datasets
This section contains renderings of the combined channels, as well as controls to create datasets 
from the combined channels.
Create 2D Dataset
Click this button to create a 2D max projection of the composite. The new image will be created 
in a new window, which may appear beneath the Combine Channels dialog; you may need to 
move the dialog to view the new image.
Create 3D Dataset
Click this button to create a 3D max projection of the composite.

(1) Under the File menu select Import Multi-Channel Data.
 
(2) The Combine Channels dialog box will appear. 

(3) Click on the Add button, then click on the Select Data button. An Available Datasets win-
dow will appear; click on Open File. Browse to the Multi Channel folder in the Tutorial data and 
select Malaria_Red.0.tif from the Multi-Channel folder and click Open. Your Tool’s Option in 
Window’s Explorer for “hide file extension for known file types” must be unchecked in order for 
you to view the *.tif extension. Also, in the Files of type section of the Open menu, select All Files 
(*.*).

(4) A dialog box will appear with the question “A sequence of files associated with this 
selected file is detected. Do you wish to load the entire sequence?” Select Yes. This question will 
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come up again when you select for the Green and Blue Channels below. Select Yes each time. If 
you receive an error message stating that a file cannot be found, open a windows explorer win-
dow, browse to the Multi-Channel folder, sort by file type then delete the .hdr files.

Warning: Doing this to your own dataset will delete any image information you may 
have previously saved with it (image spacing, numerical aperture, etc.)

(5) Repeat steps 3 and 4 for the files Malaria_Green.0.tif and Malaria_Blue.0.tif.

(6) In the area labeled Select datasets from workspace, click on the Malaria_Red.0.tif, then 
click OK. In the Import Channel window, in box 1.b, click on the radio button next to RGB. From 
the drop down menu next to RGB, select Red, then click OK.

(7) Click Add, then click Select Data and then repeat step 6 for Malaria_Green.0.tif and 
Malaria_Blue.0.tif, assigning Green to Malaria_Green.0.tif and assigning Blue to 
Malaria_Blue.0.tif.

As you add datasets, the bottom of section 2 of the Combine Channels dialog will update 
with each added channel shown individually, and section 3 will show each channel com-
bined together.

(8) In section 2 click on the red circle underneath channel 2, and drag it upward without 
releasing the mouse. When the circle is about halfway between the blue line and the top of the 
chart (or the percentage below the circle notes around 150%), release the mouse. Note that the 
green in the 2D View updates with a much brighter green channel.

(9) In the Load Channels section, highlight Malaria_Blue.0.tif, then click Change. In the 
Channel Specification section, click the radio button for Fluorescent Probes, then click on the 
drop down arrow. Select Rhodamine (576nm) from the drop down menu. Click OK. Note that 
areas that were previously blue are now yellow. Highlight Malaria_Blue.0.tif again, click Change, 
then click the RGB radio button and select Blue from the dropdown menu.

(10) Click Create 3D Dataset. A progress indicator will begin showing the writing of the red, 
green and blue channels. An XY-Max Projection of the three channels is the output displayed. 
This may open behind the Combine Channels dialog, so if the file is not visible, try moving the 
dialog box to view what is behind it.

You may now save this file as a combined channel file in the *.stk, *.seq, *.tif (24bit),  or *.bmp 
format.

Data Properties

This function allows you to view the properties of your dataset.
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File Name

This lists the name of the selected file.

File Size

This lists the size of the selected file.

Bits/Pixel

This displays the bits per pixel for the selected file.

File Type

This lists the type of file that is selected.

Dimensions (X,Y,Z)

The Image Dimensions are the Width (pixels), Height (pixels) and Depth (slices). The Width, 
Height and Depth will automatically be set for a dataset stored as TIFF (*.tif), AutoDeblur 
(*.deb), AutoVisualize (*.avz), BioRad Pic (.pic), IPLab (*.*), STK (*.stk), Bitmap (*.bmp), or 
PGM (*.pgm) formats. 
The Dimensions will need to be entered by you the first time an 8-bit, 12-bit, 16-bit or 32-bit for-
mat dataset is loaded.

Spacing (X.Y,Z)

The X, Y, and Z Spacing (also known as voxel size) is the size of 1 pixel (in microns) in the X, Y, 
and Z direction, respectively. The Z spacing is often referred to as the “step size.” The Spacing is 
listed in the following order: X, Y, then Z.
X Spacing
The X Spacing is the width of one pixel in micrometers. 

Guidelines: The X Spacing can be calculated by dividing the spatial width of the image frame in 
micrometers by its width in pixels. X Spacing is entered in micrometers and ordinarily includes a 
decimal point. An accuracy of 3% or better is required.
Y Spacing
The Y Spacing is the height of one pixel in micrometers. 

Guidelines: The Y Spacing can be calculated by dividing the spatial height of the image frame in 
micrometers by its height in pixels. Y Spacing is entered in micrometers and ordinarily includes a 
decimal point. An accuracy of 3% or better is required.
Z Spacing
The Z Spacing is the sampling distance in micrometers between adjacent optical sections. 
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Guidelines: Typically the Z Spacing (step size) between optical sections is selected by the user 
collecting the dataset. The Z Spacing can be determined by dividing the axial depth of the dataset 
in micrometers by the number of optical sections collected.
IMPORTANT: It is critical to have the correct Z Spacing (step size) within a 3% margin of 
error. This should be measured with a position gauge (e.g. Heidenhain or Mitutoyo).

For this tutorial you may use your own data type  (Confocal, Transmitted Light Brightfield, 
Spinning Disks Confocal or 2 Dimensional images) or you may follow along with the Tutorial 
recommended dataset.

(1) From the File menu select Open or from the Toolbar click on the Open File icon.

(2) From the Tutorial Data directory select the Widefield folder and click Open. Select the 
dataset FitcDapi_crop.tif and click Open.

(3) A dialog box will appear with the question “The program has detected properties that 
indicate this dataset MAY contain an old AutoQuant Proprietary Multi-channel TIFF. Is this true? 
....” Select Yes.

(4) From the File menu select Data Properties. The Data Properties box will appear.

(5) In the Dimension frame, verify the Width, Height and Depth of the image in pixels. 
(Width = 90, Height = 120, Depth = 49).

(6) In the Spacing (X, Y, Z) frame verify:

The X Spacing value is 0.07 
The Y Spacing value is 0.07 
The Z Spacing value is 0.15 

If the spacings do not match those above, select Deconvolution Settings->Standard Settings from 
the Deconvolution menu to edit the spacings.

(7) Click OK to close the Data Properties box.

Note: Do not close FitcDapi_crop.tif. Please continue on to the next section.

Numerical Aperture

This lists the numerical aperture which was used to capture the dataset.

Scope Mode

This lists the type of microscope used to capture the dataset.
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Channel Wavelength

Depending on the dataset, there can be from one to three Channel Wavelengths listed. This lists 
the wavelength of the channel present in the dataset.

Page Setup

This function allows you to control the appearance of an image on the printed page.
You may change the placement of the image on the printed page by working with the selections 
under Orientation and Margins.

Print

This function prints the active screen. You may print the active view by selecting Print from the 
File menu.

Operation Settings

This function allows you to specify information regarding the File directory and the Rendering 
Range for various projections of a dataset.

Files

You have the choice of changing the location of the temporary files or the startup directory by 
either typing in the new location or browsing to the new location. The startup directory is the loca-
tion in which the software application will look for image sets.

Note: You are advised to place the temporary files directory on a drive with at least 1 gigabyte of 
free space. 

Rendering

The Rendering tab allows you to set the range of values a pixel may have depending on the pro-
jection chosen or the threshold values for a projection. The projection rendering ranges can be set 
for Max., Min., and Sum Projections. The threshold values can be set for Voxel Gradient, Best 
Focus, and Alpha Blending projections.

Note: You are advised to leave the Rendering settings at their default values. You may want to 
change the Rendering settings in the future for noisy or photobleached datasets. 

The default Rendering Range values are as follows:

The Max. Projection Rendering Range is from 0% to 100%
The Min. Projection Rendering Range is from 0% to 100%
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The Sum Projection Rendering Range is from 0% to 100%
The default Rendering Range of Voxel Gradient, Best Focus and Alpha Blending is from
20% to 100%
The default Alpha Value is 0.5.

Load Settings 

This feature allows you to load settings previously saved using the Save Current Settings As fea-
ture (see below). Load Settings will include all fields found in the Standard and Expert Deconvo-
lution Settings. For more information on Standard and Expert Settings, see page 133.

Save Current Settings As 

This feature allows you to save the Standard and Expert Settings as text files for later use with 
either the same, or another dataset. The file is saved with an (*.set) extension.

This section of the tutorial assumes you have the FitcDapi_crop.tif dataset open.

(1) With FitcDapi_crop.tif as the active view, from the File menu select Save Current Settings 
As.

(2) In the File name field type the name you would like for these settings. For example, 
Test_parameters.set.

(3) Click on Save. You have now saved the Settings for this file. This dataset will be used later 
in the tutorial section for the Deconvolution Menu items.

Please close all views before going on to the next tutorial.

Exit 

This function closes the software and all files that are open. You do not need to save the images 
generated in this tutorial section.

Recent Files List

This feature displays five of the most recently loaded and closed datasets. This list is found in the 
File menu underneath Exit. To open one of these most recent files, select the file from the list by 
clicking on it. 

Please close all views before going on to the next tutorial. 
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Tutorials for the View Menu Items

For this tutorial you may use your own data type (Fluorescence [Widefield], Laser Scanning 
Confocal, Brightfield [Transmitted Light], Spinning-Disk Scanning Confocal, Two-Photon 
Fluorescence) or you may follow along with the recommended dataset to use.  All 3D datasets can 
be viewed in a Single view.  All 3D datasets can be Zoomed, Enhanced, Inverted, and its Aspect 
Ratio changed. Choosing different views will display the image from different perspectives. 

Single View

This feature allows you to choose the view in which the dataset is presented. The dataset can be 
viewed from three orthogonal perspectives. The choices available are: XY, XZ, and ZY where X 
represents the image width, Y the image height, and Z is the depth or may be thought of as the 
optical axis in microscopy applications. When a choice is made, the single view that is generated 
will be for the currently active projection. For example, if a Sum Projection is the active view, 
selecting ZY will generate a ZY Sum Projection of the view.

XY 

This is the view of the “face” of the dataset or the front view of each slice.

XZ

This is an “edge-like” view of the dataset or of one of its slices. It can be thought of as a horizon-
tal slice through the XY view.

ZY

This is a “side” view of the dataset or each slice. It can be thought of as a vertical slice through the 
XY view.
      

(1) Navigate to the TLB folder and open the TLBview.tif dataset. Select XZ from the Single 
View option under the View menu. 

Note: Transmitted Light Brightfield datasets will open in the Min Projection view.

(2) Set the XY Min Projection as the active view by clicking within the XY Min Projection 
view.

Note: The status bar on the bottom of the main window will display the active view and projec-
tion.
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Triple View

Note: This section is applicable only to users of the AutoVisualize software.

Selecting Triple View allows you to create three orthogonal views of your dataset.  On the top left 
of the Triple View display is the XY view, on the top right is the ZY view, and on the bottom left 
is the XZ view of the dataset. The TLBview.tif:XY Min Projection from the previous section 
should be active.

(1) From the View menu, select Triple View. The XY, ZY, and XZ views of the TLBview.tif 
dataset are displayed in the Triple View box. 

(2) You can also generate a Triple View for datasets displayed in a Slice Viewer projection. 
Make active the TLBview.tif: XY Min Projection dataset. From the Visualization menu select 
Slice Viewer. The dataset will be displayed in a Slice Viewer.

(3) From the View menu, select Triple View. The XY, ZY, and XZ Optical Slice Viewers are 
displayed in the Triple View box. Click on the Show Crosshair button. The red lines indicate 
where each slice is in relative position to the others in the dataset. To remove the red lines click 
Hide Crosshair. 

(4) To Close the Triple View click on the [X] in the upper right-hand corner of the Triple View 
box. 

Note: Do not close TLBview.tif:XYMin Projection. Please continue on to the next section.

Zoom

This feature allows you to increase or decrease the size of the currently active view by a percent-
age based scale, either by selecting a Zoom factor from the View menu, or by selecting a Zoom 
factor from the Zoom box on the toolbar.

You have three choices for changing the size of the Image:

(1) Under the View menu select Zoom and then select 200%. The TLBview.tif: XY Min Pro-
jection will be zoomed up to 200% of its original size.

(2) Move the cursor to the corner of the view. When the cursor changes from a  to a , 
click the left mouse button down and hold it down while dragging the corner until the image is the 
desired size. The default setting for locking the Image Aspect Ratio (Retain Aspect Ratio) is on, 
therefore the image will remain proportionally correct.

(3) Change the size of the image by using the Zoom drop-down box on the Toolbar.

Close all datasets before continuing on to the next section.
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Montage View

Note: This section is applicable only to users of the AutoVisualize software.

This feature generates a series of Optical Slices and allows you to view them in a Montage frame 
box. In the Montage view you are able to specify the number of rows and columns and select the 
number of slices you would like to skip (i.e., if you select 2 for the number of slices to skip, Auto-
Visualize will display the 1st, 4th, 7th, 10th, 13th, and so forth, in the Montage frame). 

(1) Select Open from the File menu. Navigate to the Brain folder. Select the dataset brain.avz, 
and click Open.

(2) The Image Dimensions dialog box now appears because a header file hasn’t been associ-
ated with this dataset. Enter a value of 256 for the Width, 256 for the Height, and 64 for the Depth. 
Click OK to continue.

(3) Once the brain dataset is loaded and the default XY Max projection is displayed, from the 
View menu, choose Montage View. 

(4) A Multi-Slice Dialog box prompts you for the Number of Columns and Number of Rows 
used in displaying the multiple slices. The default size of the viewing window is 5 columns by 3 
rows, for a total of 15 slices. 

(5) To change the number of views displayed in the Montage frame enter a 6 for the Number 
of Columns and enter a 4 for the Number of Rows. Enter a 1 for the Starting Slice number. This 
will show the first slice of the dataset in the upper left corner of the Montage frame. Enter a 1 for 
the Skip Slice number to skip every other slice of the montage display. Click OK to create the 
Montage viewer. The slices will be displayed in the Montage frame. The line (separator) designat-
ing a frame’s boundary will be a maroon color for both grayscale and multi-channel images. 

 (6) The Montage viewer created is of 24 subsequent slices. To change the slices displayed 
click the Left-arrow key or the Right-arrow key on the keyboard and the previous slice or the next 
slice will be displayed, respectively. To change the entire Montage of slices click the Page Down 
key for the next set of slices or the Page Up for the previous set of slices.

Note: When clicking on the Left-arrow key, the Right-arrow key, the Page Up key, or the Page 
Down key the number of the slices that are being displayed in the Montage viewer are displayed 
on the Status bar at the bottom of the main window.

(7) To Close the Montage Viewer click on the [X] in the upper right-hand corner of the Mon-
tage Viewer box.

(8) Close the brain dataset by selecting Close from the File menu.
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Stereo View

Note: This section is applicable only to users of the AutoVisualize software.

This feature displays a Stereo View of the image file. Stereo viewing is generally used for seeing 
depth in an image. The Stereo View Parameters dialog box will prompt you for the Stereo Angle 
(Degrees). This angle will be used to generate the pair of images. AutoVisualize will generate the 
stereo pair and display the two projections offset from each other by the Stereo Angle. 

(1) Navigate to the SmallHip folder and open the SmallHip.avz dataset.

(2) To make this dataset more recognizable from the Toolbar click on the XZ icon to create an 
XZ Max Projection view of the dataset. The dataset will appear showing the bone structure from 
pelvis to the top of the rib-cage. 

Note: A Stereo View may be created from any Single view.

(3) From the View menu select Stereo View. The Stereo View dialog box will appear.

(4) Enter 10 (Degrees) for the Stereo Angle. Click OK. AutoVisualize will rotate the entire 
three-dimensional volume 10 (Degrees) to create the appropriate stereo pair.

(5) To generate another Stereo View make the SmallHip.avz: XZ Max Projection the active 
view and click on the View menu, then select Stereo View. You may experiment with different 
Stereo Angles to show varying levels of depth. 

(6) Close the Stereo Viewer(s) by clicking the Close [X] in the upper right-hand corner.

Note: Do not close SmallHip.avz: XZ Max Projection. Please continue on to the next section.

Image Aspect (Retain Aspect Ratio, Stretch Aspect Ratio)

This feature allows you to change the size of the image by simply moving the cursor to the frame 
corner or side of a view and “dragging” the frame edge inwards or outwards. There are two 
options under this menu item. The default option is Retain Aspect Ratio, which retains the origi-
nal aspect ratio of the view while changing its size. The second option, Stretch Aspect Ratio, will 
not retain the original aspect ratio of the view.

Note: Retain Aspect Ratio is the default for Image Aspect.

(1) Move the cursor over the edge of the image until it changes to a doubled pointed head 
arrow. Hold the left mouse button down and drag the cursor outwards, enlarging the image. 
Notice how the image enlarges proportionally when Retain Aspect Ratio is active.
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(2) Under View, select Image Aspect, and then select Stretch Aspect Ratio. Move the cursor 
over the edge of the view until it becomes a doubled headed arrow. Click and drag the edge and 
notice that the image enlarges disproportionately vertically or horizontally.

(3) Click the Retain Aspect Ratio option from Image Aspect again to reset the image back to 
its original proportions.

Note: Do not close SmallHip.avz: XZ Max Projection. Please continue on to the next section.

Correct XZ/ZY Aspect Ratio

This feature allows you to display the correct aspect ratio for the XZ or ZY views with respect to 
the physical dimensions of the voxels. When viewing an XZ or ZY image without Correct XZ/ZY 
Aspect Ratio on, the view shown assumes that the voxels are perfect cubes. If the Correct XZ/ZY 
Aspect Ratio option is selected, the view is shown such that the voxels have their correct dimen-
sions. 

Correct XZ/ZY Aspect Ratio takes into account the ratio amongst the X, Y, and Z spacings, when 
displaying the XZ and ZY image projections. The difference occurs because of the difference 
between the camera resolution and the sectioning resolution.

Note: The correct parameters must be entered into the Spacing found by selecting Settings-Stan-
dard Settings from the Deconvolution menu. 

For example, a microsphere will look slightly oval in its XZ and ZY views unless the Correct XZ/
ZY Aspect Ratio is selected. 

(1) Make the XZ view of the SmallHip.avz dataset the active view. From the View menu 
select Correct XZ/ZY Aspect Ratio. This will automatically correct the XZ and ZY ratios. 

Note: Please close all views before continuing on to the next section.

3D Viewer

Note: This section is applicable only to users of the AutoVisualize software.

The 3D Viewer window displays a graphical representation of the dataset. The different function-
alities of the 3D Viewer allow you to create oblique slices, orthogonal slices, movies, apply differ-
ent color maps, change projections, adjust subvolume size, rotate the dataset, and stereo view the 
dataset in anaglyph mode. Refer to page 16 for a list of video cards that support the functionalities 
used in the 3D Viewer.

The 3D Viewer menu items are: View, Projection, Rotation, Oblique, Movie, Color Map, Save, 
Options, and Help. 
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(1) Navigate to the SmallHip folder and open the SmallHip.avz dataset, or you may follow 
along with your own dataset.

(2) From the View menu select 3D Viewer. The 3D Viewer window opens with your dataset 
in the Volume Projection view (Hardware, if your system has the proper video card, Software, if it 
does not) of its XY Max projection. In the upper left hand corner of the 3D Viewer window the 
red line represents the X axis, the green line represents the Y axis, and the blue line represents the 
Z axis of the dataset. 

(3) From the Rotation menu select Go to View and choose a view e.g. XZ. The dataset will 
be rotated to the XZ view.

(4) To rotate the dataset click anywhere in the 3D Viewer window, hold down the left 
mouse button and move your mouse. The dataset will rotate in the same direction your mouse 
moves. If you stop your mouse movement with the left button still depressed, the rotation will 
stop. If your mouse is moving while you release the left mouse button, the dataset will continue 
rotating. Clicking in the 3D Viewer window will stop the auto-rotation.

(5) From the Color Map menu, select Lookup Table, then select Jet (if you are using your 
own dataset, and it is not grayscale, then the options in all but the Background selection will be 
disabled). The dataset will be pseudo-colored with the color map displayed on the right side of the 
display.

(6) From the View menu in the 3D Viewer, select Orthogonal Slices. To change the dis-

played slices, click the Subvolume button , then left click on any plane of the orthogonal slice 
view. The slice displayed will change as you drag the mouse. The slice selected will be high-
lighted in yellow. This will work in any view within the 3D Viewer.

(7) To zoom the dataset, click the Zoom button  in the 3D Viewer Toolbar and left click 
and drag from the bottom-right to the top-left of the image. Reverse the drag direction to shrink 
the image.

(8) From the View menu, select Volume Projection - Hardware (if your video card supports 
it. If it does not, move on to step 9 below). By default the Maximum Projection of the dataset is 

shown. Rotate the dataset by clicking the Rotate button , then left clicking and dragging on 
the display. As the object rotates, a low-resolution version of the dataset is rendered. When the 
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mouse button is released, a higher-resolution version is rendered. For maximum resolution with 
large datasets, select 'Full Res View' from the Options menu.

(9) From the View menu select Cube Surface. From the Oblique menu select Display Slice. 

The Oblique Slice appears on the XY plane. To rotate the Slice, click the Oblique button , 
then left click on the object and move your mouse. To move the Slice, click on the Subvolume but-
ton, left click on the slice, and move your mouse. To rotate the object while the Oblique button (or 
any other button in the 3D Viewer toolbar) is depressed, use the right-click button on the mouse, 
and the click and drag to rotate.

(10) From the Projection menu, select Surface Slice. Click the Subvolume button, left click on 
any of the cube faces, and move your mouse to select a sub-volume for display. 

Useful Key & Mouse Combinations for the 3D Viewer

To crop the volume or move an Orthogonal/Oblique Slice:
Select Display Slice from the Oblique menu, click on the Subvolume button, left click on 

the plane/slice and drag.

To rotate the Oblique Slice: 
Click on the Oblique button, then left click on the Oblique Slice and drag.

To zoom the displayed image:
While the Rotation button is clicked, right click on the image and drag from bottom right 

to top left (or vice-versa). Alternatively, click on the Zoom button, then left click on the image and 
drag from bottom right to top left (or vice-versa).

Explanation of 3D Viewer Menus

View Menu

This menu allows you to specify which viewing mode to use. You may choose from the following 
choices: Volume Projection, Orthogonal Slices, Cube Surface, Isosurface or Height Map.

Volume Projection (Software and Hardware)

This feature displays a single 2D projection of the 3D volume as seen from your perspective at the 
object’s selected orientation. The Volume Projection Software will work slower than the other two 
options, but will offer a higher resolution of the dataset. The 2D Textures and 3D Textures projec-
tions require the proper video cards (see page 16 for the recommended video cards) and will ren-
der and rotate considerably quicker than the Volume Projection Software option. The 3D Textures 
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projection provides a more seamless rotation of your dataset than the 2D Textures, removing 
some of the artefacts. See Software and Hardware Requirements - Windows Systems in Chapter 2 
for a list of video cards that will support the Volume Projection-Hardware option.

Orthogonal Slices

This feature displays three single orthogonal planes, oriented to the object’s XY, XZ, ZY perspec-
tives. These planes may be adjusted by holding down the CTRL key, left-clicking on a plane, and 
dragging (while still holding the CTRL key).

Cube Surface 

This feature displays a cube, which has on each surface a painted projection of the dataset as 
would be seen from directly above that surface or view. The projection shown depends on the pro-
jection selected.

Isosurface

This feature displays your dataset as a solid body, with distinct surface and edge recognition and 
light reflection with quick rendering and rotation. An advantage to this feature is when using the 
oblique slice, a much clearer image is rendered as you scroll the slice through the 3D image. 

Adjust Minimum Threshold

When selecting the Isosurface projection, a dialog will appear, giving you the option to threshold 
the image. There are five options:

• Use the current threshold - If thresholding has already been performed, this 
option will say Use the current threshold of x. This option leaves the thresholding as it is

• Auto threshold - This option automatically determines what is the best 
minimum threshold for that dataset.

• Adjust threshold to... - This option allows the user to enter a minimum 
threshold value.

• Binning Factor - This option combines two or more intensities into one to 
allow for quicker rotations and renderings. This decreases the amount of data, while also slightly 
decreasing the detail. See page 99 for more information on binning.

• Use Smooth Data - This option smooths the data out, removing noise from 
it. 

Height Map

This feature displays a 3D image intensity height map of the rendered dataset. 
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Projection Menu

This menu allows you to specify which 2D projection will be shown in the 3D Viewer. You may 
choose from the following choices:

• Maximum projection
• Sum projection
• Minimum projection
• Voxel Gradient
• Alpha Blending
• Best Focus 
• Surface Slice

All projection options are active when your image view is Volume Projection or Cube Surface. If 
your view is Orthogonal Slices, Surface Slice view will be the only active projection.

Surface Slice

This feature allows you to view the first slice from each side of your dataset. 
For example, with a darkfield dataset that was scanned well above and well below the sample, its 
Surface Slice projection will have a dark slice projected for the Top view and Bottom view of the 
Surface Slice projection. 

Note: See Tutorials for Visualization Menu Items for an explanation of these projections.

Rotation Menu

Free

This feature allows you to view unconstrained rotations of the object. An unconstrained rotation is 
produced when the object is rotated about multiple axes simultaneously; your object will rotate in 
any direction your mouse moves.

Object

This feature sets the object up to rotate around one of its three axes. You may specify the rotation 
for the object axis by selecting Object and choosing the “Axis” of rotation (X, Y, Z axis) from the 
Rotation menu. Once the axis is selected, the object will only rotate along that axis. The object 
axes are in relation to the dataset (object) itself; that is, the object X, Y, and Z axes always run 
along the width, height, and optical sections of the dataset, respectively, regardless of how the 
dataset is currently oriented.
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Screen

This feature constrains the rotations to the screen axis selected. Under the Rotation menu you 
would select Screen and choose the desired axis. The screen axes are in relation to your display; 
that is, the screen X and Y axes always run along the width and height of the screen, respectively, 
and the screen Z axis always runs along your line of sight, regardless of how the dataset is cur-
rently oriented.

Best Axis

When a rotation is being performed by dragging the mouse across the object, the Best Axis setting 
determines the single axis that is closest to the mouse’s direction of movement. This allows you to 
rotate around one axis at a time without having to continually specify the explicit axis of rotation.

X, Y, Z axes 

This feature allows you to confine the rotation only about the enabled axis. All mouse movements 
made to rotate the object will only rotate the object to the extent that the mouse moves along the 
selected axis.

Go to View

This feature allows you to change the dataset to the XY, XZ, or ZY view.

Rotate 90

This feature allows you to rotate the view by 90 degrees around the X, Y, or Z Axis.

Oblique Menu

This feature is used to manipulate the display of the Oblique Slice view.

Display Slice

This feature toggles on and off the display of an oblique slice through the object. When Display 
Slice is selected all other options under the Oblique menu are made active.

Go to Origin

This feature allows you to reset the slice if you loose the slice off the edge of the object. It sets the 
oblique origin to the last selected orthogonal slice intersection point.
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Fix Plane

This feature confines the position and orientation of the oblique plane to remain fixed relative to 
the screen when the object rotates. This means that while the object rotates, the oblique plane will 
be continually updated with the current view of the dataset on that fixed cutting plane.

Flip Plane

The Oblique plane is set to remove one part of the object and it will retain everything below or 
behind the slice. Flip plane reverses the part that is removed. 
The XY, XZ, and ZY buttons allow you to automatically orient the object to the standard perspec-
tives of XY, XZ, or ZY. Additionally, the “Flip” button allows you to view the current orientation 
from the rear of the sample, effectively rotating the object 180 degrees about the screen’s Y axis.

XY, XZ, and ZY 

This feature slices through the object’s XY, XZ, or ZY plane.

Parallel 

This feature orients the Oblique Slice (the cutting plane) so it is parallel to the 3D Viewer screen. 

Movie Menu

This feature allows you to generate a movie of your dataset.

Play Movie

This feature starts a movie in playback.

Stop Movie

This feature stops a movie in playback.

Quick Movies

This feature allows you to generate a movie “quickly” by spinning the dataset about the X or Y 
axis using predetermined angles.

Rotate Y Axis

This feature allows you to choose from +/- 30, +/-45, +/-60, +/-90, +/-180 degrees for which the 
object will rotate about the Y Axis.
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Rotate X Axis

This feature allows you to choose from +/- 30, +/-45, +/-60, +/-90, +/-180 degrees for which the 
object will rotate about the X Axis.

Original View

This feature allows you to reset the position of the dataset back to its original orientation.

Set Start Point

This feature allows you to set the start point of the movie. 

Set Mid Point

This feature allows you to indicate that a view has been set as an intermediate point through 
which the rotating object should pass at the middle of the movie.

Mid Point Active

This feature allows you to indicate that the rotating object will pass through the defined midpoint. 
If the Mid Point Active is not set the movie will take the shortest path from the start to the end 
point.

Set End Point

This feature allows you to set the end point of the movie.

Set Step Angle

This feature allows you to select the size of the rotation angle between successive frames of the 
movie. You may choose from 5, 10, and 15 degrees. A smaller step size will cause more movie 
frames to be generated between points.

Go to Point

This feature allows you to go to the Start, Mid or End point of the movie.

Loop Mode 

This feature plays the movie from start to end, then start to end, and continues repeating.

Rock Mode

This feature plays the movie from start to end, then end to start, and continues repeating.
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Opposite Path 

This feature is for any pair of object positions where there are two possible rotational paths 
between the waypoints. By default, the movie generator will take the shortest rotational path. 
When Opposite Path is selected, the movie generator will take the opposite or longer rotational 
path.

Create Movie

This feature allows the 3D Viewer to generate a finalized version of the specified movie, and open 
it in the main viewing window. 

Color Map Menu

This feature allows you to select a color map in which to display your dataset. You may choose 
from different colors, look up tables, wavelengths, or probe types. You can also select a color for 
the background, as well as reverse the colors of the dataset.

Color

This features allows you to select a color based on a single color. The choices are: Gray, Red, 
Green, Blue, Cyan, Yellow, and Magenta.

Look Up Table

This feature allows you to select a color based on a look up table. The choices are: Red Fire, 
Green Fire, Blue Fire, Black Body, Copper, Cool, Jet, and Spectrum.

Wavelength

This features allows you to select a single wavelength to use as a color map for your image. You 
may choose from: 400nm, 450nm, 500nm, 550nm, 600nm, 650nm, 700nm, and 750nm.

Probe

This feature allows you to choose a color map based on the associated dye from a drop-down list.
You may choose from some of the most popular fluorescent dyes, like: Dapi (456nm), Cy2 (506), 
Fluorescein (519nm), Fitc (520nm), Lucifer Yellow (528nm), GFP (540nm), Cy3 (570nm), 
DsRed (583nm), Rhodamine (590nm), Cy3.5 (596nm), Propidium Iodide (617nm), Texas Red 
(620nm), Cy5 (670nm), Cy5.5 (694nm), and Cy7 (767nm). By using these dye selections, a sam-
ple can be viewed as colored with the chosen dye wavelength.
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Background

This feature allows the user to set the color of the background of the 3D Viewer. The choices are: 
White, 75% Gray, 50% Gray, 25% Gray, Black, Black to White, and White to Black. Black to 
White and White to Black create gradients from top to bottom (Black to White would be black on 
top and fade to white on the bottom). Additional options are available in the Color Maps tab in the 
Control Panel.

Reverse

This feature reverses the order of the color map intensity scale of the selected color map. Color 
map points that normally indicate high intensity areas will then indicate low-intensity areas, and 
vice versa.

Save Menu

This feature is used to save your dataset as either a 2D image or a rotated volume.

Current View

This feature saves the current view as a 2D image to the main viewing window. You may save the 
2D image permanently by selecting Save As from the File menu in the main window and saving 
the dataset.

Rotated Volume

This feature saves the rotated image to the main viewing window. You may save the Rotated Vol-
ume permanently by selecting Save As from the File menu in the main window and saving the 
dataset.

To Clipboard

This feature allows you to copy the 3D Viewer screen to a clipboard, which can then be pasted 
into an image editing application, such as Photoshop.

Save Default View

This feature allows you to save the settings for the 3D Viewer, so that whenever the 3D Viewer is 
opened, it will open in whatever view it is saved in, with whatever options are turned on and off.

Reset Default View

This feature will reset the default view (the view in which the 3D Viewer opens) to the original 
software defaults.
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Save Settings

This feature allows you to save the settings that you have created and subsequently apply them to 
different datasets later.

Load Settings

This feature allows you to load previously saved settings, and apply them to the current dataset.

Options Menu

This feature allows you to access general options that apply to all of the functionalities of the 3D 
Viewer.

Control Panel

This feature opens up the Control Panel. See “Control Panel” below for further details.

Whole Volume

This feature gives you a direct way to restore the dataset to its full dimensions after it has been 
cropped from a subvolume.

Full Res View

This feature allows the 3D Viewer to generate a full resolution view of the dataset. This may take 
a few seconds to generate and only works for the Volume Projection view. If you rotate the 
dataset, the rendering returns to the lower resolution version.

Correct Aspect

This feature allows the visible dimensions of the object displayed in the 3D Viewer to be adjusted 
to take into account the pixel spacings. When enabled, the displayed voxels will be cubic in 
dimension.

Auto Rotate

This feature enables the object to continually rotate once the object has been set in motion.

Display Floor

This feature displays the black and white checkered floor pattern. The floor is not visible when the 
Perspective View under the Control Panel is Off or the Volume Projection view is On.
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Display Axes

This feature will display colored bars on the axes to make it easier to identify the orientation of 
the object. The X axis is red, the Y axis is green and the Z axis is blue. The axes can be labeled in 
the Captions/Axes tab of the Control Panel.

Display Grid

This feature will display a grid around the object in order to give a perspective of the size of the 
features within the object. The spacings of the grid can be adjusted in the Captions/Axes tab of the 
Control Panel.

Display Scale Bar

This feature will display a Scale Bar in the lower-right corner of the 3D Viewer, which will adjust 
its size as the object is zoomed. This is useful for giving a perspective to the size of the object, and 
to a lesser extent, the size of features within the object.

Logo

This feature allows you to load and display a logo in the lower-left corner of the 3D Viewer. The 
logo requirements are that it be a 24-bit bitmap file, no larger than 256x256. If the file is larger 
than 256x256, the logo will automatically be cropped.

 Perspective View

This feature displays the view of the image in a depth perspective, so that closer objects appear 
larger than distant objects.

Stereo Mode 

Off

This feature is the default setting, and keeps the stereo view turned off.

Anaglyph

This feature shows contrasting colors that appear 3-dimensional when superimposed. Only gray-
scale images can be viewed in anaglyph stereo mode.

LCD Glasses

Note: This option will only be available if you have the hardware necessary to support it.

This feature is for systems with OpenGL enable Stereo Viewing capability (e.g. StereoGraphics 
CrystalEyes LCD glasses). This capability splits the image into two alternating components to 
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produce a 3D effect that is visible through special stereo goggles; since this method does not 
require special coloring, color images as well as grayscale images may be viewed in this mode. 

Anaglyph Colors

The feature splits the image into two differently colored components to produce a 3-dimensional 
effect. This is the familiar Red/Blue 3D effect (though other color pairs may be selected like: Red/ 
Cyan, Red/Blue, Red/Green, Cyan/Red, Blue/Red, Green/Red, Left Only, and Right Only). Since 
the image is specially colored, only grayscale images can be viewed in anaglyph stereo mode.

Auto Threshold

This feature automatically determines what is the best minimum threshold for that dataset and 
implements it.

Toolbar

The 3D Viewer contains a toolbar for some of the more common actions performed on the dataset.

• Rotate  - When the Rotate button is depressed, use the left mouse but-
ton to click and drag on the object to rotate it along any axis.

• Zoom  - When the Zoom button is depressed, hold down the left mouse 
button and move the mouse from left to right and back. Dragging the mouse to the right will zoom 
out, dragging the mouse to the left will zoom in. Use the right mouse button to click and drag on 
the object to rotate it along any axis.

• Subvolume  - When the Subvolume button is depressed, left click on 
any plane of the orthogonal slice view. The slice displayed will change as you drag the mouse. 
The slice selected will be highlighted in yellow. Use the right mouse button to click and drag on 
the object to rotate it along any axis.

• Oblique Rotate  - To activate the Oblique Rotate button, select Display 
Slice from the Oblique Menu. The Oblique Slice appears on the XY plane. To rotate the Slice, 
click the Oblique Rotate button, then left click on the object and move your mouse. Use the right 
mouse button to click and drag on the object to rotate it along any axis.

• Threshold  - To increase or decrease the threshold of the dataset, 
click and hold on the desired Threshold button (the button on the left increases the threshold, the 
button on the right decreases the threshold) until the dataset reaches the desired appearance.

• Brightness  - To increase or decrease the brightness of the dataset, 
click and hold on the desired Brightness button (the button on the left increases the brightness, the 
button on the right decreases the brightness) until the dataset reaches the desired appearance.

• Movie Controls - The movie controls on the bottom of the 3D Viewer can 
be used for several uses. The default use of the controls is to scroll through a 360 degree rotation 
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along the X axis. The Play button  will scroll through the entire 360 rotation. The Step For-

ward/Step Backward buttons  will move the dataset through one step of the 360 degree 

rotation in either direction (depending on the button clicked). The Rock button  will allow the 

dataset to rotate back and forth in the Play mode until the Stop button  is clicked (once the 
Play button is clicked, it turns into the Stop button). The Scroll Bar can also be used to rotate the 
dataset along the X axis, either by clicking along the Scroll Bar, or by clicking and dragging on 
the pointer in the Scroll Bar. If the dataset loaded is a time-series dataset, then these controls will 
move the dataset through the timepoints.

Control Panel

The Control Panel allows you to access all features of the 3D Viewer. It is recommended that 
the Control Panel not be used to make adjustments until expertise has been acquired in using the 
3D Viewer.

Display Tab

The Display tab allows you to specify from a choice of several parameters that will affect the 
viewing mode of the image.

Rendering View frame:

Rendering

This feature allows you to select how your dataset is displayed.

Volume Projection (Software, 2D Textures and 3D Textures)

This feature displays a single 2D projection of the 3D volume as seen from your perspective at the 
object’s selected orientation. The Volume Projection Software will work slower than the other two 
options, but will offer a higher resolution of the dataset. The 2D Textures and 3D Textures projec-
tions require the proper video cards (see page 16 for the recommended video cards) and will ren-
der and rotate considerably quicker than the Volume Projection Software option. The 3D Textures 
projection provides a more seamless rotation of your dataset than the 2D Textures, removing 
some of the artefacts.

Orthogonal Slices

This feature displays three single orthogonal planes, oriented to the object’s XY, XZ, ZY perspec-
tives. These planes may be adjusted by holding down the CTRL key, left-clicking on a plane, and 
dragging (while still holding down the CTRL key).
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Cube Surface 

This feature displays a cube, which has on each surface a painted projection of the dataset as 
would be seen from directly above that surface (view). The projection shown depends on the pro-
jection selected.

Isosurface

This feature displays your dataset as a solid body, with distinct surface and edge recognition and 
light reflection with quick rendering and rotation.

Height Map

This feature displays a 3D image intensity height map of the rendered dataset.

Projection

This feature allows you to specify a 2D projection. The choices are:

• Maximum Projection
• Minimum Projection
• Sum Projection
• Voxel Gradient
• Alpha Blending
• Best Focus
• Surface Slice

Full Res

This button allows the 3D Viewer to generate a full resolution view of the dataset. This may take 
a few seconds to generate and only works for the Volume Projection view. If you rotate the 
dataset, the rendering returns to the lower resolution version.

Save Current

This button allows you to generate a 2D view of the image that can be saved. This function is sim-
ilar to taking a print screen or a snap shot of the image in the 3D Viewer window. 
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Image Appearance frame:

Render Range (0-100%)

Maximum and Minimum Rendering Thresholds

This feature allows you to specify the maximum and minimum image rendering thresholds. Inten-
sities above and below these respective percentages will not be displayed. The threshold range is 
0 to 100%.

Alpha

This feature allows you to specify the Alpha value to be applied to Alpha projections displayed in 
the 3D Viewer.

Display Range (0-100%)

This feature allows you to adjust image brightness levels to improve visibility of features of inter-
est.

Brightness

This feature allows you to specify a threshold percentage above which all intensities are increased 
to maximum.

Darkness

This feature allows you to specify a threshold percentage below which all intensities are 
decreased to minimum.

Gamma

This feature allows you to apply the specified gamma correction factor to the image.

Zoom

This feature allows you to specify a zoom factor for the image. Higher values enlarge the image, 
and lower values reduce the image.

Apply

This button applies new values to your dataset.

Default

This button resets the Image Appearance values to their defaults.
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Properties frame:

Correct Aspect

This feature allows you to rescale the image along Z so as to more accurately reflect the actual 
proportions of the object, as defined through its X, Y, and Z spacings.

Plane Outline

This feature allows you to outline the boundaries of the dataset around orthogonal planes, and 
around subvolume boundaries. This aids in judging the orientation of the dotted line, and in judg-
ing the relative positions of the planes and the subvolumes.

Transparency

This feature allows you to toggle between whether the background areas of the object are trans-
parent or not.

Display Floor

This feature allows you to toggle between whether the checkered floor pattern is On or Off in the 
3D Viewer.

Perspective View

This feature allows you to toggle between whether the perspective view (tapered geometry toward 
horizon) is On or Off.

Auto Rotate

This feature allows you to toggle between whether the inertia-based rotation (i.e., toggles between 
whether or not the object can continue spinning after the mouse is released following a rotation) is 
On or Off.

Stereo View

This feature allows you to toggle between whether the 3D stereo-split view is On or Off.

Subvolume Tab

Subvolume frame:

This feature allows you to specify exactly a subvolume to be rendered. In the edit boxes (X from, 
Y From... and to), you may specify the first and last slices that should be included in the subvol-
ume’s region along each of the X, Y, and Z axes.
March, 2004                     Page 87



AutoQuant Imaging, Inc.                   Manual and Tutorials
Once the edit boxes have been filled, click Apply to make the changes take effect.
To quickly restore the full volume, click the Whole Volume button.

Orthogonal Slices frame:

This feature allows you to specify exactly which slice along each of the X, Y, and Z axes should 
be displayed in the Orthogonal Slices view. The values may range from 1 to the number of slices 
along the corresponding axis. Click the Apply button to make the changes take effect.
In addition, the three checkboxes in this group allow you to display any combination of the planes 
by checking or unchecking them. Click the Apply button to make the changes take effect.

Manual Input

This feature allows you to set the object’s rotational center manually using the X, Y, and Z Slice 
boxes.

Whole Volume

This feature allows you to set the object’s rotational center to be the geometric center of the 
dataset’s full volume. This is the default center.

Subvolume

This feature allows you to set the object’s rotational center to be the geometric center of the cur-
rently selected subvolume.

Center of Mass

This feature allows you to determine the coordinates of the dataset’s center of mass, and then set 
the object’s rotational center to these coordinates.

Object Center

This feature allows you to determine the coordinates of the object’s center of mass, and then set 
the object’s rotational center to these coordinates.

Note: When in orthogonal slices mode, the orthogonal planes may also be selected in the main 
display by holding CTRL, and left-clicking and dragging any one of the slices displayed.

Object Center frame:

This feature allows you to specify the rotation center of the object being displayed. You may spec-
ify the exact coordinates of the center of rotation using the edit boxes. The values may range from 
1 to the number of slices along the corresponding axis.
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In addition, several predetermined rotational centers of interest may be selected and automatically 
calculated. These centers are:

Manual Input

This feature allows you to set the object’s rotational center manually.

Whole Volume

This feature allows you to set the object’s rotational center to be the geometric center of the 
dataset’s full volume. This is the default center.

Subvolume

This feature allows you to set the object’s rotational center to be the geometric center of the cur-
rently selected subvolume.

Center of Mass

This feature allows you to determine the coordinates of the object’s center of mass, and then sets 
the object’s rotational center to these coordinates.

Ortho Slices

This feature allows you to set the object’s rotational center to the coordinates specified by the 
intersection of the three orthogonal planes (as specified in the “Orthogonal Slices” frame).

Rotation Tab

Rotate

This feature allows you to determine whether the remaining controls on this tab will adjust the 
positioning of the Object or the Oblique Slice (The dataset must be in slices for Oblique Slices to 
be active – if not, then only the Object may be selected).

Current Rotation frame:

Anchor

This feature allows you to specify the axis about which the object rotates when the slider bar is 
used to rotate the image. Use the slider bar to spin the object about the anchor axis.

Angle

This feature allows you to specify an exact angle of rotation about the X, Y, and Z axes. Using the 
three field boxes you may set the Angle of rotation for the X, Y, and Z axes.
March, 2004                     Page 89



AutoQuant Imaging, Inc.                   Manual and Tutorials
Note: The order in which these rotations are executed depends on the anchor axis chosen.

After entering a set of rotation angles in the edit boxes, use the Apply button to rotate the object to 
the specified point. Alternatively, you may use the Reset button to return the object to its original 
orientation (i.e., its orientation upon being loaded into the 3D Viewer).

Round 

This button, when clicked, will round the object’s rotation angles to the nearest whole degree 
interval, as specified in the accompanying drop-down menu.

The Apply button applies the current Anchor Axis and Angle to the object, and the Reset button 
will set the object back to its original view.

Preset Views frame:

The XY, XZ, and ZY buttons allow you to automatically orient the object to the standard perspec-
tives of XY, XZ, or ZY. Additionally, the Flip button allows you to view the current orientation 
from the rear of the sample, effectively rotating the object 180 degrees about the screen’s Y axis.

Rotate Object frame:

The feature allows you to control the incremental rotations about a particular axis.

Axis

This feature allows you to select the axis about which to rotate the object. The object will rotate 
about its own X, Y, or Z axis, depending on the selection, rather than the X, Y, and Z axes per-
ceived by you when you’re looking at the screen.

Angle

This feature allows you to select the angle by which to rotate the object about the specified axis.

Each time the Apply button is clicked, the object will rotate the selected number of degrees about 
the selected object axis.

Constrain Rotation frame:

This feature allows you to select whether the object may rotate freely when manipulated (i.e., 
rotate about multiple axes simultaneously), or if the rotation of the object should be constrained to 
one axis at a time. This can be useful to prevent unwanted rotations from occurring due to slightly 
imprecise mouse movements.
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Around

This feature allows you to choose the anchor of rotation your object will be constrained to.

Axis

This feature allows you to choose which axis you would like the object rotated about. It only is 
active if Object or Screen is selected for the Around type.

Oblique Tab

Oblique Slice frame:

There are two settings: Display Oblique Slice and Fix to Screen.

Display Oblique Slice

This feature toggles between whether the display of an oblique slice is visible through the object 
or not.

Fix to Screen

This feature when selected, locks the position and orientation of the oblique plane when the object 
rotates. The oblique plane will be continually updated with the current view of the dataset on that 
fixed cutting plane, while the object rotates.

Offset from Origin

This feature allows you to choose a value to offset the Oblique Slice from the origin. The slider 
moves the oblique slice back and forth along its normal axis. The associated number indicates the 
offset (in slices) of the current oblique slice’s position from the origin.

Preset Views frame:

XY, XZ, ZY

The XY, XZ, and ZY buttons allows you to automatically orient the oblique plane to cut a straight 
section halfway along the optical axis from each of the standard perspectives of XY, XZ, or ZY. 

Flip

The “Flip” button allows you to reverse the direction of the cutting plane, so that the visible por-
tion of the object becomes the cut portion, and vice versa.
March, 2004                     Page 91



AutoQuant Imaging, Inc.                   Manual and Tutorials
Origin

This feature repositions the Oblique Slice to pass through the object’s origin.

Parallel

The Parallel button brings the Oblique plane parallel to the view screen.

Oblique Origin frame:

The controls in this group determine the object coordinates that serve as the oblique origin. The 
oblique plane and parallel slice are calculated with respect to this origin.

X, Y, and Z Slice

This feature indicates the (X, Y, Z) coordinates of the Oblique Origin.

Calculate Origin from:

Manual Input 

This feature allows you to set the object’s rotational center manually.

Whole Volume

This feature gives you a direct way to restore the dataset to its full dimensions after it has been 
cropped from a subvolume.

Subvolume

This feature allows you to set the object’s rotational center to be the geometric center of the cur-
rently selected subvolume.

Center of Mass

This feature repositions the oblique slice to pass through the center of mass of the dataset.

Ortho Slices

This feature resets the oblique origin to the last selected orthogonal slice intersection point.

Object Center

This feature resets the oblique origin to the object’s center of rotation.
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Apply

This feature sets the oblique origin to the coordinates presently indicated in the X, Y, and Z slice 
edit boxes.

Equation (Ax + By + Cz + D > 0)

Note: This is for advanced users.

This feature contains the edit boxes used to specify an exact oblique plane by specifying its planar 
equation.

Movies Tab

Quick Movie frame:

This frame allows you to quickly create a simple rotational movie using a few often-used movie 
parameters. Movies created from this group rotate about a single axis, from one angular offset to 
another.

Rotate current view about

This feature allows you to decide whether to constrain the Movie to the Object or the Screen, the 
axis (X, Y, Z) which the object will be rotated about, and the starting position and ending position. 

When the X, Y or Z axis is selected for rotation, you may rotate your dataset “from” and “to” 0, +/
-15, +/-30, +/-45,+/- 60, +/-90, +/-180, +/-270, +/-360 degrees.

Note: The offsets used to generate the movie are relative to the view that is displayed at the time 
“Apply” is clicked.

Control Movie Points frame:

The controls in this group allow the creation of movies that rotate about more than one angle.

Start

This field when checked, indicates that a movie starting point is activated.

Mid

This field when checked, indicates that a view has been set as a pathway point through which the 
rotating object should pass at the middle of the movie.

End

This field when checked, indicates that a movie ending point is activated.
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Each of these pathway points has an associated “Set” and “Go to” button. The “Set” button in 
each case sets the current orientation of the object to be the associated pathway point. The “Go to” 
button in each case reorients the object to display the currently selected position of the associated 
pathway point.

Opposite Path 

This feature is for any pair of pathway points. There are two direct rotational paths between the 
pathway points. By default, the movie generator chooses the shortest rotational path between the 
two pathway points. When this box is checked, the movie generator will select the other direct 
rotational path (i.e., the longer route).

Low res/faster

This feature allows the 3D Viewer to generate a movie quicker, with only a slight decrease in res-
olution.

Play Movie frame:

This group controls the movie playback options and movie playback itself.

Stop

This feature halts a movie in playback mode.

Play

This feature begins a movie playing or puts the movie in playback mode.

The slider bar allows you to scroll through the movie frames. On clicking “Play”, playback will 
begin from the selected frame.

Step Angle 

This feature determines the size of the rotation angle between successive frames of the movie. A 
smaller step size will cause more movie frames to be generated to move between the pathway 
points.

Frames/sec

This feature determines the frame rate of the final movie. This does not affect the speed of the 
movie preview, but is stored in the movie header so that a final movie file generated from the 3D 
Viewer replays at the desired rate.
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Rock Mode

This feature when checked, sets the movie preview to rock from start to end, then end to start, and 
repeats. When unchecked, the movie preview will loop, going from start to end, then start to end, 
and continues repeating.

Opposite Path

The Opposite Path feature will run the movie in the opposite direction. In other words, if you 
select to rotate the object +/-30 degrees, the Opposite Path option will actually turn the object 330 
degrees.

Create Movie

This feature when clicked, generates a finalized version of the specified movie, and will create a 
new movie document, which may then be saved to an AVI or similar format movie file.

Display Movie on Desktop Message

Checking this box will, once the movie is created, cause a message to appear alerting you to the 
fact that the 3D Viewer may need to be moved in order to view the created movie. Click OK, then 
move the 3D Viewer if necessary. Checking the Do not display this message again box will 
ensure that this message does not get displayed again.

Color Maps Tab

Current Color Maps frame:

Display
This feature allows you (for a multichannel image) to select whether or not a channel will be dis-
played. The checkboxes next to each channel label allows you to turn on or off the display of that 
channel. If more than one channel is displayed, the option of changing the Color Map may not be 
used; each channel is represented as one of the Color Maps red, green, or blue.

Select
This feature is active when only one channel is active, and it indicates that a new color map may 
be selected for that channel.

Color Map
This feature displays the current color map for the associated channel. The choices are: Gray, Red, 
Green, Blue, Cyan, Yellow, Magenta, Orange, and Custom.

Reverse
This feature reverses the intensity scale of the selected color map. The color map points that nor-
mally indicate high intensity areas will then indicate low-intensity areas, and vice versa. The 
Reverse checkbox is only available when only one channel is being displayed.
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Monochrome
This feature is for multi-channel images. Checking this box will cause the color image to be dis-
played as grayscale. Activating this option allows a color image to be rendered in a stereo view 
using split-color anaglyphs.

Select Color Map frame:

Color
This feature allows you to select a color map based on a single color. The associated drop-down 
list offers a standard group of colors, as well as the choice to select a custom color. The Color 
choices are: White, Red, Green, Blue, Cyan, Yellow, Magenta, Orange, and Custom.
 
Look Up Table
This feature allows you to select a color map based on multiple colors. The associated drop-down 
list offers several maps that vary in color as intensity changes. The preset colors or color spec-
trums are as follows: Gray, Red Fire, Green Fire, Blue Fire, Black Body, Copper, Cool, Jet, and 
Spectrum. 

Fluorescent Probe
This feature allows you to choose a color map based on colors of popular fluorescent dyes: Dapi 
(456nm), Cy2 (506), Fluorescein (519nm), Fitc (520nm), Lucifer Yellow (528nm), GFP (540nm), 
Cy3 (570nm), DsRed (583nm), Rhodamine (590nm), Cy3.5 (596nm), Propidium Iodide (617nm), 
Texas Red (620nm), Cy5 (670nm), Cy5.5 (694nm), and Cy7 (767nm). In this way, a sample can 
be viewed as colored with the chosen wavelength.

Wavelength
This feature allows you to generate a color map based on a wavelength, in nanometers. In this 
way, the sample can be viewed as colored with the chosen dye wavelength.

Background
This feature sets the background color of the 3D Viewer. The Top and Bottom selections allow 
you to create a gradient color for the background, by selecting one color for the Top, and another 
color for the Bottom. A gradient will be formed between the two colors. Alternatively, the same 
color can be chosen for the top and bottom, and the background will be a solid color. The color 
choices are: White, 75% Gray, 50% Gray, 25% Gray, Black, Red, Green, Blue, Cyan, Yellow, 
Magenta, Orange and custom.

Apply
This feature will apply the current color map settings to the 3D Viewer display.
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Settings/Stereo Tab

Pixel Spacing frame:

X, Y, and Z Spacing
This feature allows you to specify the X, Y, and Z pixel scale sizes (in micrometers).

Aspect Ratio
This feature allows you to specify the dataset’s ratio between the Z and X dimensions.

Apply
This button applies the selected settings.

Auto Calculate Ratio

This feature, when checked, automatically calculates and displays the dataset in the resulting ratio 
of the Z-spacing to the X-spacing. When unchecked, you may modify the visible aspect ratio 
without altering the spacings.

Correct Aspect Ratio
This feature, when checked, allows the visible dimensions of the object displayed in the 3D 
Viewer to be adjusted to take into account the pixel spacings in addition to the number of pixels in 
the X, Y, and Z dimensions.

Stereo View frame:
The controls in this group specify how a stereo view will be created, and whether it is toggled on 
or not.

Mode
This feature allows you to select between the available stereo view modes.

Anaglyph
This feature allows you to split the image into two differently colored components to produce a 3-
dimensional effect. This is the familiar Red/Blue 3D effect (though other color pairs may be 
selected – see “Filter”). Only grayscale images can be viewed in anaglyph stereo mode.

Stereo Goggles 
Note: This option will only be available if you have the hardware necessary to support it.

This feature allows you to split the image into two differently flickering components to produce a 
3-dimensional effect that is visible through special stereo goggles. This feature is for systems with 
OpenGL enable Stereo Viewing capability (e.g. StereoGraphics CrystalEyes LCD glasses). Since 
this method does not require special coloring, color images as well as grayscale images may be 
viewed in this mode.
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Filter
This feature allows you to select image filters for the stereo view. Primarily, this allows the selec-
tion of the anaglyph color pair used in generating an anaglyph stereo image. In addition, you may 
choose to display only the left or right image of the stereo pair.

Angle
This feature allows you to specify the angular offset between the two images of the stereo pair. 
This number may be adjusted to optimize the 3-dimensional effect for a particular user (the opti-
mum value for this is affected by your distance from the monitor and the distance between your 
eyes).

Stereo On
This feature, when checked, displays the stereo view in the 3D Viewer window.

Apply
Clicking this button applies the adjustments made within the Stereo View frame.

Display frame:

Perspective Angle
This is the angular size of the 3D Viewer’s field of view. Reducing the angular size will produce 
many affects. It will decrease the size of the field of view of the 3D Viewer, it will reduce the 3D 
Viewer’s visible area around the dataset, and it will reduce the perspective effect on what is visi-
ble. Conversely, increasing the number increases the field size, and increases the perspective 
effect.

Hardware Volume Projection Quality
Provided your system has the required video card (see page 16 for a list of acceptable video 
cards), this section allows you to select the quality of the hardware projection. The choices are 
Highest, Medium and Fastest.

Apply
Clicking this button applies the changes of the Perspective Angle of the display.

Window Size
This feature allows the user to set the size of the display window. The entire 3D Viewer will adjust 
its size to accommodate the size entered. Enter the height and width of the desired display size (in 
pixels) in the appropriate text boxes.

Apply
Clicking this button applies the changes of the Window Size.
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Isosurface Tab

It is best to threshold your image when using the Isosurface view, such that the edges of your 
dataset have an intensity of 0 along all of the edges. Any intensities detected along the edges will 
be displayed as triangles in the Isosurface viewer.

Appearance Frame:

Bin factor
Binning an image combines two or more intensities into one, effectively decreasing the data, 
which slightly decreases the detail of the image while speeding up the rotation and recalibration 
of the data (thresholding, adjusting the gamma, etc.). A bin factor of 1 uses all of the available 
data, whereas a bin factor of 10 uses the least amount of available data. Select the bin factor either 
by entering in the desired bin factor (1-10) then clicking the Apply button, or using the up and 
down arrows to scroll to the desired bin factor and then clicking the Apply button.

Wire frame
Selecting this button will display a wire frame of the triangles that create your image. Deselecting 
this button will hide the wire frame.

Display Sides
Selecting this button will connect the sides of the object, filling in what appears to be empty 
spaces.

Decimation Frame

Decimate
This feature will perform an adaptive reduction of the triangles in the isosurface view. In the text 
box labeled Remove, enter the percentage by which to reduce the number of triangles, then click 
the Decimate button. In areas of low detail (such as flat areas), more triangles will be removed, 
whereas in areas of higher detail, less triangles will be removed, but overall, the percentage of tri-
angles entered in the text box will be removed.

Reset
Click the reset button to return the number of triangles to the original amount based on the bin 
factor.

Lighting Frame:

The controls in this group control how light will be projected onto the dataset. 

Display light
This feature will display the beam of light which illuminates the dataset. The beam can be rotated 
around the image by left-clicking and dragging it to the desired perspective.
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Shadow
This feature will project a shadow of the dataset as the light is projected onto it.

X, Y, Z
The X, Y and Z controls determine the 3D coordinates of the light beam. The ranges are -10 
through 10, with 0 being directly above the plane. It is best to drag the beam to the general desired 
position, then fine tune its position using the up and down arrows next to the text box on each 
axis.

Thresholds Frame:

Thresholding can be performed on the dataset from this section of the control panel.

Channel 1, Channel 2, Channel 3
These controls will threshold the dataset. If it is a single channel (black and white) dataset, only 
channel 1 will be active. If it is a multi-channel dataset, then the channels can be thresholded indi-
vidually, or simultaneously by selecting the Link checkbox. If the Link checkbox is selected, then 
the threshold values will be linked with the threshold values in the Display tab.

Alpha
This feature allows you to specify the Alpha value to be applied to Alpha projections displayed in 
the 3D Viewer.

Height Map Tab

Display Options Frame:

Bin Factor
Binning an image combines two or more intensities into one, effectively decreasing the data, 
which slightly decreases the detail of the image while speeding up the rotation and recalibration 
of the data (thresholding, adjusting the gamma, etc.). A bin factor of 1 uses all of the available 
data, whereas a bin factor of 10 uses the least amount of available data. Select the bin factor either 
by entering in the desired bin factor (1-10) then clicking the Apply button, or using the up and 
down arrows to scroll to the desired bin factor and then clicking the Apply button.

Height Factor
The height factor controls the degree to which the height factor is displayed. The higher the factor, 
the more dramatically the difference between low and high intensities will be shown. Either use 
the up and down arrows, or enter a number between 0.1 and 1.0 in the text box.

Project below
This feature will display the XY view of the dataset on the bottom of the height map image.

Display sides
This feature will display sides, connecting the bottom of the image (with the projection of the 
image, if the Project below option is chosen) to the height map.
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Project on surface(s)
This feature will overlay the image onto the height map.

Flip
This feature will switch the height map to a depth map of the image. The map will reverse the 
height map such that the map protrudes from the image towards you, rather than away from you 
when looking at the image in its default orientation. This feature allows you to analyze the inten-
sities side by side with the image in the XY perspective.

Wire frame
This feature will display the height mapped dataset as a wire frame.

Display Method Frame:

Use projection
Use this feature to use a projection mode when rendering the height map image. From the drop 
down menu, select one of the projections (Maximum Projection, Minimum Projection, Sum Pro-
jection, Voxel Gradient, Alpha Blending, Best Focus, Surface Slice). If Surface Slice is selected, 
the text box to the right of the drop down will become active, allowing you to select the slice to 
view, either by using the up and down arrows, or by entering the slice number into the text box.

Plane
Select the plane to be mapped (XY, XZ, ZY).

Use layered Data
This feature allows you to layer an image over a height map. You must first create a sequence 
containing the slices you wish to use. All of the slices must be the same size. You may display up 
to two height maps, and two images, so the sequence cannot be greater than four images. In a four 
slice sequence, slices one and two will be displayed as a height map, and slices three and four will 
be displayed as an image on top of the height map(s).

Height Source
This controls which slice(s) is displayed as the height map. Select either Slice 1 (only slice 1 will 
be displayed as a height map), Slice 2 (only slice 2 will be displayed as a height map) or Slices 
1&2 (both slices will be displayed as a height map).

Image Source
This controls which slice(s) is displayed as the image on top of the height map(s). If slice 1 is cho-
sen for the Height Source, then your only options for Image Source will be Height Data, which 
will overlay no image on top of slice 1, or Slice 2, which will overlay the image of slice 2 over the 
height map of slice 1. If slice 2, or slices 1 and 2 are chosen for the Height Source, then you can 
select Height Data, which will use no image on top of either slice. Or you can choose Slice 3, 
which will overlay slice 3 as an image on top of both slice 1and 2. Lastly, you can chose Slices 
3&4, which will overlay slice 3 onto slice 1, and slice 4 onto slice 2.
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Captions/Axes Tab

This tab allows you to enter text to display at the top and bottom of the 3D Viewer.

Captions

Header
Text entered into this section will be displayed at the top of the 3D Viewer.

Footer
Text entered into this section will be displayed at the bottom of the 3D Viewer.

Text Size
This feature sets the size of the Header and Footer. Type the desired font size into the text box.

Text Color
This feature sets the text color of the Header and Footer. The choices are: White, Black, Red, 
Green, Blue, Cyan, Yellow, Magenta, Orange, Custom.

Axes and Scale Bar

Axes
Checking this feature will display color-coded axes to make it easier to determine the orientation 
of the object. The X axis will be red, the Y axis will be green and the Z axis will be blue.

Axis Labels
Checking this feature will display the name of each axes above, below, or next to it, depending on 
its orientation. The default labels will be X, Y and Z respectively, however, you can change the 
names by entering the new name in the corresponding text box.

Grid
Checking this feature will display a grid around the object in order to give a perspective of the 
size of the features within the object.

Spacing Labels
Checking the Spacing Labels feature will display the spacings on the grid, as well as the axes, to 
assist in showing the actual size of the object and its features.

Length
This feature allows you to enter the distance in between the spacing labels. For instance, entering 
10 into the textbox will display gridlines and spacings of 10, 20, 30, 40 and so on. However, when 
zooming in and out, these will adjust for optimal display.

Scale Bar
Checking this feature will display a scale bar, which will assist in giving a perspective to the 
actual size of the object.
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Help Tab

This tab displays written instructions for manipulating the dataset in the 3D Viewer.

To rotate the object:
Left click on the image and drag in the desired direction.

To crop the volume or move an orthogonal/oblique slice:
Hold down the Ctrl key, left click on the plane/slice and drag.

To rotate the oblique slice: 
Hold down the Shift key, left click on the oblique slice and drag.

To zoom the displayed image:
Right click on the image and drag from bottom right to top left (or vice-versa).

Image Enhancement

 Depending on the display of the machine running the software, images may appear too dark, or in 
other cases, too bright. To compensate for these differences it is possible to perform a Gamma 
correction on a particular view.

(1) Navigate to the SmallHip folder, open the SmallHip.avz dataset and generate an XZ view.

(2) From the View menu, select Image Enhancement. The Image Enhancement dialog box 
will appear.

(3) Check the Ignore Background box. This will put the focus on the object and give a more 
detailed histogram of the data.

(4) Enter a value of 1.2 in the Gamma Correction field. Notice that the horizontal line on the 
histogram moves up, as well as a change in the image. The Gamma can also be adjusted by click-
ing on the grey box on either side of the horizontal line on the histogram, and dragging it up or 
down.

Note: A Gamma value of 1.0 restores the image to its original state. Values greater than 1 
brighten the image, whereas values below 1 darken the image. Gamma values may be between 0.1 
and 10.0.

(5)  You may also adjust the darkness and brightness of the image in any of several ways:
-Enter a new value in the Intensity text boxes. The text box on the left is for the minimum, 
and the text box on the right is for the maximum (the Image Enhancement dialog will 
default to the minimum and maximum values present in the image). The minimum must 
be less than the maximum.
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-Enter a new value in the Percentage boxes between 0 and 100. The text box on the left is 
for the minimum, and the text box on the right is for the maximum. The minimum must be 
less than the maximum.

-Left click on the red box on top of the histogram, and drag it to move the minimum inten-
sity indicator (red line) to the right. Left click on the green box on top of the histogram and 
drag it to the left to move the maximum intensity indicator (green line) on the histogram. 
The maximum intensity indicator can only be placed to the right of the minimum intensity 
indicator, and the minimum intensity indicator can only be placed to the left of the maxi-
mum intensity indicator.

The intensity values are used in a histogram stretching intensity filter. For 8 bit data, this filter sets 
all the pixel values that are greater than the maximum parameter to 255, and all the pixel values 
less than the minimum parameter to 0. Pixel values, which fall in between the brightest and dark-
est parameter values, are linearly scaled between 0 and 255.

Image Enhancement may be done on a single color channel (Red, Green, Blue) or on All Chan-
nels by activating the appropriate choice under Channel. 

(6) Click Show CDF line. This displays the Cumulative Distribution Function line, which 
maps the distribution of the intensities across the histogram.

(7) Click the drop down arrow next to Auto Levels (%). A list will appear containing 4 differ-
ent percentage ranges. Select 5-95, and note that the Brightness and Darkness indicators move to 
those percentages on the histogram.

(8) Close the Image Enhancement box by clicking the OK button.
 

Note: When viewing in a Slice Viewer, the maximum and minimum values for Brightness and 
Darkness Level are the true maximum and minimum values of the entire dataset. For other projec-
tions, the Brightness and Darkness Level values represent the maximum and minimum intensity 
values of the view.

Note: Do not close SmallHip.avz: XZ Max Projection. Please continue on to the next section.

Invert View 

This feature allows you to take a bright grayscale or color image on a darkfield or brightfield 
background and invert its pixels intensities. For instance, a bright grayscale image on a darkfield 
background after inversion will appear as a dark image on a bright background.

(1) From the View menu, select Invert View.

Note: Inverting the Image when the Slice Viewer or Multiple Slices (Montage View) projection is 
active will result in inverting the entire 3D dataset, not just the one slice being displayed.
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(2) To the right of the Image Enhancement icon on the toolbar, click on drop down arrow, 
select Add or Remove Buttons and select Invert View, then click on the drop down arrow again. 
The Invert View icon is displayed on the Toolbar. The icon is displayed depressed to indicate that 
the current view is inverted from its normal state. By clicking this icon you can toggle between 
the inverted image and the normal image. Click on the Invert View icon to restore the original 
view.

When a newly inverted data projection is created, the projection is created first using the original 
data, and then inverted. 

Note: Do not close SmallHip.avz: XZ Max Projection. Please continue on to the next section.

Flip (Horizontal, Vertical)

This feature will flip the current image over, either horizontally or vertically. When a new projec-
tion is created with flipped data, the projection is first created from the original data, and then the 
new projection is flipped and displayed. For Slice Viewer projections, selecting Flip will flip all 
the slices in the dataset.

(1) From the View menu, choose the Flip View option and select Horizontal. The XZ Max 
projection will then be flipped along the horizontal axis of the view (180 degrees about the Y 
Axis).

Note: Flipping the Image when the Slice Viewer or Montage View projection is active will result 
in flipping the entire 3 dimensional dataset, not just the one slice being displayed.

(2) If you have added the Horizontal Flip View icon to your toolbar, notice it is now 
depressed. This indicates that the current view has been flipped horizontally from its original 
position. By clicking this icon you can toggle between the flipped image and the original image. 
Click on the Horizontal Flip View icon to restore the original view. You may also wish to flip the 
view vertically by selecting Vertical from the Flip View options under the View menu.

Note: Do not close SmallHip.avz: XZ Max Projection. Please continue on to the next section.

Color Map

This feature allows you to change the active view to one of the four Color Map options: Gray 
Scale, Hot, Cool and Copper. These various color maps can be used to obtain a different represen-
tation of the projections generated. The default Color Map is Gray Scale.

(1) From the View menu, choose Color Map and select Copper. This will change the Gray 
Scale Color Map to the Copper Scale Color Map.
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(2) Try changing the view to another Color Map selection to observe the different characteris-
tics. Select either Hot or Cool under the Color Map selection in the View menu.

(3) To return to Gray Scale, from the View menu select Color Map and choose Gray Scale.

Channels

For this tutorial you may use your own data type  (Fluorescence [Widefield], Laser Scanning 
Confocal, Brightfield [Transmitted Light], Spinning-Disk Scanning Confocal, Two-Photon 
Fluorescence or 2 Dimensional images) or you may follow along with the recommended data to 
use. All multi-channel data regardless of what microscope it came from or data type it is, will be 
separable into its own channels.

Note: The term Channel is used for delineating data that was collected at different wavelengths. 
This menu item will be used for data that is imported as Multi-channel data. You may arbitrarily 
set any of the color channels to any of the emissive wavelengths collected. The channel descrip-
tion set up below are guidelines for you with respect to which channel will correspond to what 
wavelength.

Red Channel

This Channel (feature) normally represents the longest emissive wavelength collected for the 
dataset.

(1) From the File menu select Open or from the Toolbar click on the Open File icon.

(2) From the Tutorial Data directory select the Multi-Channel folder.  Select TobaMC.tif  
and click Open.

(3)  A dialog box will appear with the question “The program has detected properties that 
indicate this dataset MAY contain an old AutoQuant Proprietary Multi-channel TIFF. Is this True? 
.... ” Select Yes.

(4) From the View Menu select Channels then select Red Channel. An image consisting of 
only the red channel will be generated.

Green Channel

This Channel (feature) represents either the intermediate length wavelength collected for a 3 
channel dataset, or the shortest wavelength collected for a 2 channel dataset.

(5) From the View Menu select Channels then select Green Channel. An image consisting of 
only the green channel will be generated. 
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Blue Channel

This Channel (feature) represents the shortest wavelength collected for a dataset.

(6) From the View Menu select Channels then select Blue Channel. An image consisting of 
only the blue channel will be generated.

(7) Close all views before going on to the next tutorial.

Viewing the Channels and Slices of a Multi-channel Data Set

(1) The Untitled# dataset should be open from the previous section. If it is not open please 
Import the Multi-Channel Data again. From the View Menu select Channels then select Red 
Channel to view the red channel. 

(2) From the Visualization menu select Slice Viewer or click on the Slice Viewer icon. You 
may navigate through the slices composing the red channel. Close this Slice Viewer projection 
and the Red Channel XY Max Projection before going on to step (3). 

Note: When a color is selected from the View Menu, the view/projection formed depends upon the 
currently active view/projection.

(3) From the View Menu select Channels then select Green Channel to view the green chan-
nel.

(4) From the Visualization menu select Slice Viewer or click on the Slice Viewer icon. You 
may navigate through the slices composing the green channel.

(5) From the View Menu select Channels then select All Channels to view the Slice Viewer 
projection of the multi-channel data. 

(6) From the Windows menu select Close All. A dialog box will appear with the question 
“Untitled# is not saved. Do you wish to save it?” Select No. This will close all open views.
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Tutorials for PreProcessing Menu Items

For this tutorial  you may use your own data type  (Fluorescence [Widefield], Laser Scanning 
Confocal, Brightfield [Transmitted Light], Spinning-Disk Scanning Confocal, Two-Photon 
Fluorescence) or you may follow along with the Tutorial recommended dataset. 

Select Region

The Select Region feature allows you to select a region within an image. You have the choice of 
Rectangle, Ellipse, Polygon and Freehand selection tools. 

(1) Open the Neuron.deb dataset from the Confocal folder.

(2) To use this feature, from the PreProcessing menu choose Select Region and click on Rect-
angle. This is the default Select Region tool. 

(3) Move your cursor over the dataset’s region of interest. Starting in the upper left corner 
click and hold the left mouse button while dragging the cursor. This will create a rectangle shaped 
dotted line box around your region of interest. If you need to further adjust the size of the rectan-
gle, left click on one of the sides of the dotted-rectangle region and drag the side inwards or out-
wards to resize as desired. 

(4) To erase the dotted shape, left click anywhere on the image outside of the dotted shape 
region.

Note: Do not close Neuron.deb. Please continue on to the next section.

Crop

This function takes a selected region of an image (see Select Region above), and creates a new 
document based on whatever pixels fall inside that selected region. 

Crop the Stack

(1)  If the Neuron.deb file is not open from the previous tutorial, select the Confocal folder 
from the Tutorial data directory. Select the Neuron.deb dataset and open it.
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(2) Start in upper left corner of the view illustrated above to select a region.

(3) Press the left mouse button down and while still holding the left mouse button down, drag 
the mouse to form a square similar to the one demonstrated in the above illustration. Once the 
square is formed, release the left mouse button. The size of the above cropped area is approxi-
mately 100 by 100 pixels.

Note: The cropped region’s dimensions are concurrently displayed in the lower left-hand corner 
on the main window status bar.

(4) From the PreProcessing menu select Crop, and click on the Crop the Stack option or from 
the Toolbar click on the Crop the Stack icon. The image will be cropped and displayed in the 
viewing window.
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(5) From the File menu, select Save As.

(6) When prompted for a file name to save the cropped image type Neuron_crop1 in the File 
name field and click the Save button. You may close the Neuron_crop1.deb view.

Note: Do not close Neuron.deb. Please continue on to the next section.

Slice by Slice Cropping

Note: This section applies only to users of AutoVisualize, and this function is only available when 
the dataset is in a Slice Viewer projection.

If the Neuron.deb file is not open, select the Confocal folder from the Tutorial Data directory. 
Select the Neuron.deb dataset and open it.

(1)  Create a Slice Viewer projection of the Neuron.deb dataset by choosing Slice Viewer 
from the Visualization Menu. 

(2) Click within the Slice Viewer projection and place your cursor in the upper left-hand cor-
ner of the area of interest. Click and hold down the left mouse button while dragging your cursor 
to the right and downwards. A dotted-line rectangle will be created.
 
(3) From the PreProcessing menu select Crop and choose Slice by Slice Cropping.
The Cropping Mode Selection box will appear. 

(4) Press the Apply Region button. An unchecked check box will appear to the left of the 
number 1 in the list box. This represents the first region of interest selected. 

(5) Click on the check box next to the number 1 to select it. A highlighted overlay will appear 
in the selected region. You may now choose the Crop function or the Remove Region function. 
The Crop function will crop out the previously selected region of interest and will display the 
cropped dataset as a new dataset. The Remove Region function will remove the region of interest 
from the dataset, and will display the removed region as black within the dataset. The Remove 
Region function is useful for removing artifacts from datasets. 

You may select from one of three following Slice by Slice crop options:

Apply to current slice only: 

This function allows you to select a region of interest on the current slice.

Apply to all slices:

This function takes the selected region of interest on the current slice and applies it to all 
of the slices in the dataset. A new volume is created from the cropped area of interest. 
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Apply to given slice range:

This function takes the selected region of interest and allows you to apply it to a specified range of 
slices. The newly created cropped volume will only contain the slices specified by you.

(6) For this tutorial select the Apply to given slice range option and enter 18 for the From slice 
and enter 50 for the to slice.

(7) Press the Crop button. A new Untitled# dataset of the cropped region will appear in a Slice 
Viewer projection. 

(8) You may repeat the steps above and choose Remove Region [in step (7)] to remove a 
region of interest.

If you desire to Crop out a different shape on each slice you should select the Apply to current 
slice only choice. The Apply Region button must be clicked to have the current selected region 
take part in the Crop or Remove Region. When a region is selected for cropping, and the check 
box is checked the first highlight will be light blue. Select another slice using the scroll bar at the 
bottom of the Slice Viewer and repeat the steps of selecting a region, clicking the Apply Region 
button and checking the box left to the number in the list box. 

The Clear Selected Regions button will remove the crop overlay from the regions that are cur-
rently selected. 

(9) When you have chosen all of the desired cropping regions, you should click the Crop but-
ton. A cropped volume will be displayed with only the foreground image data from the high-
lighted regions; all else will be set to background.

Note: Do not close Neuron.deb. Please continue on to the next section.

Crop Dimensions

This feature allows you to set the position and size of region of interest you would like to crop. 
When Crop Dimensions is selected, the Crop Dimensions box appears prompting you to specify 
the Top Left Front Corner and the Bottom Right Back Corner.

(1) Select a region of interest on the dataset by placing the mouse in the upper left hand corner 
of the dataset, then clicking and dragging downward and to the right. Release the mouse, and a 
box will appear around the region selected.

(2) From the PreProcessing menu select Crop Dimensions. A Crop Dimensions box will 
appear. Specify the region of interest’s Top Left Front Corner position and its Lower Right Back 
Corner by typing in the coordinate values.

(3) Click Continue and the region of interest selected will be cropped and displayed as a new 
volume.
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Extend Slices

An image can be extended (have additional optical slices added to it) along its Z axis.
This function allows you to generate additional image slices based on linear extrapolation, and 
appends them to the top and bottom of an image. It is not the same as adding blank slices to the 
top and bottom of a stack as mentioned in (1) below.

An extended dataset will have false slices attached to its top and bottom. These false slices serve 
the purpose of a buffer to keep the guardband region from overlying meaningful features, thereby 
keeping the meaningful data from being obscured in the deconvolution process.
 
This tutorial continues with the Neuron.deb dataset from the Crop tutorial above.

(1) From the PreProcessing menu select Extend Slices. The Extend Image box will appear. 
You have the option of extending the data by using false slices or by using the Zero Pad option 
which when selected gives you the ability to add blank slices to the Top and Bottom of your sam-
ple devoid of any information.

The Extend Depth indicates how many slices you want to add to the top and bottom of your sam-
ple.

In the Extend Depth box enter 4 for the Top and Bottom field values.
The new Depth value will be displayed in the New Dimension frame.
Leave the Zero Pad box unchecked.

(2) Click OK. The extended dataset will be displayed. Click on the XZ view icon, and notice 
the difference between the real data slices and the false slices just generated. 

(3) Close all views before going on to the next tutorial.

Resize

This function allows you to change the overall size of an image. There are two methods for doing 
so, the Linear and the Ideal method. The Ideal method is recommended, however the Linear 
method is somewhat faster than the Ideal method. 

Resizing a dataset resamples the data to produce a new stack of optical sections with dimensions 
different than those of the original stack, unlike changing the size of the image on the screen. This 
can be useful for reducing data storage requirements, reducing pixelation (blockiness) in small 
datasets, and improving rendering.

Note: Resizing an image and Sizing (zooming) an image are different functions.

(1) Navigate to the Widefield folder and open FitcDapi_crop.tif. 
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(2) From the PreProcessing menu, select Resize. The Resize Image dialog box appears. This 
dialog box allows you to either specify a new Voxel Size, a new Image Size, or a new Resize Fac-
tor. You also have the option of choosing Linear or Ideal as the method employed in the Resize 
function. As one parameter is changed the others are automatically updated to preserve the true 
image size. 

Image Size:

For the Image Size Width, enter a value of 250.
For the Image Size Height, enter a value of 250.
For the Image Size Depth, enter a value of 100. 

Voxel Size:

Verify the Voxel Size Width is 0.108.
Verify the Voxel Size Height is 0.144.
Verify the Voxel Size Depth is 0.196.

Resize Factor:

Verify the X Resize Factor is 2.77777.
Verify the Y Resize Factor is 2.083333.
Verify the Z Resize Factor is 2.040816.

Resize Methods:

Select Linear.

(3) Select OK. A progress bar for the resizing of the image will be displayed. When com-
pleted an XY Max projection of the newly resized dataset will be created.

Conversely, if a dataset is too large to view easily, the volume can be resized to a smaller three-
dimensional volume. 

Please close all views before continuing on to the next section.

Optical Density Correction

This feature is used to correct fluctuations in the image intensity values across the depth of an 
image. This only works on images with depth > 1. The image intensity value often fluctuates erro-
neously because of random flicker from the camera shutter or the lamp instabilities. Flicker 
occurs with nearly all widefield microscope systems. It is due to several causes. Most Cooled 
CCD cameras have a randomness in their shutter’s speed. This shutter speed fluctuation causes 
variations on the order of several milliseconds (typically) from one exposure to the next. The 
effect can be seen best in a side-view projection of a dataset.
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To determine if your dataset needs Optical Density Correction look for abrupt fluctuations in 
image intensity summations from one depth to the next. 

(1) From the File menu select Open. Navigate to the TLB folder and click on star.1.
In the Files of type field select 16 bit data [*.*], if the folder appears empty.

(2) The first time you load a dataset that is a sequence of files a dialog box will appear with 
the question A sequence of files associated with the selected file is detected. Do you wish to load 
the entire sequence? Select Yes. The dataset will be loaded.

(3) In order to appreciate fluctuations in image intensity, an XZ projection needs to be gener-
ated. From the Visualization Menu select Sum Projection. Generate an XZ View by clicking on 
the XZ View icon. Notice the horizontal lines in the dataset. 

(4) From the PreProcessing menu select Optical Density Correction. The Optical Density 
Correction box will appear. 

Note: If the image is multi-channel, the summation data will be provided for each channel in the 
Summation Data frame of the Optical Density Correction box.

The order of the Polynomial is set at 3. This is the default value that can be used to correct for 
optical density. You have the choice to use the default value of 3 by clicking on Continue, you 
may change the order of the polynomial by clicking on Change, or you may Cancel.
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Note: Increasing the order of the Polynomial will increase the correction in the image intensity to 
a certain point, after which possible aberrations will be observed depending on the dataset.

(5) Click on the Change button. The Change Order of Polynomial box will appear.

(6) Change the Order of Polynomial to 4. Notice how the dotted line more closely follows the 
intensity profile of the image. Click Continue.

(7) Place the Untitled#.deb: XZ Sum Projection view below the star.1: XZ Sum Projection 
view, and compare the differences between the views. 

Notice how the Optical Density Correction has reduced the amount of horizontal lines in the cor-
rected dataset. 

Note: The intensity profile displayed is that for a Grayscale dataset. For a multi-channel dataset 
the intensity profile displayed is the Red Channel. This is the default. You can view the intensity 
profile for each channel separately by making the appropriate selection under Select Channel. 
For each channel you may chose an order of the polynomial which best fits the image intensity 
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profile.

Other types of cameras often have a similar problem. Ordinary Video Rate CCD cameras, intensi-
fied CCD cameras, digital cameras and other types of cameras will show this flicker effect. There 
are several factors that contribute to this effect, and it is unknown to what degree each factor con-
tributes. Some camera manufacturers may claim that their cameras do not have these imperfec-
tions. Even so, the effect is still likely to arise and is due at least in part to other factors in the 
optical train that the camera manufacturer cannot control. Such factors include: arc-lamp flicker, 
instabilities in the power supply to the lamp, instabilities in the power supply to the camera, fluc-
tuation in the 110 Volt A.C. power that supplies the camera electronics, microscope and other 
electronics in the microscope system. Other remote possibilities are adverse laboratory condi-
tions, temperature changes, room lights being turned off and on, and movement in the room caus-
ing shadows over the microscope.

Although the source of these flicker effects is difficult to pinpoint exactly, it is certain that they 
occur and that they occur regularly. 

(8) Close all views before continuing on to the next section.

Attenuation Correction

The Attenuation Correction function corrects the attenuation as a function of depth into the sam-
ple. Such attenuation is due to several factors: 

• Excitation light absorption
• Fluorescent emission light absorption
• Photobleaching
• Changes in the optical point spread function as a function of depth, which in turn 
is fundamentally due to refractive index mismatches between the sample embedding 
medium, coverslip, and lens immersion medium. 

A dataset that requires Attenuation Correction is recognized by noticing darkening within an 
image as you go from the top to the bottom of the view.

(1) From the File menu, select Open. Navigate to the Confocal folder and select RedNuc.0.

(2) A dialog box will appear with the question “A sequence of files associated with the 
selected file is detected. Do you wish to load the entire sequence?” Select Yes.

(3) Generate a Sum Projection, by clicking on the Sum Projection icon on the Toolbar. 

(4) From the View menu select Single View and click on XZ to generate an XZ View of the 
Sum Projection. Notice how the dataset appears darker as you go from the top to the bottom of the 
view.
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(5) From the PreProcessing menu select Attenuation Correction.
The Attenuation Correction will be performed automatically on the dataset, and the result will be 
displayed in the viewing window.

(6) Compare the raw XZ Sum Projection dataset to the newly corrected XZ Sum Projection 
dataset. The bright to dark effect has been diminished in appearance.

Attenuation Correction is most often applied to Confocal datasets where there is frequently a 
decrease in image intensity due to attenuation, light scatter, and spherical aberration as the depth 
into the sample is increased. Apply Attenuation Correction to the raw dataset before processing.

(7) Close all views before going on to the next section.

Background Equalization

Note: This section applies to users of AutoVisualize only.

This function allows you to remove unnecessary background from an image. 

(1) From the File menu select Open or from the Toolbar click on the Open File icon. 
Navigate to the SmallHip folder and select SmallHip.avz.  The SmallHip.avz dataset will be 
loaded. 

(2)  From the PreProcessing menu select Background Equalization. The Background Equal-
ization box will appear. Adjust the Background by typing in the Background Equalization box or 
by scrolling the bar until the Maximal Equalization value equals 45%.

(3)  Check the Remove Negative Intensities box to enable it. When this box is checked Auto-
Visualize will remove any background points that have negative intensity values. These negative 
pixel intensity values can come from the autoscaling function in the software or from artifacts in 
the dataset itself. Click OK. The background adjusted dataset will be displayed.

(4) Close the Background Equalization dataset (Untitled#) before going on to the next section. 

Note: Do not close SmallHip.avz. Please continue on to the next section.

Invert Data 

This function inverts the intensity scale of the entire stack of optical sections. This is different 
from the Invert View function under the View menu item which only inverts the intensity scale of 
the image in the current view.

(1) From the PreProcessing menu select Invert Data. The SmallHip.avz dataset will be pro-
cessed automatically and displayed upon completion of the inversion.
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(2) You may close the Invert Data image (Untitled# dataset) before going on to the next sec-
tion.

Note: Do not close SmallHip.avz. Please continue on to the next section.

Image Alignment

Slice to Slice

Automatic Alignment

Note - This feature is only available as an added plug-in. Contact your dealer for purchase infor-
mation.

This feature corrects for X & Y translation and warp (nonlinear distortion) between frames. Mis-
alignment and warp can be caused by stage motion, movement of the sample during live imaging 
and other causes.

(1) Open the Unaligned.avz file from the Ocular folder in the Tutorial Data directory.

(2) From the PreProcessing menu select Image Alignment, the select Automatic. The Image 
Alignment box will appear. Click the Advanced Settings button, and then the dialog will appear as 
it does below:
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Alignment Axis

This features allows the alignment to be restricted to the X axis, the Y axis, or both axes. The 
default setting is Both X and Y Axes.
X 
This setting will only align an image horizontally.
Y
This setting will only align an image vertically.
Note-Selecting both X and Y will align the image on both its horizontal and vertical axes.

(3) Leave the default setting of Both X and Y axes enabled.

Advanced Settings

Clicking the Advanced Settings will display additional Automatic Image Alignment Settings. 
These settings are already set based on the image information, however, if you feel that these are 
not as accurate as you would like them, you can fine tune them.

Image Warp

This feature corrects for warp due to motion between frames. The more serious the warp, the 
longer the processing time.

You may slide the pointer to any setting on the scale, the far left being no warp, the far right being 
extreme warp. 

(4) Verify that the Image Warp setting is None (this is the default).

Void Region Fill

This function will put a frame like cover over the areas that no longer contain data. After the data 
are aligned, gaps and spaces are created at the edges. This function chooses how those areas are 
filled in.

Note: The Frame may have straight, scalloped or irregular edges to it.

Black 
This will put a black frame on the edge of the image where the aligned data has left a
void. This is recommended for Fluorescence and Darkfield datasets.

Random
This will place a frame on the edge of the dataset made up of random pixel values where 
the aligned data has left a void. This is recommended for datasets that will be
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deconvolved or for images that have obvious structures at the edges of the frame.
White

This will put a white frame on the edge of the image where the aligned data has left a
void. This is recommended for Transmitted Light Brightfield datasets.

(5) Select Random from the drop down menu.

Noise Threshold

This function allows you to set the noise threshold for which the Automatic Alignment feature 
will compensate. By default, Noise Threshold is disabled. To enable, check the Set Threshold 
box. Noise Threshold is automatically set to 20%. If this figure does not match your dataset, move 
the pointer to the appropriate spot on the slider.

Base Slice

This is the frame to which all other frames are aligned.
Find Automatically

This function finds the base slice which has the highest similarity in features and 
structures to all other slices. If the dataset is not opened in a Slice Viewer, this is the only 
available option.

Current slice
This is available only in a Slice Viewer. This function uses the current slice being
viewed as the base slice for alignment. It allows you to select the base slice. It is recom-

mended that Current slice be used if dataset has 50 or more slices.

(6) You will only be able to select the “Find Automatically” setting because the dataset is not 
in a Slice Viewer.

Base Channel

In a multi-channel dataset, this feature allows you to select the channel upon which the dataset is 
aligned. This feature will be disabled if the dataset is not a multichannel dataset. For this tutorial, 
this feature should be disabled.

Alignment Log File

The Alignment Log File allows you to name and save a log file which will detail the changes 
made to each slice.
Write Log
Selecting this feature will prompt the Image Alignment feature to save a log of the changes made 
to each slice. In the text box next to the right, enter the file name you want the log file to be called.
Set folder path
Click the set folder path button to open a windows browser to select the folder to which the log 
file will be saved.
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(7) Click the OK button. The application will launch the alignment process and will display 
the results upon completion.

The following images are the original dataset and the resulting aligned dataset.

(9) Create Slice Viewers of the original and the aligned images, then open the Slice Synchro-
nizer from the Visualization menu. Scroll through the datasets. Notice the motion between the 
slices in the Unaligned.avz dataset, as compared to the Aligned.avz dataset.

Please close all views before going on to the next section.

Manual Alignment

Note - This feature is only available as an added plug-in. Contact your dealer for purchase infor-
mation.

This feature allows you to correct for X & Y translation and warp (nonlinear distortion) between 
frames, as well as rotation. Currently only Grayscale datasets are supported. Misalignment and 
warp can be caused by stage motion, movement of the sample during live imaging and other 

   Original                   Aligned
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causes. Upon opening the Manual Alignment dialogue, two images will open. The image on the 
left will be slice 1, and the image on the right will be slice 2.

Two Views

The Two Views icon , which is depressed by default, places two adjacent frames side by side 
in the Image Alignment workspace. The image on the right is always the slice following the slice 
on the left (e.g., if the image on the left is slice 5, the image on the right will be slice 6). In the 
Two Views mode, the image on the right will be the one that is adjusted.

Projection

To the right of the Two Views icon is the projection selection drop down menu. This menu con-
tains four options:

• Max: Displays the Max projection of the images.
• Min: Displays the Min projection of the images.
• Avg: Displays the Average of the intensities of the images.
• Sub: Displays the difference between the images.

Combine

The Combine icon , when depressed will overlay the object image (the image on the right) on 
top of the base image (the image on the left).

Flicker

The Flicker icon , when depressed, will alternate the image on the left between the base image 
and the object image (e.g., if the image on the left is on slice 1, pressing the Flicker icon will 
cause the image to alternate between slice 1 and slice 2). When the Flicker icon is depressed, it 
will change to a Stop icon . The image will continue to alternate until the Stop icon is 
depressed.

Zoom Step

The Zoom Step drop down menu located to the right of the Flicker icon determines the percentage 
by which the image is magnified when selected to do so(10% will increase the image by 10% 
each time you magnify the image).

Zoom

The Zoom icon  allows you to magnify the images by a determined amount. To zoom in on an 
image, select the step size from the Zoom Step drop down menu. Next, click the Zoom icon, and 
finally click the image you desire to zoom in on.
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Controls

The image controls located beneath the images will manipulate the object image. This section will 
assume that you are operating in the Two Views mode.

Resize
The Resize controls allow you to resize the image. This is used to correct for stretching/contract-
ing of the specimen. Checking the Keep Aspect checkbox will adjust both the height and width 
simultaneously, maintaining proportion. Unchecking the Keep Aspect box will allow you to 
adjust the height and width independently.
Rotation
The Rotation control allows you to rotate the image to correct for movement during acquisition. 
To use the rotation control, first locate the crosshairs on the object image. Place the cursor over 
the crosshairs until the cursor becomes a crosshair. Click and drag the crosshair to the location 
you wish use as the axis about which to rotate the image. Once the crosshairs have been placed, 
either click the arrows on either side of the rotation control (the left arrow will rotate the image 
counter-clockwise, the right arrow will rotate the image clockwise), or click on the slider and 
move it back and forth. Rotate the object image until it is lined up.
Reposition
The Reposition controls allow you to reposition the dataset to correct for movement or vibrations 
during acquisition. Depress the Combine icon to overlay the two image. Reposition the object 
image using the Reposition controls and observe the overlaid image on the left as the object image 
moves over the base image.
Slice Control
The Slice Control adjust the slice which you are adjusting. Clicking the right-arrow key on the 
slider control will scroll to the next slice (if you were working on slice 4, it will move to slice 5).
Slice Status Box
The Slice Status Box will indicate whether the displayed slice has been modified. If the slice has 
been modified, the word Unmodified will appear, whereas if the slice has been modified, the word 
Modified will appear.
Apply
The Apply button, when depressed, will apply the changes to the selected slice, then move to the 
next slice automatically. The Apply button will be disabled until changes have been made to the 
slice. Once the Apply button has been depressed, the changes made to that slice cannot be undone, 
except by re-manipulating the slice to its original format; there is no undo once the Apply button 
has been depressed (other than to close the Manual Alignment dialog box).
Undo
If you have made changes to the slice, but have not yet depressed the Apply button, pressing the 
Undo button will return the slice to its original state (if a prior change had been made to the slice, 
after which the Apply button was depressed, then additional changes were made to the same slice, 
pressing the Undo button will return the slice to its state after the last time the Apply button was 
depressed). This is not a step back feature, all changes since the last time the Apply button was 
depressed for that slice will be undone.
Close
Depressing the Close button will close the Manual Alignment dialog, and will open a new untitled 
slice viewer, incorporating any changes made to the dataset. This new window can be saved.
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Channel to Channel

The Channel to Channel alignment feature allows the user to align multi-channel datasets that 
have shift between the channels due to a filter cube or some other image acquisition problem. To 
open the Channel to Channel Alignment feature, go to the PreProcessing menu option, select 
Image Alignment, then Channel to Channel, then select Automatic.

Alignment Direction

This section allows the user to select the direction in which the image needs to be aligned: along 
the X axis, along the Y axis, or along both axes (by checking both the X and Y axes). The default 
setting is to align to both axes.

Base Slice

This section is where the Base Slice (the slice to which all others will be aligned) is chosen. The 
default setting is to let the application select the base slice. Deselecting Select Automatically will 
enable the slice scroll bar, with which the user will then need to scroll to the desired base slice. 
Alternatively, the user can enter the slice number into the text box to the right of the scroll bar.

Advanced Settings

Clicking this button will open the Advanced Settings Dialog. It is recommended that the default 
settings be used. Clicking this button again with the Advanced Settings dialog showing will close 
the Advanced Settings dialog.
Noise Background
Set Threshold
This option sets the noise threshold for the dataset. The default is set to 20%; clicking the Set 
Threshold button allows the user to set the noise threshold to a different level.
Show Noise
This option shows the noise on the image when the Set Threshold option has been selected. The 
default is On.
Void Region Fill
This function will put a frame like cover over the areas that no longer contain data. After the data 
are aligned, gaps and spaces are created at the edges. This function chooses how those areas are 
filled in.

Note: The Frame may have straight, scalloped or irregular edges to it.

Black 
This will put a black frame on the edge of the image where the aligned data has left a
void. This is recommended for Fluorescence and Darkfield datasets.

Random
This will place a frame on the edge of the dataset made up of random pixel values where 
the aligned data has left a void. This is recommended for datasets that will be
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deconvolved or for images that have obvious structures at the edges of the frame.
White

This will put a white frame on the edge of the image where the aligned data has left a
void. This is recommended for Transmitted Light Brightfield datasets.

Alignment Log File
The Alignment Log File allows you to name and save a log file which will detail the changes 
made to each slice.
Write Log
Selecting this feature will prompt the Image Alignment feature to save a log of the changes made 
to each slice. In the text box, enter the name to call the log file.
Set folder path
Click the set folder path button to open a windows browser to select the folder to which the log 
file will be saved.

OK

Clicking the OK button will initiate the Channel to Channel Alignment feature, and will create a 
new, aligned image, that will need to be saved.

Cancel

Clicking Cancel will cancel and close the Channel to Channel alignment dialog. No aligned 
image will be created or saved.

Help

Clicking the Help button will open the Online Help file, opened to the Channel to Channel Align-
ment topic.

Data Correction

The Data Correction function performs the Flat-Field and Bias Field corrections and the correc-
tions for the camera and lamp flicker, whose principles are described in the Guidelines for Col-
lecting 3D Image Data section of this manual. The Data Correction function is for widefield 
datasets (fluorescence or brightfield) only. Do not use it for confocal datasets.

It is recommended that you do a Data Correction on your dataset before processing a Widefield 
dataset (fluorescence or brightfield).

Slow Scan Cooled CCD

The Data Correction feature can correct for Slow Scan Cooled CCD cameras, when charge inte-
gration time is selectable.
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(1) Navigate to the TLB folder in the Tutorial Data directory. Set the Files of type to All Files 
and select star.1. The File Input dialog box will appear (shown below).

Select Yes.

(2) From the PreProcessing menu, select Data Correction and click on Slow Scan Cooled 
CCD. The Slow Scan Cooled CCD Data Correction box will appear.

Within the Files tab you will need to locate and load the files for the Flat Field, the Bias Field 1 
and the Bias Field 2. If you have not collected these fields then their selection boxes should be 
unchecked. The recommendation is to collect and load all three Field image stacks.

(3) To load the Flat Field file (*.lt0), click the top Load button and navigate to the TLB folder.

(4) Select the star.lt0 file, and click Open. The File Open box appears with the message 
“Dataset only contains one optical slice, the orthogonal projection along XZ and YZ will be inac-
tive.” Click OK. AutoDeblur will automatically load the Flat Field file.
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(5) To Load the Bias Field 1 file, click on its corresponding Load button and select the 
star.bs0 file from the TLB folder. Click Open. The File Open box appears with the message 
“Dataset only contains one optical slice, the orthogonal projection along XZ and YZ will be inac-
tive.” Click OK. AutoDeblur will automatically load the Bias Field 1 file.

(6) To Load the Bias Field 2 file, click on its corresponding Load button and select the 
star.bs1 file from the TLB folder. Click Open. The File Open box appears with the message 
“Dataset only contains one optical slice, the orthogonal projection along XZ and YZ will be inac-
tive.” Click OK. AutoDeblur will automatically load the Bias Field 2 file.

(7) Select the Parameters tab. 

Within the Parameters tabs you will need to enter the Exposure times for the Average, the Flat 
Field, the Bias Field #1, and the Bias Field #2. These numbers should have been recorded and 
archived when the image stacks were collected. The Average exposure time is the exposure time 
of the CCD camera that was set while the 3D dataset was collected. To learn how to obtain these 
numbers refer to the operator’s manual of your camera, check the documentation of the software 
used to collect the image stacks, or contact the camera and data collection software manufacturer. 

(8) The Exposure Times (in seconds) of the fields should be specified as illustrated above. 

(9) The Bad Pixels Treatment setting should have the default value of None.
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Bad pixels occur when the dark current of a pixel is so severe that it causes a bright spot in the 
picture. Most image stacks do not require any treatment of bad pixels. Therefore the recom-
mended default selection is None. If the selection of None causes the corrected pictures to become 
black, this is an indication that the dataset requires the treatment of the bad pixel(s). In this case, 
the recommended Bad Pixel Treatment setting is Median Filter. This is the most accurate means 
of treating bad pixels. It replaces the bad pixel’s intensity with the median value of its nearest 
neighboring pixels. The Wiener Regularization setting is available because it executes much 
faster than the Median Filter setting, but it is not as accurate as the Median Filter setting. 

(10) Click OK to begin the data correction of the Slow Scan Cooled CCD dataset. Data correc-
tion will take approximately 1-2 minutes depending upon your machine.

(11) Once the image has been corrected, AutoDeblur will display the result in the viewing win-
dow.

Close all views before continuing on to the next section.

High Speed CCD

The High Speed CCD selection under Data Correction is for datasets that were collected from a 
standard Video camera, an intensified CCD camera, a standard digital camera or any other camera 
besides the Slow Scan Cooled CCD camera. There are two tabs: the Files tab and the Parameters 
tab.

(1) Navigate to the Data Correction folder under the Tutorial Data directory. Set the Files of 
type to All Files. Open the Strfish.tif dataset. Create the ZY view of the dataset. 

(2) From the PreProcessing menu select Data Correction, and click on High Speed CCD. The 
High Speed CCD Data Correction box will appear. 

(3) Within the Files tab, load the Flat Field file (*.tif) by clicking the top Load button and nav-
igating to the Data Correction folder. Set the Files of type to All Files.

(4) Select the StrfishFfv.tif file, and click Open. AutoDeblur will automatically load this Flat 
Field file.

(5) To Load the Bias Field file, click on its corresponding Load button and navigate to the 
Data Correction folder. Select the StrfishBfv.tif file, and click Open. The File Open box appears 
with the message “Dataset only contains one optical slice, the orthogonal projection along XZ and 
YZ will be inactive.” Click OK. AutoDeblur will automatically load the Bias Field file.
There is only one Bias Field for High Speed CCD Data Correction, because Dark Current does 
not effect the image in this situation. 

(6) Select the Parameters tab. You may enter the value for the frame(s) per optical slice. 
Leave the default setting of 1 for this example. For Bad Pixel Treatment select Median Filter. 
Click OK and AutoDeblur will correct the High Speed CCD dataset.
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Note - To slow down the viewing time per each frame increase the frame(s) per optical slice value.

Background Subtraction

This feature should be used to clean up images that have background noise. There are five differ-
ent ways to subtract the background from a dataset:

• ROI - This involves drawing an ROI around an area that is known to be the 
background. The algorithm will remove all data with the same or lower intensity as the intensity 
within the ROI.

• Histogram Peak - Selecting this algorithm will remove the most commonly 
occurring intensity level, using the assumption that the majority of a dataset is background and 
contains no relevant data.

• Minimum Value - Selecting this algorithm will remove the lowest intensity 
value from the image.

• Constant Value- This involves entering an intensity value, below which, all 
intensities will be removed.

• Background Image - This involves taking an image of a blank specimen 
(which will create a dataset that is entirely background) and selecting this dataset from the drop-
down menu (the dataset needs to already be opened for this to happen). The algorithm will then 
analyze the intensity in that image, and subtract that intensity from the desired dataset.

(1) Click on File from the main menu and select Open. Navigate to the Ratiometrics folder 
and open HighCa1.001.

(2) Select Background Subtraction from the Data Correction option under the PreProcessing 
menu. The Background Removal dialog box will open.

(3) There are five different methods of background removal: Constant, Region of Interest 
(ROI), Histogram Peak, Minimum Value and Background Image.

-For the ROI option, select a region of interest in the image that is empty (background) by click-
ing the mouse, dragging it to create a box, and then releasing. Make sure that nothing is inside this 
box.
-The Histogram Peak option requires no input, it looks at a histogram of the intensities, then 
removes the highest occurring intensity (this is typically the background, in an image in which the 
object takes up less than half of the image).
-The Minimum Value option also requires no input, and it removes the minimum intensity from 
the image.
-The Constant method allows an intensity to be entered into the text box, and anything at or below 
that intensity level will be removed from the image.
-The Background Image option requires an image to be acquired with no object in it (a blank 
image). Select this file from the drop down menu. If the background image file has not been 
opened, open it using the Open button on the main toolbar.

Click on the radio button for the desired method of background removal.
March, 2004                     Page 129



AutoQuant Imaging, Inc.                   Manual and Tutorials
(4) Click OK. A new Untitled* file will be created.

Image Macro

This feature gives you the option to perform the same functions on several datasets at one time.

(1) Open the Neuron.deb dataset from the Confocal folder.

(2) Select Image Macro from the PreProcessing Menu. The Image Macro Functions box will 
appear.

(3) Click the Select Data button and the Available Datasets box will appear. The Available 
Datasets box will list all datasets currently opened. You may add datasets to this workspace by 
using the Open File button and opening as many datasets as you would like. You may select the 
dataset you want to work with or you may use the Select All button. Select the Neuron.deb dataset 
and click OK.

(4) In the Operations frame of the Image Macro Functions box select Crop as the first func-
tion and click the blue arrow. This places the Crop function in the Operation Order frame.

Selecting the Crop operation causes the Crop Rectangular Dimensions box to appear in the lower 
left side of the Image Macro Functions box, which contains field position boxes to set the Top 
Left Front Corner and the Lower Right Back Corner position of the dataset.

(5) In the Crop Rectangular Prism frame set the following:
Top Left Front Corner: X = 8, Y = 8, Z = 1
Lower Right Back Corner: X = 71, Y = 71, Z = 32 

If you choose to perform an Operation like Crop, Extend, or Resize on any or all of the datasets, 
the new dimensions will be displayed automatically in the New Dimensions frame for the cur-
rently highlighted file. The Apply To box contains all of the files on which the Image Macro func-
tions will be performed on. If you wish to remove a file, click on the file and click the red [X] 
button in the lower right corner.

Note: When Extend is chosen, the Extend Depth box appears on the lower left side of the Image 
Macro Functions box. In this box you would set the number of false slices you would like added to 
the top and bottom of your dataset. When Resize is chosen, the Resize Factors box appears with 
fields for resizing the X, Y, and Z dimensions of your image.

(6) Select OK. Each dataset will be automatically cropped to your previously set proportions 
and saved in the same folder as the original dataset. The new dataset will be named as follows: if 
the original dataset was named pollen.deb, then the new dataset will be pollen_operation 
performed_1.deb.
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Rotation Offset

The feature selects a rectangular region from an image and applies a cropping, based on that 
region, across multiple volumes. It also allows the specification of a rotation angle at which to 
crop. Once cropped, the volumes are reoriented to the opposite angle at which the crop occurred 
(which causes them to appear “level”).

From the PreProcessing menu select Image Macro. The Image Macro Functions dialog box will 
appear.

When you choose the Crop operation from the dialog, the prompt for cropping appears in the 
lower left region of the dialog. You may then select a region from the image by dragging out a 
bounding box on top of the image. When the region is selected (i.e., when the mouse is released), 
the numeric boundaries of the bounding box will be entered into the crop boundary edit boxes in 
the Image Macro Functions dialog box.

Once the region is drawn out, you may then specify the desired rotation angle in the Rotation Off-
set edit box. The ROI rectangle drawn in the image window will also be rotated to continue to 
show the region that is going to be cropped. If, after specifying the rotation angle, you adjust the 
cropping coordinates by updating the text box entries, then the ROI will be moved accordingly in 
the image window, and the rotation offset will be maintained. If, however, you click inside the 
image window, and re-specify the cropping coordinates by dragging a new region, then the rota-
tion offset will be reset to 0.
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Adding Files

Files may be added to the “Apply To:” list in two ways. First, you may click Select Data which 
opens a dialog box that lists available datasets. Second, since it may be necessary to operate on 
more files than can reasonably be opened, you may drag-and-drop files from the Windows 
Explorer directly into the “Apply To:” list.

Removing Files

To removing files, select the file you wish to remove from the “Apply To:” list, and click the red 
[X] button to the right of the list box.

Please close all views before going to the next tutorial.
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Tutorials for Deconvolution Menu Items

Deconvolution Settings

Note: This chapter applies to users of AutoDeblur only.

Before you are able to deconvolve a dataset you must set the Standard Settings and the Expert 
Settings. The objective of this tutorial is to give you a feel for setting both the Standard and the 
Expert Settings.

Note: This tutorial contains many explanations and guidelines that are important to the under-
standing of Standard and Expert settings. It is recommended that you read over the explanations 
and guidelines to assist you in specifying the Standard and Expert settings.

Standard Settings

The Standard Settings allow you to specify parameters needed for deconvolution. Inputting these 
parameters is the first step in the deconvolution process. Pausing the cursor over a field requiring 
input will launch a tool tips description of that item.
Additionally, any values that are outside the expected range will be shaded in a color coded fash-
ion:

• Yellow indicates that the value is outside the expected range, but the algo
rithm will still run.

• Red indicates that the value is outside the expected range, and the algo
rithm will not run until the value is corrected.

• Cyan indicates that the dataset appears to be oversampled, but the algo-
rithm will still run.

(1) From the Widefield folder open the FitcDapi_crop.tif dataset and create an XZ Sum Pro-
jection.

A significant amount of haze can be observed in the FitcDapi_crop.tif dataset, especially in the 
XZ Sum Projection. 

(2) From the Deconvolution menu, select Deconvolution Settings and click on Standard Set-
tings. A Standard Settings box will appear.

(3) There are four sections in the Standard Settings: the Deconvolution Methods, the Optics 
Settings, Deconvolution Settings and the Output Settings. These are explained below.
Deconvolution Methods
The Deconvolution Methods section allows you to select between Adaptive PSF (Blind) and 
Fixed PSF (Non-blind) for the deconvolution. 

(4) For Deconvolution Methods verify the setting is on Adaptive PSF (Blind).
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Optics Settings 
The Optics Settings section prompts you to set the microscope and dataset parameters obtained 
during the dataset collection. Such parameters are: the Numerical Aperture, the Refractive Index, 
the Microscope Modality, the Emissive Wavelength, the Image Dimensions and the PSF Dimen-
sions.
Experiment specific settings can be saved and loaded to save time on entering the settings each 
time an image is processed. This can be done at the top of the Optics Settings frame, in the text 
box to the right of where it says Select. To create a saved setting, once all of the optics settings are 
created, type a name for the settings into the text box, then click Add. To load a previously saved 
setting, select the desired setting from the text box drop-down menu. In addition to using previ-
ously saved settings, there is an option to use the previous settings, which will load the settings 
that were last used during deconvolution. Restore Settings will restore the settings to the last set-
tings entered during the current session. Restore Settings (Current Dataset) will restore the set-
tings associated with the dataset prior to opening the Standard Settings dialog.

(5) On the Image Dimensions tab notice the following:

The Width value is 90 pixels (27 microns.)
The Height value is 120 pixels (36 microns.)
The Depth value is 49 pixels (19.6 microns.)

Verify the X Spacing is 0.3.
Verify the Y Spacing is 0.3.
Verify the Z Spacing is 0.4.

(6) On the Microscope Settings and Image/PSF Dimensions frame:

In the Modality box, verify that Widefield Fluorescence is selected.
In the Lens NA field, verify the value is 1.4.
In the Refractive Index field, verify the selection is Oil (1.515).

(7) In the Emissive Wavelength frame, the wavelength for each channel is displayed. To
change the wavelength select the radio button for the channel of interest, and either type in
the wavelength (nm) or select the probe type from the Probe drop down menu. 

For the first channel (Channel 1) leave it blank. For the second 
channel (Channel 2) set the Probe to FITC and type 520 for the wavelength. For the third
channel (Channel 3) set the Probe to DAPI and type 456 for the wavelength. AutoDeblur 
checks each channel for dataset. If the Channel is void of data it will automatically be 
skipped.

Calculate Spacings
Clicking the Calculate Spacings button will produce tabs for Theoretical XY Spacings and Cali-
brated XY Spacings. Either tab can be used to calculate the spacings of the image. In the Theoret-
ical XY Spacings tab, you will enter your microscope parameters, which will then be used to 
calculate your image spacings. In the Calibrated XY Spacings tab you will need to take a calibra-
tion image measuring the spatial calibration. To learn how to do this see page 48. Enter the result-
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ant measurements in the Calibrated XY Spacings tab. After either tab has been populated, click 
the Transfer Spacings button. The spacings will now be transferred into the Image Spacing text-
boxes.
Deconvolution Settings
The Third Section of the Standard Settings is Deconvolution Settings which prompts you for the 
deconvolution parameters.

The Deconvolution Settings section has the following input fields: Total Iterations, Save Interval, 
Noise Level, Noise Value, Performance, Use Recommended Expert Settings, and Go to Expert 
Settings.

(8) In the Total Iterations field enter a value of 30
In the Save Interval field enter a value of 15. This will perform 30 iterations of
deblurring, saving the results through the 15th & 30th iterations.
Verify that Low is selected for the Noise Level. Based on the Noise Level chosen, the
Noise Value is automatically populated, except when Other is chosen, in which case you
must enter a value in the Noise Value field.

Verify that the Use Recommended Expert Settings is enabled. The Expert Settings will be 
explained in its own section on page 137.

Output Settings
The Output Settings allows you to select the file format in which you want the resultant file to be 
opened.

(9) Select TIFF (16-bit). This is the same format as the Input File.

(10) Click OK, this sets the Standard Settings for the FitcDapi_crop.tif dataset.

Standard Settings Explanations

Total Iterations 
The Total Iteration field under the Deconvolution Settings section allows you to choose the num-
ber of iterations performed during a deconvolution. The higher this number the more times the 
dataset will be processed. Lower iterative numbers will execute in less time whereas the higher 
iterative numbers will take more time and generally provide improved resolution. Beyond a cer-
tain number, depending upon the imaging modality (widefield or confocal) the deconvolution 
may provide unstable results. 

The recommended number of Total Iterations is 30. If the total Iterations is set to a number above 
60, that field will become yellow, indicating it is outside the recommended range. The algorithm 
will still run however. If there is no entry (or if zero is entered) or the entry is greater than 5,000, 
then the field will be highlighted red, indicating that it is outside of the acceptable range, and the 
algorithm will not run until the field is corrected.
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The Save Interval 
This field allows you to select the number of iterations that will occur between storage of decon-
volution results on the disk. The possible values are integers from 1 to the number of Total Itera-
tions, such that the Total Number of Iterations is evenly divided by the number of Save Intervals. 
For example, if the number of Total Iterations is 20 and the Save Interval is 5, the deconvolution 
will be saved at 5, 10, 15 and 20 iterations. The deconvolution application automatically checks 
for available disk space before beginning the deconvolution.
If there is no entry (or if zero is entered) or the entry is greater than 5,000, then this field will be 
highlighted red, indicating that it is outside of the acceptable range, and the algorithm will not run 
until the field is corrected.
Performance
This field allows you to speed up the Deconvolution process, while sacrificing slightly on the 
results. The default for this is unchecked.
Noise Level
This feature allows you to set the noise level present in your image. The options are Low, 
Medium, High and Other. This option will already be selected for you if you have Automatic 
Deconvolution Settings selected. If you choose to set your own noise level, you can select the 
noise level that best matches your dataset. The Noise Value to the right of the selection represents 
the amount of noise smoothing that will accompany that setting. Selecting Other will allow you to 
enter a more specific number into the Noise Value box.
Noise Value
This box displays the noise value that is the default for the selected Noise Level. Or, if Other is 
chosen for the Noise Level, then the Noise Value must be entered in manually.

Use Recommended Expert Settings
It is recommended that you use the “Use Recommended Expert Settings” option.

As a general rule, DO NOT MODIFY THE EXPERT SETTINGS until you have attained expertise 
in using the deconvolution application. Expert settings should not be adjusted from their original 
default settings except in rare cases. Do not change them casually. All adjustments should be 
tested on a small sub-field of the dataset (e.g. 64 x 64 x 32). If you disable the Use Recommended 
Expert Settings (uncheck the check box), the Go to Expert Settings button becomes active.
Output Settings 
This field allows you to select the format in which the deconvolution application will save the 
deconvolution results. The options are: AutoDeblur File (*.deb), 8 bit character data, TIFF(16 
bit), STK File, SEQ File, and TIFF Sequence (16-bit).

Guidelines: The TIFF format allows the deconvolution results to be easily imported into other 
software. The TIFF format uses no compression and is an 8-bit format.
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Expert Settings

Note: This section applies to users of AutoDeblur only.

This tutorial continues with the FitcDapi_crop.tif dataset from the previous Standard Settings sec-
tion.

From the Deconvolution menu select Deconvolution Settings and click on Expert Settings. The 
Expert Settings box will appear.

Subvolume section

(1) This section of Expert Settings affects the handling of the object data.
 

The default values are as follows:

XY Montage is selected (enabled).
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Z Montage is deselected (disabled). 
Dynamic Subvolumes is selected (enabled).

Leave these fields at their default values. 

(2) Verify that the following fields are set to their default values:

The Subvolume overlap (Pixels) is 10.
The XY Guardband (Pixels) is 10.
The Z-Guardband (Pixels) is 6.

Pre-processing section

(3) Verify that the Intensity Correction box is unchecked.

(4) Verify that the Minimum Image Intensity Removal box is checked.

(5) Verify that the Accelerated SA Detection box is checked.

(6) Verify that the Pre-Condition Imported PSF box is unchecked.

(7) Verify that the Object First Guess is set to Smoothed Raw Image.

PSF Section 

(8) In the Adaptive PSF Tab:

(9) Verify that the Axial Stretch Factor is 1.

(10) Verify that the PSF Waist is 1.

(11) Verify that the Disable PSF Constraints box is unchecked. 

(12) Click OK to close the Expert Settings box. This sets the Expert Settings for the 
FitcDapi_crop.tif dataset.

(13) Close all views before going on to the next tutorial.

Expert Settings Explanations
Z Montage
The Z Montage setting allows the deconvolution application to break the dataset into sections 
along the optical axis and to deconvolve these subsections separately. The valid settings are: On 
(checked) or Off (unchecked).
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Guidelines: The default for this option is “Off”. It should only be turned “On” for image stacks 
with a large “Depth” setting (e.g. >100 slices). This option reduces the amount of RAM required 
by the deconvolution process. It may also be useful in rare cases where the sample thickness is so 
large that the PSF changes dramatically along Z. In such cases, Z Montage allows the blind 
deconvolution to find different PSF solutions for different depths.
XY Montage
The XY Montage option allows the deconvolution application to break the dataset into sub-vol-
umes along the XY dimensions.

Guidelines: The default for this setting is “On”. This option reduces the amount of RAM required 
by the deconvolution application. It should be turned “Off” only if the deconvolution application 
is producing rigid, box-like artifacts in your dataset.
Z Montage
The Z Montage option allows the deconvolution application to break the dataset into sub-volumes 
along the Z dimensions. The default for this option is unchecked.
Dynamic Subvolumes 
The Dynamic Subvolumes selection allows the deconvolution application to subdivide the dataset 
into the largest size the processing computer’s RAM can handle. The advantage of larger subdivi-
sions of data being processed is the increase in processing speed and therefore a decrease in the 
amount of time it takes to deblur a dataset.
Subvolume overlap (Pixels)
The Subvolume overlap setting determines the number of pixels that the montaged subvolumes 
will overlap. The possible values are integers from 0 to N/2, where N is the width or height of the 
XY field in pixels whichever is smaller.

Guidelines: An overlap of 10 or 25 pixels usually works best. If the result of the deconvolution 
contains artifacts having rigid lines, edges or an obvious grid structure start with a value of 10. If 
doing so reduces the problem, but does not eliminate it, then increase this number again. Overlap-
ping regions are deconvolved twice, so making this number too large (e.g. 100) will increase the 
deconvolution time.
XY Guardband (Pixels)
The Guardband size defines the width of a border surrounding each subvolume. This border is the 
region where the subvolumes are processed to seam them together. This guardband prevents arti-
facts at the seams. The possible values are integers from 0 to N/2, where N is the width or height 
of the XY field in pixels whichever is smaller.

Guidelines: Generally, the larger the guardband, the fewer the artifacts and the better the image 
quality. However, deconvolution time increases with guardband size, so a default value is set 
which minimizes deconvolution time and eliminates artifacts in most cases. The default value is 
10. This number may be increased if seaming artifacts appear. If so, first increase the number to 
15, then 20, and then 25 until the seaming artifact is gone.
Z-Guardband (Pixels)
The Z-Guardband specifies the number of slices that will be added at the top and bottom of the 
subvolume. This Guardband prevents artifacts at the seams of these subvolumes. The possible 
values are integers from 0 to N/2, where N is the depth of the XZ or YZ field.
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Guidelines: The Z-Guardband should never be larger than the subvolume overlap region. A value 
of 6 is adequate for most image stacks.
Intensity Correction
Selecting this option will correct for differences in intensities between slices. The default setting 
for this option is unchecked for Confocal images and checked for Widefield and TLB images. It 
works much like the Optical Density Correction feature in the PreProcessing menu.
Minimum Intensity Removal
The Minimum Intensity Removal feature will subtract the minimum intensities from the image. 
Thus, with Minimum Intensity Removal selected, an image that has intensities ranging from 11-
245 will be adjusted to have intensities of 0-234. The default for Minimum Intensity Removal is 
Yes.
Accelerated SA Detection
Selecting Accelerated (this is selected by default) will accelerate the process of detecting the 
spherical aberration of the dataset. Accuracy is slightly better with acceleration not selected, but 
the trade-off of speed with the acceleration is greater than the accuracy compromise.
Pre-Condition Imported PSF
This option will pre-condition an imported PSF.
Object First Guess
The Object First Guess has three options: Flat Sheet, Smoothed Raw Image and Use a Wiener Fil-
ter. The First Guess selects the initial estimate of the object that is used to initiate a blind deconvo-
lution process.

Flat Sheet: Select this option to use a constant array as the object guess.

Smoothed Raw Image: Select this option to use a smoothed version of the original image 
as the object first guess.

Inverse Filter: Select this option to use an Inverse Filter as the object first guess.

Previous Result: Select this option to use the previous result from an already performed 
deconvolution as the object first guess.

Super Resolution
Activate Sub-pixel Processing
This option will perform deconvolution on a sub-pixel grid to achieve super-resolved results. It 
will also, however, result in longer processing times.
XY Factor
If the Activate Sub-pixel Processing feature has been checked, the XY Factor feature will become 
enabled. This feature allows you to select the number by which the pixels will be divided. The 
options are 1 (which is for when the Activate Sub-pixel Processing feature is not activated), 2 and 
3, with three being the highest resolution, and longest processing time. 

PSF Section
In the PSF section there are two tabs: the Adaptive PSF (Blind) and the Non-Blind. 
The Adaptive PSF (Blind) tab
Axial Stretch Factor
This section allows you to set how much axial stretch to allow from the theoretical first guess 
PSF. The default for Widefield datasets is 1, and for Confocal datasets the default is 3.
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PSF Waist
The PSF Waist is the size of the narrowest part of the PSF, usually measured in Airy Disc diame-
ters. The default setting for both Widefield and Confocal is 1.
Disable PSF Restraints
This removes the limitations placed on the Point Spread Function (PSF).
The Fixed PSF tab 
This tab contains the parameters to use with Gold’s method.
Gaussian Width (FWHM in pixels)
This field is based on the Noise Level, found directly below. If the Noise Level is set to Other, 
then this field becomes editable, and you must enter in the Gaussian Width. Otherwise, if you 
select Low, Medium, or High, then the Gaussian Width automatically defaults to a set number. 
This feature will be used to smooth the resultant image.

Noise Level
Select the noise level that best represents your dataset. If the Low, Medium, High options are not 
sufficient, then select Other and then enter in your own Gaussian Width in the Gaussian Width 
section above.

Start 3D Deconvolution

Note: This section applies to users of AutoDeblur.

Blind Deconvolution is considered to be the most accurate algorithm available with AutoDeblur. 
Blind Deconvolution does not require the calibration and measurement of the Point Spread Func-
tion (PSF). Blind Deconvolution can be used with Fluorescence [Widefield], Laser Scanning 
Confocal, Brightfield [Transmitted Light], Spinning-Disk Scanning Confocal, or Two-Photon 
Fluorescence.

3D Blind Deconvolution is an iterative and constrained algorithm. It is iterative in the sense that it 
repeats the same computational operations many times while converging to the enhanced image 
solution. It is constrained in the sense that it only accepts deconvolved images that have the cor-
rect mathematical properties of nonnegativities, (that is, it does not allow the tracer concentration 
to have negative values) and smoothness (suppresses snowy-like noise due to low-light levels). 
3D Blind Deconvolution is a method of deconvolution that adapts itself to the real PSF of the 
microscope system (which can be significantly different from the theoretical PSF and from the 
previously measured PSFs) due to specimen and instrument variations. The AutoDeblur Blind 
Deconvolution system is able to adapt to PSF changes within a specimen itself. Thus, the decon-
volved results are superior to those methods which utilize theoretical or previously measured 
PSFs.

For this example you may use your own data type (Fluorescence [Widefield], Laser Scanning 
Confocal, Brightfield [Transmitted Light], Spinning-Disk Scanning Confocal, or Two-Photon 
Fluorescence images) or you may follow along with the recommended dataset to use.
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(1) Navigate to the Widefield folder under the Tutorial Data directory and open the dataset 
FitcDapi_decon.tif. This dataset has had the Standard Settings and the Expert Settings set up in 
the previous tutorial. The information is contained in its header file, and the header file is auto-
matically read when the dataset is loaded.

(2) From the Deconvolution menu, select Start 3D Deconvolution. The 3D Blind/Non-Blind 
Deconvolution box will appear. 

Before starting a deconvolution, it is a good practice to verify the Optics and Deconvolution Set-
tings. If any of the following settings do not match what is in the Standard Settings box, make the 
appropriate changes in the Optics Settings by clicking the Change button and editing the settings 
so that they do.

(3) In the Deconvolution Methods frame, verify that Adaptive PSF (Blind) is checked.

In the Optics Settings frame verify the following:

On the Microscope frame:

In the Numerical Aperture field, verify the value is 1.4.
In the Refractive Index field, verify the selection is Oil (1.515).
In the Modality box, verify that Fluorescence is selected.

In the Emissive Wavelength frame, the wavelength of the dye used for each channel is
displayed. The dye name next to Probe indicates which dye name was entered last.
Verify the following:

Wavelength red (nm): None
Wavelength green (nm): 520 (FITC)
Wavelength blue (nm): 456 (DAPI)

The Width value is 90 pixels and 6.3 microns.
The Height value is 120 pixels and 8.4 microns.
The Depth value is 49 pixels and 7.35 microns.

The Spacings (microns):

The X Spacing is 0.07.
The Y Spacing is 0.07.
The Z Spacing is 0.15.

On the Deconvolution Settings frame:

In the Total Iterations field enter a value of 10.
In the Save Interval field enter a value of 10. This will perform 10 iterations of
deblurring, saving the 10th iteration.
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Verify that the Noise Level field is set to Low.
Verify that the Faster Processing/Reduced Resolution box is unchecked.
Verify that the Continue from Previous Result box is unchecked (if Deconvolution has not
already been run, this option will be disabled.
Verify that the Use Recommended Expert Settings is enabled.

In the Output Settings frame:

In the Output File Format verify that the setting is on TIFF (16-bit). This is the same 
format as the Input File.
Verify the Base File Name for Deconvolved Data.
Click the Save the PSF Files box. This will create a PSF file that can be loaded for later
use.

(4) Click the box next to the Spherical Aberrations section, then click Detect in the section 
that will appear. AutoDeblur will automatically detect the level of spherical aberration in your 
dataset. This should only take a few minutes.

(5) Once the spherical aberrations have been detected, click Start.

(6) The 3D Blind Deconvolution will start. The results will be displayed in the main viewing 
window.
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Terminate, Cancel and Preview 3D Deconvolution

Once the Deconvolution has begun, a progress dialog box will appear, displaying what iteration is 
currently running on which channel, along with an approximate remaining time. There are also 
options to Terminate, Cancel and Show Deconvolution Preview.
Terminate
This feature will stop the deconvolution process, but will save and open a new dataset, based on 
the most recently completed iteration. When this button is clicked, you will receive a message 
saying Terminating Deconvolution: Do you wish to finish the iteration and save the result? Click-
ing Yes will finish the current iteration, and open the result in a new dataset. Clicking No will stop 
the deconvolution immediately, and save and open a new dataset based on whichever was the last 
iteration completed (for instance, if you clicked Terminate during the 10th iteration, it would save 
and open a dataset based on the 9th iteration).
Cancel
This feature will stop the deconvolution process, and will not open a new dataset. When you click 
on Cancel, you will receive a message saying Do you wish to stop this process? Clicking Yes will 
stop the process and return to the original dataset. Clicking No will resume the deconvolution.
Show Deconvolution Preview
Checking this feature will show a small preview of the dataset as it is being deconvolved and you 
will be able to view the improvement in the image with each iteration. The default for this feature 
is unchecked.

Close all views before continuing on to the next section.

2D Blind Deconvolution

AutoDeblur’s 2D Blind Deconvolution allows you to apply the Blind (Adaptive) Deconvolution 
to a single two-dimensional image (the image can be Fluorescence (widefield), Laser Scanning 
Confocal, Brightfield (Transmitted Light), Spinning-Disk Scanning Confocal, and Two-Photon 
Fluorescence) without requiring previous knowledge of the microscope parameters or the image 
parameters. The 2D Deconvolution algorithm is also capable of improving the resolution of an 
image for the restoration of features at a sub-pixel resolution level. You may process multi-frame 
(time series) image sets, individual color channels or intensity images. The 2D algorithm is able 
to suppress noise while retaining quantitative accuracy (total number of photons) in the image, 
thus allowing you the ability to make valid quantitative measurements. 

Open an Image

(1) From the File menu select Open or from the Toolbar click on the Open File icon. Click on 
the Widefield folder and open it. 

(2) From the Widefield folder select the colencsc.1.tif dataset and click Open. The Files of 
type field must be set to All Files (*.*) or TIFF (*.tif, *.tiff).
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(3) A dialog box will appear with the statement Dataset only contains one optical slice, the 
orthogonal projection along XZ and YZ will be inactive. Click OK.

(4) AutoDeblur will now load the colencsc.1.tif dataset and display it in the XY Max Projec-
tion view.

Setting Up a 2D Blind Deconvolution

Select a Region of Interest
(1) Click and hold the left mouse button down, while dragging out a Region of Interest (ROI) 
similar to the one shown below.

(2) From the Deconvolution menu select 2D Blind Deconvolution. The 2D Deconvolution 
box will appear, with the Standard tab as the active tab. A 2D Deconvolution Results box which 
will show the result of the deconvolution will also appear.
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Within the 2D Deconvolution box set the parameters to the following values: 

(A) For the Data to deblur selection, click on the Region of Interest box.
(B) The Color selection should be All Channels.
(C) For the Deconvolution Parameters, increase the Total Iterations number to 30.

The PSF Correction Factor (2) and Super Res Factor (1) remain unchanged.
(D) The Image Info box settings remain unchanged. The image size is displayed in
pixels, i.e. 256 x 256.
(E) The Noise Smoothing setting should remain as Low, because this image does not
contain a great amount of background noise.

(3) The Expert tab, the ROI tab and the Frames tab settings remain unchanged from their 
default values.
Process an Image 
(1) Click OK to begin the deconvolution process.

Note: To interrupt the deconvolution, press the ESC key and wait for the current iteration to fin-
ish.

(2) When the 2D Blind Deconvolution is complete a 2D Deconvolution Results box appears 
with three tabs: Results, Channels, and Save.
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2D Deconvolution Results

In the Results tab, you are able to view the result of the deblurring process at each iteration by use 
of the scroll bar in the View Iterations frame. You have the option to display the PSF during the 
viewing process by checking the check box next to Display PSF. You also have the option to alter-
nate between the current iteration number result and the original image by clicking on the Origi-
nal/Current button.

Within the Adjust Deblur Parameters frame you may choose to do further iterations by clicking on 
the Further Processing button or you may click on Return to Setup to rerun the 2D Deconvolution 
with different parameters.

Within the Use Current Iteration Settings to Deblur frame you may choose to process the Full 
Image or Multiple Frames of the Full Image or a ROI (Region Of Interest). You may click the Use 
ROI box to enable it and then click the Full Image button to process that region of interest 
throughout the entire dataset. 

To Further Process a Data Set

(1) With the 2D Deconvolution Results box open and the Channels tab active, enable the 
Adjust All feature. You may click on any one of the scroll bars, and scroll back and forth. With the 
Adjust All feature engaged, all the channel scroll bars will slide simultaneously. Notice how the 
fine details become clearer up to the last iteration of the deconvolution performed. 
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(2) To view a separate channel’s processing, disable the other channel(s) by removing the 
check mark in their respective boxes. For this Lesson, disable the Blue and Green Channels.

(3) Slide the Red Channel’s bar back and forth; note that the fine details becomes clearer to 
the last iteration, but never reaches a point where the channel’s clarity levels off or starts to 
become blurred. This is a good indication that further processing is required.
 
(4) Click on the Results tab, and click the Further Processing button. AutoDeblur will process 
the dataset for 10 more iterations, and display the 2D Deconvolution Results box alongside the 
processed results. Return to the Channels tab and scroll the channels back and forth observing the 
increase in clarity and observe that around iteration 38, the image’s clarity starts to stay the same. 
This indicates that the image does not require further iterative processing. 

(5) Slide the Red Channel’s bar back and forth; note that the fine details reach a point where 
an increase in clarity has stopped. Leave the slider at that point.

(6)  When you have deconvolved the Region of Interest to the desired level (as above), you 
may apply the parameters to the whole image. Click on the Results tab, and click the Full Image 
button in the “Use Current Iteration Settings to Deblur” frame. A confirmation box will appear, 
allowing you to confirm, or change the total number of iterations to perform. The number of iter-
ations that appears is based on where the slider was left in step 5. Click OK. AutoDeblur will 
deconvolve the entire image using the current number of iterations and settings for each channel.
Viewing the Channels of a Processed Dataset.
A processed image may appear brighter in the region that has been processed, than in the unproc-
essed region. The 2D Blind deconvolution typically increases the dynamic range (the maximum 
value a pixel can have becomes increased) of the processed image compared to the original 
unprocessed image.

(1) Click the Channels tab. You may view 1, 2 or 3 of the channels simultaneously, by check-
ing or unchecking the check boxes next to each channel.
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(2) To adjust the appearance of the processed dataset you may check the Adjust All box and 
use one of the scroll bars in the Mixing box to adjust the iteration number and/or you may adjust 
the Minimum, Maximum or Gamma values in the Display Controls box. You may adjust the 
channels and the iterations individually by selecting or deselecting the Channel(s) of interest. 

(3) While viewing an individual channel, if you feel the specific channel appears dim, in the 
Display Controls frame you may check that channel’s Radio button and adjust the Gamma value.
You may also perform further processing to change the appearance of the Channels.

To process the image further see To Further Process a Dataset above.

Saving a Processed Dataset

(1) In the Save tab you are able to select the Directory in the Where to Save frame. This will 
be where the file you are about to save will be saved. AutoDeblur will display the default name 
for the File name Prefix. You can either accept this default name or create your own. AutoDeblur 
will automatically append the File name Prefix with the slice range and the number of iterations 
performed in the resultant processed dataset. If the Full Image was chosen then the slice range 
will consist of all the slices in the dataset.

In the Data to Save frame, you can choose to save just the Image, the PSF, or Both. Saving the 
PSF with the image will create a larger file by approximately 2 fold.

The Iteration(s) to Save features allows you to save the Current iteration, All the iterations, or 
only a Selected few iterations in a processing sequence. When you choose Selected as your option 
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for Iteration(s) to Save, you may specify the first or the Start iteration, the End iteration and the 
Step of iterations (the number of iterations to be skipped when saving the processed image).

(2) For the Where to Save frame, you may use the default location or click on the Browse but-
ton and navigate to the desired location. 

(3) You may use the name already in the File Name Prefix box or change the name as desired. 
For this example use (colencsc.1) as the File Name.

(4) In the Data to Save frame, the Image selection should be enabled.

(5) In the Iteration(s) to Save frame, enable Selected. For the Start value enter 15, for the End 
value enter 30, and for the Step value enter 15. This will Save the 15th and the 30th iteration when 
the Save button is clicked. 

(6) Press the Save button. A dialog box will appear with the Prefix File Name chosen above 
and the iterations to be saved as the suffix (i.e., colencsc_15-30.tif).

(7) Press the Close button.

Close all datasets before continuing on to the next section.
Time Lapse Images
You also have the option of selecting a region of interest and applying the region of interest to 
only part of a time lapse dataset. 
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(1) Click on the Open File icon, browse to the Time Lapse folder, and open 
Image_T001_S001_Z001_C01. A message will appear saying A sequence of files associated with 
the selected file is detected. Do you wish to load the entire sequence? Select Yes.

(2) The Select Pattern dialog box will appear. Select the pattern where the # follows the letter 
T. This instructs AutoDeblur where the time series indicator is in the file name.

(3) From the Deconvolution menu select 2D Blind Deconvolution. The 2D Deconvolution 
dialog box will appear with the Standard tab displayed.

(4) In the Data to deblur frame select the Multiple Frames option.

(5) To set the range of images you would like to process, select the Frames tab and in the Mul-
tiple Frames frame select Frame range. Enter the desired starting Frame (image number) in the 
Start Slice box, and enter the desired ending Frame number (image number) in the End Slice box.

(6) Click OK. A Save Multi-Frame Deblur box will appear. You may use the default name for 
the resulting dataset or you may type in a name for your resulting dataset.

(7) Click the Save button. A 2D Deconvolution will run on your dataset, and upon completion 
you will be prompted to save the newly created file.

(8) Click the Save button. A dialog box will appear asking you Do you wish to export as mul-
tiple files, each of a single slice? Select Yes. AutoDeblur will show you the naming extension it 
will append to the dataset. The new dataset will be saved under a name indicating the Start and 
End slices along with the number of iterations in its title.

Close all datasets before moving on to the next section.

Inverse Filter 

Use with Widefield Fluorescence and Transmitted Light Brightfield datasets only.

The Inverse Filter is a one step non-iterative deconvolution method based on inverse-filtering the-
ory. It utilizes optimal linear filtering. 

Inverse Filter is one of the simple deconvolution methods offered in AutoDeblur. It is very useful 
for obtaining quick results, but is not as accurate as Blind Deconvolution. Inverse Filtering is typ-
ically more robust than the Nearest Neighbor or No Neighbor deconvolution methods. The execu-
tion speed of the Inverse Filter is between that of Nearest Neighbor and Blind Deconvolution. 
The Inverse Filter should be used in cases where speed is important. A typical processing time is 
under 2 minutes with a 256x256x32 dataset (Pentium III, 450 Mhz). 

(1) Navigate to the Widefield folder and open Pollen.deb.
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(2) From the Deconvolution menu select Deconvolution Settings, then select Standard Set-
tings, or you may double click within the image to make the Standard Settings box appear.

(3) Verify the following dimensions:

In the Microscope Settings and PSF Dimensions frame:

In the Modality box, verify that Fluorescence is selected.
In the Lens NA field, verify the value is 0.7.
In the Refractive Index field, verify the selection is Oil (1.515).

In the Image frame.

The Width value is 90 pixels and 32.724 microns.
The Height value is 80 pixels and 28.56 microns.
The Depth value is 110 pixels and 44 microns.

The X Spacing is 0.3636.
The Y Spacing is 0.357.
The Z Spacing is 0.4.

In the Probe frame, the Probe may be left blank.
Verify for Channel 1 the wavelength is 540nm. 
Channel 2 and Channel 3 will remain blank.

(4) Click OK on the Standard Settings box.

(5)  From the Deconvolution menu select Inverse Filter. The Inverse Filter Parameters box 
will appear.

(6) The Optics Settings frame contains the dataset’s Width, Height, Depth and Spacings. Ver-
ify that they are the same as listed above. 

(7) Leave the Spherical Aberrations checkbox unchecked. If your dataset has spherical aber-
rations, select this box, then click the Detect button. AutoDeblur will then detect the spherical 
aberrations so that they can be corrected when running the Inverse Filter algorithm.

(8) Select Medium from the Noise Level drop down menu.

(9) The Phase Content Expected should be used if the specimen is a Transmitted Light Bright-
field dataset, and exhibits significant phase characteristics, e.g. areas of the specimen appear 
brighter than the background. For this dataset leave the Phase Content Expected box unchecked.

(10) Click Start. AutoDeblur will now execute the Inverse Filter deconvolution. The status bar 
will indicate the progression of the Inverse Filter.
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(11) When the Inverse Filter method has finished, a new XY-Max Projection view will appear. 
This is the result of the Inverse Filter deconvolution. Do not close the Inverse Filter result Unti-
tled# dataset. You will compare it to the results of the Nearest Neighbor in the Nearest Neighbor’s 
section on pages 144-146.

Inverse Filter Batch Processing

This feature allows you to batch Inverse Filter operations.

Within the Inverse Filter Parameters dialog box, enter all the necessary parameters for the inverse 
filter operation. In order to add an inverse filter operation to a batch, verify that the parameters in 
the dialog are valid, and then click the Batch button.

From the Deconvolution menu, select Batch Process. Within the Batch Processing dialog box, the 
column labeled Operation allows you to know the type of operation that a specific task will per-
form. There are two types of operations: 3D Iterative Deconvolution and 3D Inverse Filter.
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You may switch between the two operations by selecting “Change Operation…” from the Edit 
menu, as shown below. This menu is also accessible by right-clicking on any of the tasks within 
the batch table.
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When you click on the “Change Operation” tool, a Change Operation dialog box will appear, 
allowing you to choose between the 3D Deconvolution and the Inverse Filter.

Once the all desired tasks have been loaded in, you can either begin the processing immediately 
by clicking the Start button, or you can schedule the processing to begin at some point in the 
future by selecting a date and time from the Start Time box, then clicking the Start button. Once 
this is done, a countdown will appear near the bottom of the dialog, indicating when the batch will 
begin processing. For more information on Batch Processing, proceed to the Batch Processing 
section.

The output of the inverse filter operation will have the same file format as the raw input dataset. 

Note: Do not close the Pollen.deb dataset. Please continue on to the next section.

Nearest Neighbor/No Neighbor 

Use with Widefield Fluorescence and Transmitted Light Brightfield datasets only.

The Nearest Neighbor algorithm is the fastest algorithm available. It works by deconvolving one 
image slice at a time. As a trade-off in order to achieve this speed, it is less accurate than either the 
Blind Deconvolution or the Inverse Filter. It should be used in cases where speed is most impor-
tant. Typical processing times are less than 1 second for a 256x256 single image slice and less 
than 1 minute for a 256x256x32 3D dataset (Pentium III, 450 Mhz). 

AutoDeblur contains two methods for running the Nearest Neighbor deconvolution on a dataset. 
One method is called Processing Stack and will run the specified deconvolution on the entire 
image stack. The other method is called Processing Current Slice and is run while viewing one 
slice of an XY-Slice Viewer of the image stack. 

Processing Current Slice

(1) Click on the Pollen.deb dataset to make it the active view. From the Visualization Menu 
select Slice Viewer. The slice currently displayed will be the slice processed. 
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(2) From the Deconvolution menu select Nearest Neighbors and click on Processing Current 
Slice. The Nearest/No Neighbor Slice Operation dialog box will appear. The Haze Removal Fac-
tor, the Z Kernel Width, and the No Neighbor selections will have values preset for you. The 
default value for the Haze Removal factor is 0.97, and for the Z Kernel Width it is 3. The No 
Neighbor algorithm and Phase Content Expected are both disabled by default.

Note - The Phase Content Expected should only be checked if the specimen is a Transmitted Light 
Brightfield dataset, and exhibits significant phase characteristics, e.g. areas of the specimen 
appear brighter than the background. For this dataset leave the Phase Content Expected box 
unchecked.

(3) Click the Apply button. The Nearest Neighbor deconvolution will be applied to the current 
slice and will be displayed in the current Slice Viewer. To return to the original view of the slice 
click the Restore button. 

To use the No Neighbor algorithm instead of the Nearest Neighbor algorithm check the No Neigh-
bor box on the Nearest/No Neighbor Slice Operation box.

(4) Adjust the results by trying different values for the Haze Removal Factor and the Z Kernel 
Width, also try the No Neighbor deconvolution by clicking in the flag box to activate and deacti-
vate it.

(5) Set the Haze Removal Factor to 0.98, the Z Kernel Width to 2, and leave the No Neighbor 
check box unchecked. These values produce satisfactory results for the Nearest Neighbor or No 
Neighbor algorithm. Click the Restore button to restore the optical section to its original view.

(6) Click the Close button to exit from the Nearest/No Neighbor Slice Operation box. The 
algorithm chosen (Nearest Neighbor), and the values selected for the Haze Removal Factor and 
the Z Kernel Width are now saved for this specific dataset.

Note: Do not close the Pollen.deb dataset. Please continue on to the section.

Processing Stack

(1) Click on the Pollen.deb: XY MAX Projection to make it the active view. From the Decon-
volution menu select Nearest Neighbor and select Processing Stack.

(2)  The Nearest/No Neighbor Parameters box appears. The settings for the Haze Removal 
Factor (0.98), the Z Kernel Width (3), and the Nearest Neighbor algorithm were determined above 
in the Processing Current Slice section.

(3) Click Start. The deconvolution will be performed on each slice of the entire stack. A status 
bar will indicate the progression.

(4) Compare the results of the Nearest or No Neighbor deconvolution to the original dataset 
and note how the deconvolution removes haze and sharpens features. Examine the Maximum pro-
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jections and the Slice Viewers of the original Pollen.deb dataset, the Inverse Filter, and the Near-
est Neighbor results in both the XY and XZ views.

Close all datasets before continuing on to the next section.

Axial Blind Deconvolution

Use only with Confocal datasets

Also known as 1D deconvolution, this is a form of blind deconvolution that is especially custom-
ized for speed. It is designed to be the fastest method for deblurring a confocal dataset. It is used 
for applications where improving the resolving power is desired only along the optical axis. This 
is a typical scenario for confocal dataset collection where empty lateral magnification is often 
avoided (the X and Y dimensions show no distortion or haze). Typical processing times are in a 
range from 2 to 5 minutes with a 256x256x32 dataset (Pentium III, 450 Mhz). 

(1) Open the original Neuron_crop1.deb dataset from the Confocal folder.

(2) From the Deconvolution menu select Axial Blind Deconvolution. The Axial Blind Decon-
volution box will appear. The Use Power Acceleration is automatically selected. This accelerates 
the algorithm and requires less iterations. The number of Iterations is set to 10.

Note - It is recommended that you do not select the Use Power Acceleration feature if your dataset 
has a high noise to signal ratio.

(3) Click Start. AutoDeblur will execute a one-dimensional deconvolution of the 
Neuron_crop1.deb dataset. A status box will appear indicating the progression.

(4) The deconvolution results will appear on the screen upon completion as a new, untitled 
dataset. 

(5) Generate an XZ View by clicking on the XZ view icon on the Toolbar.

(6) Generate a Slice Viewer of the Untitled1.deb: XZ Max projection by clicking on the Slice 
Viewer icon on the Toolbar. The median slice number, approximately 32, will be displayed. Com-
pare the axial deblurred result to the raw dataset.

XZ/ZY Slice Deconvolution

Use only with Confocal datasets.

Also known as 2D Slice deconvolution, this is a form of blind deconvolution that is especially 
customized for processing a single XZ or ZY slice (slices that are parallel to the optical axis).
It is used for applications where a quick result is necessary and an XZ or ZY cross sectional view 
is sufficient, and the accuracy afforded by the blind deconvolution is also necessary. A typical 
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processing time is under 8 seconds for a single XZ slice with a 256x256x32 dataset (Pentium III, 
450 Mhz).

(1) Click on the Neuron_crop1.tif: Max projection view to make it the active view.

(2) Generate the XZ view of the image. 

(3) Generate the XZ Slice Viewer of the dataset.   

(4) From the Deconvolution menu, select XZ/ZY Slice Deconvolution. The XZ/ZY Slice 
Deconvolution box will appear, click Start.

(5) When the XZ/ZY Slice Deconvolution has come to completion, the deblurred image will 
appear. This image is not a fully three-dimensional stack of optical sections. It represents the 2D 
Slice deconvolution of the selected slice in the XZ optical view.

DIC Restoration

Use with Differential Interference Contrast datasets only.

The DIC Restoration feature converts a DIC image into an image that represents the optical thick-
ness of the specimen.

Restoration Method

This section allows you to select between an Iterative and an Inverse Filter process to restore your 
dataset. The Iterative process will yield better results, whereas the Inverse Filter will yield satis-
factory results in less time.

DIC Image Settings

Slice Selection
In this section, select the slice(s) to deconvolve. Choose from All Slices, Current Slice, or Slice 
Range. If Slice Range is chosen, you must enter a range into the From: and To: text boxes.
Image Characteristics
In this section, input the data about your dataset to attain the best restoration results possible.
Shear Angle
This is the angle at which the light in your acquisition equipment meets your object. Select the 
proper angle for your equipment, and the shadow box to the right of the drop down menu will 
mimic the lighting of your dataset.
Image Noise
Select the image noise level that best matches your dataset, Low, Medium or High.
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Channel to Deconvolve
Select the channel to restore. If you are restoring a grayscale image, the only available option is 
Intensity; if you are restoring a multi-channel image, select the channel to restore.

Advanced Settings

Clicking the Advanced button will open the Expert Settings dialog. Only change these settings if 
you are experienced with the DIC Restoration feature. Otherwise, use the default settings.

(1) Navigate to the DIC folder and open test.tif.

(2) From the Deconvolution menu, select DIC Restoration.

(3) In the Restoration Method section, select Iterative.

(4) In the DIC Image Settings, select All Slices (the current image is only 1 slice).

(5) Still in the DIC Image Settings section, select 135 from the Shear Angle drop down menu. 
Once the angle is selected, a sample will appear to the right of the drop down menu; the light pat-
tern in this image should match that in the dataset.

(6) Select Low for Image Noise.

(7) Click Advanced to view the advanced features. Verify that Total Iterations is set to 15. 
Verify that the Regularization Iterations and Regularization Contribution are both set to 10. Make 
sure all of the Processing Options are checked.

(8) Click OK.

Batch Process

Under the Deconvolution menu click on Batch Process. The Batch Processing box will appear.

Start

This function starts the deconvolution process for the batch files in the queue. Once the Batch pro-
cess has started, you may cancel the processing of one or more of the files by clicking the Cancel 
button on the progress box. This cancellation will only apply to the file currently being processed 
and will not effect the previously processed files or the files yet to be processed.

Note: This menu item will NOT become available unless there are image stacks in the queue.
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File Menu

Open
This option in the Batch Process dialog allows you to navigate to a folder and select the files you 
would like to add to the Batch. Selecting Open from the File menu launches Windows Explorer. 
Once the file of interest is located, drag and drop it into the Batch queue.

Edit Menu

This menu allows you to copy and change the settings for the files in the Batch. The Tool menu 
items are: Copy Optics Settings, Paste Optics Settings, Copy Deconvolution Settings, Paste 
Deconvolution Settings, Copy PSF File Settings, Paste PSF File Settings, Change Settings, 
Change PSF File, and Change Operation. These features may also be accessed by moving your 
cursor over the file you wish to edit in the Batch and right click the mouse.
Copy Optics Settings
This feature allows you to copy the Optics Settings from one of the files in the Batch.

(1) To use this feature select your source dataset. 

(2) From the Edit menu select Copy Optics Settings. This copies the Optics Settings parame-
ters from your source.
Paste Optics Settings
This feature allows you to paste the Optics Settings into selected files in the Batch.

(1) To use this feature select the datasets you want to paste the Optics Settings into. 

(2) From the Edit menu select Paste Optics Settings. This pastes the Optics Settings parame-
ters from your source dataset into the selected files.
Copy Deconvolution Settings
This feature allows you to copy the setup and deconvolution parameters from one of the files in 
the Batch.

(1) To use this feature select the file of interest from the Batch by clicking on it. 

(2) From the Edit menu select Copy Deconvolution Settings. This automatically copies the 
file’s parameters. If you paste the copied settings file into a text editor (e.g. Windows Notepad) 
you will be able to view the actual settings for the deconvolution. 
Paste Deconvolution Settings
This feature allows you to apply the setup and deconvolution parameters from one file into one or 
more files in the Batch. This feature is generally used when similar files are collected using the 
same microscope setup.
 
(1) To use this feature, select the file(s) from the Batch that you would like to copy the decon-
volution parameters to. In this case, the PollenPA.deb file. 
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(2) From the Edit menu select Paste Deconvolution Settings. This automatically Pastes the 
Pollen.deb deconvolution parameters into the PollenPA.deb file.
Copy PSF File Settings 
This feature allows you to copy the PSF File parameters from one of the files in the Batch.

(1) To use this feature select the TOSPollen_psf.deb in the Batch by clicking on it. 

(2) From the Edit menu select Copy PSF File Settings. This feature copies the file’s parame-
ters.

If you were to paste this file into a text editor, you would be able to view the actual settings for the 
deconvolution. 
Paste PSF File Settings. 
This feature allows you to apply the PSF parameters from one file into one or more files in the 
Batch. This feature is generally used when similar files are collected using the same microscope 
setup.
 
(1) To use this feature, select the Pollen_psf.deb file from the Batch1 queue. Select Copy PSF 
File Settings from the Tool menu. 

(2) Click on the TOSPollen_psf.deb file to make it active. 

(3) From the Edit menu select Paste PSF File Settings. This automatically Pastes the 
Pollen_psf.deb PSF parameters into the TOSPollen_psf.deb file.
Copy All
This feature will copy all of the setting (Optics, Deconvolution and PSF) from the selected file in 
the batch.

(1) To use this feature select your source dataset. 

(2) From the Edit menu select Copy All. This copies the Optics Settings, Deconvolution Set-
tings, and PSF Settings parameters from your source.
Paste All
This feature allows you to apply the Optics, Deconvolution and PSF settings that have been cop-
ied from a selected file.

(1) To use this feature select your source dataset.

(2) From the Edit menu, select Copy All.

(2) Select the file to which to paste the settings. From the Edit menu select Paste All. This 
pastes the Optics Settings, Deconvolution Settings, and PSF Settings parameters to your selected 
file.
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Change Settings
This feature allows you to change the setup and deconvolution parameters for a file in the Batch.

(1) To use this feature, select the file from the Batch that you would like to change. For exam-
ple, the PollenPA.deb file.

(2) From the Edit menu select Change Settings. The 3D Blind/Non-Blind Deconvolution box 
will appear. Change the Save Interval setting to 20 and click Update Batch. This will update the 
settings in the Batch for the PollenPA.deb file. 
Change PSF File
This feature allows you to change the PSF file used in a Fixed PSF (Non-blind) deconvolution.

(1) To use this feature, select the PollenPA_psf.deb file in the Batch file. 

(2) From the Edit menu select Change PSF File. An Open box will appear. Navigate to the 
Batch folder and select Pollen_psf.deb. Click the Open button. The file will automatically replace 
the PollenPA_psf.deb
Change Operation
This feature allows you to change the operation to be performed on the dataset.

(1) To use this feature, select Task 1 in the Batch Processing dialog box.

(2) From the Edit menu, select Change Operation. A Change Operation dialog will appear. 
Select the desired operation.

Help Menu

The Help item, from the Help menu, will open the Online Help system directly to the Batch Pro-
cess section.

Cancel

This function closes the Batch function without starting the Batch process. The cancellation will 
only apply to the file currently being processed and will not effect the previously processed files 
or the files yet to be processed.

Clear List

This function allows you to remove all the files in the Batch queue.

Delete

This function allows you to remove the selected file from the Batch queue. To use this feature first 
select the file to be deleted by clicking on it, then click the Delete button.
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Paste

This function allows you to Paste a file that has been copied into the Batch queue.

Adding Files to the Batch

(1) Select Batch Process under the Deconvolution menu. Select Open from the File menu and 
navigate to the Tutorial Data directory. Open the Batch folder and select the Pollen.deb file. 

(2) With the Pollen.deb selected click and drag the file over to the Batch box and drop it into 
the Batch queue.

(3) From the Batch folder select the following files: PollenPA.deb, PollenPA_psf.deb, 
TOSpollen.deb, and the TOSpollen_psf.deb file. While the cursor is over one of the selected files, 
depress the left mouse button and drag the selected files into the Batch queue.

Note: Do not close the Batch Processing box. Please continue on to the next section.

Save Max. Projection

This feature allows you to save maximum intensity projections of batched operation results.

Click the checkbox in the Batch Processing dialog, labeled Save Max. Projection.

When you have checked this box, a maximum intensity projection of the processed dataset from 
the XY perspective will be saved into the same directory as the processed dataset. The file format 
of the max projection output will match the file format of the processed dataset.

Scheduling a Batch

To schedule AutoDeblur to run a batch process at some point in the future, you can select a date 
and time from the Start Time text box. The text box will not allow you to chose a time that has 
already passed (for example, if it is currently 4/17/03 14:26, it will not allow you to select 4/17/03 
14:00, nor will it allow you to chose a date before the current date).
Once all of the desired jobs have been loaded, and the start time has been selected, click the Start 
button. Once this is done, a countdown will begin beneath the buttons on the bottom of the Batch 
Process dialog box, showing the time remaining until the batch process will begin.

Cancel Timer

Clicking the Cancel Timer button in the Batch Process dialog will cancel the timer. It will not 
delete the jobs that have been loaded into the Batch Process dialog, and the timer can be restarted 
by clicking the Start button.
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Cancelling, Pausing and Resuming a Batch Process

Once a batch process has begun, you can pause or cancel the batch. While the batch is running, 
the following dialog will appear:

Clicking on the Pause button will pause the batch, and the Pause button will change to a Resume 
button. Clicking on the Resume button will then resume the batch.

Clicking on the Cancel button will launch the following dialog 
box:

Clicking the Cancel Entire Batch button will cancel the entire batch. Clicking the Cancel Current 
Deconvolution will cancel the current job without creating a deconvolved dataset for that job, and 
move to the next. Clicking Continue will not cancel any of the jobs, and will resume the batch.
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Show Deconvolution Preview

In the lower left-hand corner of the Performing 3D Deconvolution progress dialog, there is a 
checkbox for Show Deconvolution Preview. Clicking on this box will display a small preview of 
the image, and you will be able to view the improvement in the image with each iteration. The 
default setting for this is unchecked.

Please close all datasets before moving on to the next section.
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Tutorials for Visualization Menu Items

Maximum Projection

This function takes parallel rays, perpendicular to the viewing surface, and casts them through the 
image. The maximum voxel value encountered along each ray is taken for the projection pixel 
value, and the resulting image is made up of each maximum voxel value. This projection high-
lights edges and prominent bright features.

(1) From the File menu select Open. Navigate to the Widefield folder and select Pollen.deb. 
Click Open. The dataset will be loaded in the XY Maximum projection view. The XY Max Pro-
jection view is the standard default view, except for transmitted light brightfield datasets, which 
open in the XY Minimum projection view.

(2) Select XZ from the Single View option under the View menu. 

(3) Set the XY Max Projection as the active view by left-clicking in the view.

Note: The status bar on the lower left-hand corner of the main window will display the active view 
and projection.

Note: Do not close Pollen.deb: XY Max Projection. Please continue on to the next section.

Minimum Projection

This function takes parallel rays, perpendicular to the viewing surface, and casts them through the 
image. The minimum voxel value encountered along each ray is taken for the projection pixel 
value and the resulting image is made up of each minimum voxel value. 

The Minimum projection provides volumetric representations in which foreground intensities 
tend to be suppressed. This projection highlights edges and prominent dim features.

(1) Select Minimum Projection from the Visualization menu. The Minimum Projection will 
be automatically calculated and displayed. 

Note: Do not close Pollen.deb: XY Max Projection. Please continue on to the next section.

Sum Projection

This function takes all the voxel values along each parallel ray, perpendicular to the viewing sur-
face, and sums their intensity values. This creates a projection of all the summed values. Sum Pro-
jections provide volumetric representations of the dataset in which more information from the 
dataset is considered than with the Maximum projection. Background noise will also be included 
in this type of projection.
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(1) To generate a Sum Projection for the Pollen.deb dataset, either click on the Sum Projec-
tion icon or select Sum Projection from the Visualization menu. 

Note: Do not close Pollen.deb: XY Max Projection. Please continue on to the next section.

Voxel Gradient Shading

This function finds the first voxel that is above the intensity threshold for each parallel ray, per-
pendicular to the viewing surface, then computes the dot product of the gradient at this point. 
These dot product values make up the pixel intensity values in the 2-D projection. This function is 
ideal for examining the surfaces of objects. 

Click on the XY Max projection view of the Pollen.deb dataset to make it the active view. 

(1) From the Visualization menu select Voxel Gradient Shading.

Note: The Voxel projection creates a shaded isosurface for a volume at a specific threshold value. 

(2) From the View menu, open Image Enhancement. This will allow you to modify the thresh-
old of the Voxel Gradient Shading projection. 

(3) Enter 60 into the Minimum Percentage textbox (the lower-left box in the Thresholds 
frame) or slide the bar until the percentage value becomes 60%. Leave the Max. projection at 
100%. The Voxel Gradient shading dataset will automatically update.

(4) Try changing the Threshold to other values to view the new results.

(5) Click the OK button on the Image Enhancement dialog, and click the Close button on the 
Voxel Gradient Rendering box.

Note: Do not close Pollen.deb: XY Max Projection or the Pollen.deb: XY Voxel Gradient dataset. 
Please continue on to the next section.

Best Focus

Note: This section applies to users of the AutoVisualize software only.

This function takes parallel rays, perpendicular to the viewing surface, and casts them through the 
3D image. The voxel, encountered along each ray, with the greatest local contrast is selected for 
display in the resulting 2D image. This produces an image constructed from the most in focus fea-
tures from the volume.
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A Best Focus projection creates an image out of the regions within a volume that best stands out 
against their neighbors. This is useful for observing more subtle features in an image, which may 
be not as pronounced in other projections.

(1) Make the Pollen.deb Max Projection the active view.

(2) From the Visualization menu select Best Focus. The Best Focus projection of the dataset 
will be displayed. Again, you may adjust the Min. and the Max. intensities by opening Image 
Enhancement from the View menu.

Please close all views before going on to the next tutorial.

Slice Viewer

This function generates slices through the image “optically” and then displays the “face” of each 
slice in the Slice Viewer. The thickness of each slice corresponds to the Z spacing or step size. 
Viewing in the Slice Viewer is a good way of examining the degree of optical sectioning in the 
dataset. 

You are advised to examine your dataset in a Slice Viewer because it allows you to see subtle and 
not so subtle changes from slice to slice.

Make the Pollen.deb: XY Max Projection dataset active by clicking within its view.

(1) From the Visualization menu, select Slice Viewer to generate an optical slices projection 
of the dataset from the XY perspective.

Note: When a projection operation is selected, the resultant view formed depends upon the cur-
rently active view. For example, in the previous step the XY Max projection was the active view. 
Thus, when the Slice Viewer menu item was selected, optical slices were created from an XY per-
spective.

(2) To step through the optical slices, simply move the slider at the bottom of the view. This 
can be accomplished either by clicking on the button and dragging it to the left or right, or by 
clicking either the left or right arrow key. The current slice number is displayed to the left of the 
AUTO button.

(3) The Slice Viewer also has the ability to cycle through all the slices automatically. To 
enable this feature click the button labeled AUTO to the left of the slider. The AutoPlay feature 
will be engaged, and the slices will begin being displayed sequentially.   

(4) Clicking the button now labeled STOP will halt AutoPlay. 

Note: Do not close Pollen.deb: XY Max Projection. Please continue on to the next section.
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Slice Synchronizer

This feature allows you to scroll through the slices of more than one image simultaneously. In 
addition to allowing you to scroll through the slices of multiple images one at a time, it also 
allows you to “auto-scroll” through multiple images simultaneously.

Make sure that the Slice Viewer of the Pollen.deb is still open. From the Visualization menu select 
Slice Synchronizer. The Slice Synchronizer dialog box will appear.

When this dialog box is first opened, the table will contain all of the datasets that are open to an 
XY view. Since it is including all open XY slice viewers, they need not all have the same number 
of slices. All datasets will be synchronized to the slice number of the first dataset to appear in the 
table (which can be arbitrary). This means that the synchronizer is permitted to manipulate the 
currently viewed slice number of datasets that appear in this table. If there are datasets that have 
different numbers of slices, (e.g., one dataset has 50 slices, one has 30 slices and one has 90 
slices), all datasets will scroll only through the number of slices contained in the smallest dataset 
(in this case, all datasets would scroll through slices 1-30). If there are no XY slice viewers open, 
then a message will appear in the bottom left region of the dialog informing you that you must 
open an XY slice viewer to be able to do anything.

Datasets are added and removed as they are added or removed from the workspace, and also as 
they are minimized or restored in the workspace (minimizing a dataset will remove it from the 
synchronizer; restoring it will re-add it).

Selecting a View

You may choose to synchronize slice viewers of any of the three orthogonal views – XY, XZ, or 
ZY. When you change the selected view, the slice synchronizer will attempt to make accessible 
each of the datasets that were already being synchronized. This means that a slice viewer that is 
not open for the newly selected perspective (but was open in the previous perspective), will be 
opened automatically. For example, consider the synchronization table above 1_Pollen.deb is 
being synchronized in the XY view. If you were to change to the XZ view, and 1_pollen.deb did 
not have an XZ slice viewer open, it would be automatically opened.
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However, if a dataset that appeared in the previous view has a slice viewer open but minimized in 
the new view, then it will not be included in the new view’s synchronization table (the assumption 
being that it was minimized for a reason). Continuing from the last example, if “Image_T001” did 
have an XZ slice viewer open, but it was minimized, then it will be left in its minimized state and 
will not be included in the updated synchronization table.

Scrolling through Slices

The large scrollbar at the bottom of the Slice Synchronizer dialog box allows you to move 
through the slices in a manner similar to that of a single optical slice viewer (i.e., the arrows at 
either end move one slice at a time, and multiple slices can be jumped at a time by moving the 
slider about). Additionally, the text box to the left of the scroll bar indicates the “global” position 
of the slider (effectively, this is the position within the slice viewer that has the greatest number of 
slices). 

If the “Auto” button is clicked, the views automatically scroll through their slices. 

Adding Datasets

Datasets will be added to the synchronization table as they are opened in the workspace. When a 
slice viewer oriented to the selected view is opened (e.g., if the XZ view is selected, and a new XZ 
slice viewer is opened), then that dataset will automatically be added to the synchronization table.

Also, minimized slice viewers will not appear in the synchronization table. If a slice viewer in the 
current view is restored from a minimized state, it will be added back to the table.

Removing Datasets

Datasets will be removed from the synchronization table as they are closed in the workspace. 
When a slice viewer oriented to the selected view is closed (e.g., if the XZ view is selected, and 
one of the XZ slice viewers is closed), then that dataset will automatically be removed from the 
synchronization table. In addition, minimizing a slice viewer in the current view will remove it 
from the synchronization table.

Movie Maker

Note: This section applies to users of the AutoVisualize software only.

AutoVisualize allows you to create a movie sequence. To create a movie, a series of frames are 
generated and then displayed in a contiguous manner. A movie sequence consists of a series of 
rotations through a specified range and about a specified axis. The movie generated can be played 
later in AutoVisualize or exported as an AVI file. 

(1) Open the Colorpollenc.tif dataset from the Multi-Channel folder. 

(2) From the Visualization menu select Movie Maker. The 3D Viewer box will appear.
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Note: Images in the 3D Viewer will open in the XY view only.

The Movie menu of the 3D Viewer provides the tools needed to generate a movie. You have two 
options to generate a movie: (1) you may use the Quick Movies option under the Movie menu, 
which allows you to generate a movie “quickly” by spinning the dataset about the X or Y axis by 
predetermined angles (+/- 30, 45, 60, 90 or 180 degrees), or (2) you may generate a movie by set-
ting your own Start Point, Mid Point, End Point, and Step Angles.

For this tutorial we will start with the Quick Movies option.

(3) Within the 3D Viewer box click on the Movie menu and select Quick Movies. Click on 
Rotate Y Axis and select the +/- 60 Degree option. This will generate a movie that rotates about 
the Y-axis by +/- 60 degrees in the Rock mode. To stop the Movie at any time, click on the Movie 
menu again and select Stop Movie. To play the movie again you may click on Play Movie from 
the Movie menu. 

(4) You may play the movie in Loop mode by selecting the Loop mode option under the 
Movie menu and then choosing Play Movie. If you wish at any time to play the movie backwards 
you may do so by selecting Opposite Path from the Movie menu.

(5) Restore your original view by first stopping the movie and then selecting Original View 
from the Quick Movies options.

To generate a movie by selecting your own Start Point, End Point, and Step Angle do the follow-
ing:

(1) Choose your Start Point by either starting with the original view or by rotating your 
dataset with your mouse to a position that you want the movie to start from. From the Movie 
menu select Start Point.

(2) Now using your mouse rotate the view to a position that you want as the end point for the 
movie. From the Movie menu select End Point. 

(3) Select a Step Angle from the available options under the Set Step Angle option from the 
Movie menu.

(4) Click on Play Movie. The movie will play in the direction in which you selected your Start 
Point and then the End Point.

(5) Again, you may play the movie in Loop mode, Rock mode, and in the Opposite direction. 

Note: You may also select a Mid Point when generating a movie. To do so rotate the view to a 
position that you want as the Mid Point. From the Movie menu select Set Mid Point.
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The last option under the Movie menu is Create Movie. This feature opens an untitled movie file, 
which may be saved. It provides all the options to Play the movie, Stop the movie, Rock mode 
Play, and Loop mode Play. 

Close all views before continuing on to the next section.

Time-Series Movie Maker

This feature generates a movie from fixed-angle projections of a volume over time. You need to 
select the datasets that comprise the time series, the angle at which to produce the projections, and 
the projection to produce.
 
From the Visualization menu select Time-Series Movie Maker. The Time-Lapse Movie Generator 
dialog box will appear.
March, 2004                     Page 173



AutoQuant Imaging, Inc.                   Manual and Tutorials
When this dialog box is first opened, the table will be empty. Datasets may be added via the Add 
Frames button. Datasets may be removed by highlighting one or more entries in the table, and 
clicking Remove Selected Frame(s).  The Add Frames button will be disabled once frames have 
been added, and the Remove Selected Frame(s) button will be disabled when the table is empty.

Adding Datasets

Clicking the Add Frames button will open the Import Time-Lapse Data dialog box.

In this dialog box, you may choose to import either a single channel grayscale image, or a multi-
channel color image consisting of up to three channels.

When Multiple is selected in the Channels to Import frame, you may choose which channels to 
enable or disable. In the Importing Data frame, for each channel enabled, you will need to specify 
a sequence of files to import. If multiple channels are to be imported, you would first select the 
radio button for the channel of interest (Red, Green, Blue), and then click the Browse… button to 
choose the files.

If Single or Composite is selected in the Channels to Import group, then the checkboxes relating 
to individual channels will not be displayed.

Clicking the Browse… button will open a standard File Open dialog. Browse to the Time Lapse 
folder in the tutorial folder. Select Image_T001_S001_Z001_CO1.tif. The Select Pattern dialog 
will appear asking for the location of the time sequence number. Select the file where # comes 
directly after Image_T.
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Once a time-lapse dataset has been loaded, the Import Time-Lapse Data dialog will provide infor-
mation about the time series that has been loaded. Specifically, it will contain the following infor-
mation:

• Slices per Time Point: the number of optical slices in each volume that 
makes up the time series.

• Total Time Points: the number of time points that comprise the time series.
• Channels Loaded: which channels of (R, G, B) have been imported. If a 

single-channel set was loaded the channel selection will not be displayed.

Movie Parameters

Choose Frame Range
You may choose a range of time points to include in the time-lapse movie using the Choose Frame 
Range frame in the Movie Parameters section. Here, you can choose the first time point (Start 
Frame) to include, the last time point (End Frame) to include, and the time step interval (Include 
Every) to use (e.g., include every 3rd frame in the time-lapse movie). Images that fall outside of 
the range will be ignored during the movie preview and generation. The time step interval will be 
hidden until you select the Frame Range option. Additionally, when Frame Range is selected, you 
can also set the save interval in the Include every ‘x’ Frame(s) section. Selecting 2 will save every 
second frame, selecting 3 will save every third frame and so on.
Rotating Morph
You may select an option for your movie to simply rotate through the chosen time point (select 
option None), to move through each time point while rotating (select option Full Rotation/Movie), 
or to rotate through one time point at a time, completing the prescribed rotation for each time-
point in succession (select option Full Rotation/Time Point). When the Full Rotation/Time Point 
option is selected, the Rock option becomes available. This option “rocks” the movie back and 
forth from the beginning to the end, and back to the beginning before moving on to the next time 
point.

Time Stamp Format

This section allows you to set up how the time stamp will be displayed on the movie (or to select 
to not have it displayed at all). Next to each radio button is shown the template for how that option 
will be displayed on the movie.

Caption

This section allows you to enter a caption to be displayed on each frame. To enter a caption, you 
must first select the frame for the caption to be displayed on (do this in the Selected Frame text 
box in the Preview Data section of the dialog). Enter the desired text into the Caption textbox. Do 
this for each frame you wish to enter a caption for.
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Setting up a Movie

The Setup Movie group includes the controls and options needed to interact with the 3D Viewer 
to prepare a time-lapse movie.

View Selected Frame
Click the View Selected Frame button, the dataset selected in the table in the Choose Data group 
will be loaded into the 3D Viewer. If multiple datasets are selected, the lowest frame number will 
be displayed.
If, when this button is clicked, the 3D Viewer window is not open, it will be opened with the 
selected dataset loaded. If the 3D Viewer is open, then it will simply be updated to display the cur-
rent volume selection. The number of the frame being displayed in the 3D Viewer will be dis-
played in the box labeled Selected Frame. 

Normalize Frame Intensities
When selected, this will normalize the intensities across all frames of the time-lapse movie with 
respect to the global maximum and minimum values across all frames. When unchecked, the 
intensities will remain as captured from the 3D Viewer.

Generating the Time-Lapse Movie

When you are satisfied with the selections made for the Movie Parameters you can either click the 
Preview button or the Generate button. If you click the Preview button, then each frame that is to 
be included in the movie will be displayed in the 3D Viewer, one after the other – appearing the 
same as it would in the finalized movie. However, the frames that are shown will not be stored to 
disk.

When the preview finishes running the movie, the view will be returned to the first frame of the 
movie (which is not necessarily the view you had loaded at the time you clicked the Preview 
Movie button).

Clicking the Generate Movie button has the same effect as clicking the Preview button, but will 
also store the movie to disk as it is generated. When all frames have been generated and stored, a 
new Untitled movie view that displays the time-lapse movie that has been generated will be 
displayed. As with existing movie views, you may then save the Untitled movie to a supported 
movie format. Clicking the Cancel button will end the movie generation process, and will revert 
the view to the first frame of the movie (without the new movie view being generated).

Concatenate Movies

(1) From the File menu, select Open Movie.

(2) Navigate to the Movies folder, and open Colrpollenrs.avm.

(3) From the Visualization menu select Concatenate Movies.
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(4) The Concatenate Movies box will appear. Click the Add a Movie button and navigate to 
the directory where the movie files are stored. Select the first movie to be added in the concatena-
tion, Colrpollenrs.avm, and click the Open button. The movie will be placed first in the Movie 
List. 

(5) Click the Add a Movie button again and select the Hip.avm to be opened. Once the Open 
button is clicked, AutoVisualize will add the SmHip.avm to the Movie List in the second place. If 
you make a mistake in selecting a movie, the movie may be easily removed by selecting the 
movie and clicking the Remove button. AutoVisualize will remove the highlighted movie from 
the Movie List. For now, leave both movies in the Movie List.

(6) Click the OK button and AutoVisualize will generate a new movie comprised of the Colr-
pollenrs.avm and the SmHip.avm movies. This concatenated movie can then be saved and concat-
enated again with another movie if desired.

(7) Click the Loop Mode button on the Movie player bar and then click the Play button. Auto-
Visualize will display the frames of the movies in a continuous Loop pattern. 

(8) Click Stop. 

Change Frame Delay

This feature allows you to set the time length each Frame (or Slice) is displayed. This feature 
becomes selectable when a Movie file (*.avm or *.avi) or a Slice Viewer is the active view.

(1) Make active the Colrpollenrs.avm movie.

(2) From the Visualization menu select Change Frame Delay. The Change Frame Delay box 
will appear. Type in the desired length of time you would like each frame displayed. The time is 
measured in milliseconds (ms). 

(3) Click Continue. This applies the Frame Delay change to the Colrpollenrs.avm movie.

Please close all movies before continuing on to the next tutorial.
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Tutorials for Analysis Menu Options

FRET

Note: This feature is only available as an added plug-in. Contact your dealer for purchase infor-
mation.

This function allows for the elimination of Cross Talk, so FRET can be accurately calculated. 
This feature is predominantly useful for studying protein-protein interactions with sensitized 
emission FRET techniques.

Correct FRET Cross Talk

Algorithms
In the Algorithm section, there are three algorithms from which to choose. There is Elangovan 
and Periasamy, Gordon and Herman, and AutoQuant Imaging, Inc. which is our own proprietary 
algorithm. For more information on the differences between the algorithms, go to www.aqi.com 
and download the FRET Application Note from the Support section. Select the desired algorithm 
by clicking on its radio button.
FRET Images and Calibration Images
This section makes associations between the images and excitation/emission/specimen set. To 
optimize the use of the FRET feature, the proper datasets must first be obtained. Below is a list of 
headings, and the images they correspond to that will allow for optimal use of the FRET feature 
(when naming your datasets, make sure you know which one corresponds to which excitation/
emission/specimen set):

Headings and Corresponding Datasets
DDf - Donor excitation and Donor emission applied to the FRET specimen
DAf - Donor excitation and Acceptor emission applied to the FRET specimen
AAf - Acceptor excitation and Acceptor emission applied to the FRET specimen
DDd - Donor excitation and Donor emission applied to the Donor specimen
DAd - Donor excitation and Acceptor emission applied to the Donor specimen
*AAd - Acceptor excitation and Acceptor emission applied to the Donor specimen
*DDa - Donor excitation and Donor emission applied to the Acceptor specimen
DAa - Donor excitation and Acceptor emission applied to the Acceptor specimen
AAa - Acceptor excitation and Acceptor emission applied to the Acceptor specimen
*Not necessary, but can be used with the Gordon and Herman and AutoQuant Imaging 
Inc. algorithms.

If it is not possible to obtain the calibration images (DDd, DAd, AAd, DDa, DAa, and AAa) the 
Cross Talk Coefficients tab can be used to estimate the Cross Talk. See the Use Cross Talk Coeffi-
cients Tutorial for more information on this.
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PreProcessing
Use Automatic Alignment
Checking this box will align the channels using the Channel to Channel Alignment feature, using 
its default settings. For more information on the Channel to Channel Alignment, see page 124.
Subtract Background
This section allows the user to choose from three options regarding the Subtract Background 
algorithm: None, Minimum Value, and Histogram Peak. Selecting None will perform no back-
ground subtraction on the datasets. Selecting Minimum Value will subtract the background by 
eliminating the minimum value present in the dataset. Selecting Histogram Peak will subtract the 
background based on the most commonly occurring intensity level. There are other options which 
can be performed on images individually available from the PreProcessing menu, under the Data 
Correction option. For more information on these, see page 129. The Subtract Background feature 
should be used to clean up images that have background noise. Doing so will allow for more accu-
rate results with the FRET algorithms.

Specified Cross Talk
Donor Only, Acceptor Only, Donor and Acceptor
This section allows you to select which datasets to correct for cross talk. Typically, if both donor 
and acceptor calibration images are available, it is best to select Donor and Acceptor. However, if 
only one or the other set of calibration images are available, for instance, only the donor calibra-
tion images, then select that set to correct, in this instance, select Donor Only.
Intensity Range Factor
This divides the intensities into whatever number of sets is selected (e.g., if the number 10 is cho-
sen, then the intensities will be processed in 10 evenly distributed sets). The recommended range 
is between 5 and 20. This number can either be typed into the text box, or scrolled to using the up 
and down arrows next to the text box.
Note-This is only available when using the Elangovan and Periasamy algorithm.
FRET Conversion Factor G
This is the relationship between the loss of donor signal due to FRET with the Donor filter set 
(DD) and the increase in acceptable signal due to FRET with the FRET filter (DA) set.
Note-This is only available when using the Elangovan and Periasamy or Gordon and Herman 
algorithm.
Acceptor Quantum Yield Qa
The AutoQuant Imaging, Inc. algorithm requires the Acceptor Quantum Yield (Qa) which is the 
ratio between the number of fluorescence photons emitted and the number of photons absorbed. 
This feature is only active when the AutoQuant Imaging, Inc. algorithm is selected in the Algo-
rithms section.
Result Name Prefix
This text box allows the user to enter a prefix which will be used in the file name of each resultant 
image created by the experiment.
Use Cross Talk Coefficients
This section allows you to enter cross talk values in lieu of using calibration images. For each 
image (donor and acceptor) there are three values to be filled in. These should be between 0.0 and 
1.0. Ideally, settings should be set between 0.0 and 0.5. Settings of 0.5 and 1.0 are acceptable, but 
not ideal. The only way to verify is to visually inspect the resultant images. For this reason, unless 
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you know what these coefficients are from previous experiments, it is ideal to have calibration 
images.
Calculate
Clicking this button initiates the selected Correct FRET Cross Talk algorithm.
Clear Files
Clicking this button will clear all file associations made in the FRET Images and Use Calibration 
Images sections. There is no undo for this.
Close
This button closes the FRET dialog box. Any files created using the FRET dialog will remain 
open, only the dialog box closes.
Help
This button will launch the Online Help file, opened to the FRET section.

Calculate FRET Efficiency

Once the Cross Talk has been corrected, the analysis of FRET can begin.
Data for FRET Efficiency Estimation
This section allows you to select the images to run statistical analysis on. Do this by clicking on 
the dropdown arrow, then selecting the correct image (based on the heading above the dropdown 
menu). In other words, for the first (top) dropdown menu, select the image that is the corrected 
FRET image (DAf). If you have just run the Correct FRET Cross Talk algorithm, the proper 
images will already be assigned. All three images must be assigned in order to run statistical anal-
ysis on them.
Image ROI
The Image ROI section displays the coordinates of the selected region of interest. Select the 
region of interest by clicking and dragging on the desired image to create a rectangle around the 
desired region. Top Left refers to the top left corner of the rectangle, whereas Bottom Right refers 
to the bottom right corner of the rectangle. For each, the X, Y and Z refers to the axial coordinates 
of the respective corners.
Fixed Threshold
This section has two sliders, which allows you to set the upper and lower percentages of the inten-
sities to be analyzed. Set the intensities by either clicking on the pointer and dragging it to the 
desired location, or by clicking on the desired location to incrementally move the pointer to that 
spot, or by entering the desired intensity in the text box.
Dye Pair’s Foster Distance R0
This section is where you can enter the dye pair used in the images. This will allow for a calcula-
tion of the actual Fοrster’s distance when calculating the FRET efficiency. Select the proper dye 
pair from the dropdown list by clicking on the dropdown arrow, or if the distance is known, yet 
not displayed in the dropdown menu, it can be entered into the textbox manually.
ROI
Add
This button calculates the efficiencies for a selected region of interest for the active image set.
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Delete
This button removes an already processed region of interest, removes it from the table and erases 
all of the efficiencies calculated for it. Highlight the desired ROI(s) to be removed, then click 
Delete.
Save Statistics
This button will save the data into a text file, which can then be copied and pasted into an Excel 
spreadsheet.
Help
This button will open the Online Help file, opened to the section regarding FRET.
Close
This button will close the FRET Analysis dialogue.

Correct FRET Cross Talk Tutorial
(1) Navigate to the FRET folder in the tutorial images. Open Image-AAa, Image-AAf, Image-
DAa, Image-DAd, Image-DAf, Image-DDd, and Image-DDf.

(2) From the Analysis menu, select FRET.

(3) Select the desired algorithm from the Algorithms section.

(4) Associate each excitation/emission/specimen with an opened file by clicking on the 
arrows in the FRET Images section, selecting the file with the Donor excitation and Donor emis-
sion applied to the FRET specimen for the DDf heading, the file with the Donor excitation and 
Acceptor emission applied to the FRET specimen for the DAf heading, and the file with the 
Acceptor excitation and Acceptor emission applied to the FRET specimen with the AAf heading.
Once a set of files has been assigned and processed, the file associations will be saved in the 
header file, and only one file association will need to be made in the FRET Image section, the rest 
will automatically fill in upon clicking the second arrow.

(5) In the Use Calibration Images section, associate the files with the appropriate headings as 
outlined in the preceding list. It is advised that a “region of interest” be drawn in each one of the 
calibration sets. This will speed up the processing. Create the region of interest around the area in 
which FRET is suspected of occurring by clicking and dragging on the image, creating a rectangle 
around the desired area.
If no calibration images are available, proceed to the Use Cross Talk Coefficients section.

(6) Check the Use Automatic Alignment box

(7) From the Subtract Background dropdown menu, select Minimum Value.

(8) Select Donor and Acceptor in the Specified Cross Talk box.

(9) Enter tutorialset1 for the Result Name Prefix.

(10) Click the Calculate button. Three new images will open, all with the prefix tutorialset1.
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Use Cross Talk Coefficients Tutorial

With the Gordon and Herman as well as the AutoQuant Imaging, Inc. algorithms, there is an 
option to enter the Cross Talk Coefficients rather than loading calibration images. It is still highly 
recommended that calibration images be used, however, the Use Cross Talk Coefficients tab 
exists for when these images are not available.

(1) Select Gordon and Herman from the Algorithms section.

(2) Click on the Use Cross Talk Coefficients tab on the right side of the FRET Analysis dialog 
box.

(3) Enter the estimated Cross Talk Coefficients for each of the 6 entries on the tab.

(4) Enter the FRET Conversion Factor G into the text box. If this value is not known, the 
default setting of 1 can be used, or an estimation between 0 and 1 can be entered.
G is defined as the ratio of acceptor that is excited due to FRET versus the donor that is quenched 
due to FRET.

(5) Click Apply. The application will create 3 new files with the results.
Note- If there are already results files opened, clicking the Apply button will update those files 
automatically, it will not create new files. To create new files, click the Calculate button.

(6) Changes can be made to the Cross Talk Coefficients settings. Once the changes have been 
made, to create new files, click the Calculate button, to update the existing files, click the Apply 
button.

Calculate FRET Efficiency Tutorial

Once the algorithm has run on the images, and the new files are opened, analyses can be run on 
the images.

(1) In the FRET Analysis dialog box, click on the Calculate FRET Efficiency tab.

(2) In the Data for FRET Efficiency Estimation section, assign the appropriate images to the 
Corrected FRET, Corrected Donor and Corrected Acceptor images by clicking the dropdown 
arrows and selecting the correct image from the list.

(3) Select a region of interest to process by clicking and dragging on one of the images around 
the area to be analyzed, creating a rectangle around it, then releasing the mouse button.

(4) Select a percentage range of intensities to analyze by adjusting the Fixed Threshold sliders 
to the desired percentages. The minimum must be lower than the maximum.
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(5) Select the dye pair used in the images in the Dye Pair’s Foster Distance R0 section by 
clicking on the dropdown arrow and selecting the appropriate pair from the list.
Note - If the dye pair that was used in the images is not listed, but you know the Forster’s distance, 
you can enter that distance in the text box as well.

(6) Click Add. The efficiencies will be calculated and displayed in the table in the dialogue 
box.

(7) Close all images before moving on to the next section.

Ratiometrics

Note: This feature is only available as an added plug-in. Contact your dealer for purchase infor-
mation.

This function allows you to observe changes in the sample environment such as changes in Cal-
cium concentration or changes in pH.

Images

In this section, the images to be analyzed are assigned to either the numerator or the denominator. 
The feature will perform an image division, and as such, the image assigned to the numerator will 
be divided by the image assigned to the denominator.

PreProcessing

Use Automatic Alignment
Checking this box will align the channels using the Channel to Channel Alignment feature, using 
its default settings. For more information on the Channel to Channel Alignment, see page 124.
Maximum/Minimum Thresholding
This section has two sliders, which allow you to set the upper and lower percentages of the inten-
sities to be analyzed. Set the intensities by either clicking on the pointer and dragging it to the 
desired location, or by clicking on the desired location to incrementally move the pointer to that 
spot, or by entering the desired intensity in the text box.

Use Grynkiewicz Equation for Ion Concentration

Select this option if you are measuring the effects of changes in calcium concentrations in your 
sample. To get the best results out of this equation, a calibration set of images should be taken. 
This set should consist of four images: two each at two separate wavelengths; one with no cal-
cium, and the other saturated with calcium. Once a calibration has been performed, the values can 
be entered into the textboxes manually in later analyses.
Rmax
This is the ratio of the two wavelengths for the calcium saturated specimen.
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Rmin
This is the ratio of the two wavelengths for the calcium free specimen.
B(Sl2/Sh2)
This is the ratio between the calcium free and calcium saturated specimens.
Calibrate
If the above mentioned set of calibration images are open, click on the Calibrate button to assign 
these files to the proper setting.
Numerator Wavelength
Assign the images associated with the numerator wavelength to this section. The calcium free 
sample needs to be assigned to the Low Ion image, and the saturated calcium sample needs to be 
assigned to the High Ion image.
Denominator Wavelength
Assign the images associated with the denominator wavelength to this section. The calcium free 
sample needs to be assigned to the Low Ion image, and the saturated calcium sample needs to be 
assigned to the High Ion image.
OK
This button will calibrate the images, to fill in the necessary parameters in order to use the Ratio-
metrics feature.
Browse
These buttons , located to the right of each image textbox, will open a Windows Explorer 
browser from which you can navigate to, and click and drag files into the AutoDeblur/AutoVisu-
alize workspace.
Cancel
Clicking this button will cancel the calibration process and close the Calibration Images dialog.
Help
Clicking this button will open the Online Help file, opened to the topic relating to the Calibration 
dialog.
Kd
This is the affinity of a fluorescent dye to calcium. Different dyes have a different affinity. Below 
is a table listing the most popular dyes used in measuring intracellular concentration:

Table 1: Kd

Dye Kd for Ca++ 

Fura-2 224 nM

Quin-2 115 nM

Indo-1 250 nM

Ca-Green 190 nM
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Viscosity
This is the Viscosity factor, which is the effect that the viscosity will have on the spectra of the 
dyes. Viscosity is defined as the measure of the resistance to flow that a fluid exerts. If the viscos-
ity factor is not known, it is recommended that 0.7-0.85 be entered into this field.

PostProcessing

This section allows you to clean up noisy images during processing. This will result in a much 
more accurate analyses of the datasets.
Remove Spot Noise
This option lets the user remove “spot noise” caused by a few bright pixels that may be generated 
during the ratio process.
Gaussian Smoothing
This feature removes noise by using a Gaussian filter, thus creating a more accurate image.
Calculate
Clicking this button will run the Ratiometrics process, and create a new image.
Statistics
Clicking this button will open a statistics window, displaying a histogram and statistics of the 
intensities. For more information on the Statistics window, see page 200.
Close
This button will close the Ratiometrics dialog.
Help
This button will open the Online Help, opened to the Ratiometrics topic.
Ratiometrics Tutorial
(1) Navigate to the Ratiometrics folder, then open HighCa1.001, HighCa2.001, LowCa1.001, 
and LowCa2.001. For each file, it will ask which pattern denotes the slice number; select the pat-
tern in which the pound sign (#) falls at the end of the filename.

(2) From the Analysis menu, select Ratiometrics.

(3) Click on the Use Grynkiewicz Equation for Ion Concentration box.

(4) Click on the Calibrate button.

(5) For the Numerator Wavelength section, assign the LowCa1.001 and HighCa1.001 images 
to the Low Ion and High Ion images, respectively. For the Denominator Wavelength section, 
assign the LowCa1.002 and HighCa2.001 images to the Low Ion and High Ion images, respec-
tively. Click the OK button. This will populate the Calibration Parameters frame in the Ratiomet-
rics dialog.

(6) Go to File, then Open, and navigate to the Ratiometrics folder, then the Calibration folder, 
and open B1LT1.001 and B1LT2.001. For each file, it will ask which pattern denotes the slice 
number; select the pattern in which the pound sign (#) falls at the end of the filename.
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(7) Assign B1LT1.001 to the Numerator and assign B1LT2.001 to the Denominator in the 
Images frame of the Ratiometrics dialog.

(8) Verify that the Remove Spot Noise feature has been checked. Click Calculate. A new 
image will appear. This is the result of the ratio.

(9) Click the Analysis button in the Ratiometrics dialog to display the statistical information 
on the new image.

(10) Close all images before moving on to the next section.

Colocalization

Note: This feature is only available as an added plug-in. Contact your dealer for purchase infor-
mation.

This function displays and analyzes the overlay of two separate dyes in a multi-channel dataset. 
To use Colocalization, a multi-channel dataset must first be opened.

Image 1/Image 2

In the Image 1 and Image 2 sections, the channels to be analyzed are selected and assigned a color 
in which to be displayed. All available datasets will appear on the dropdown menus, so make sure 
that the channels selected are the same dimensions. If 2 channels with different dimensions are 
loaded into these dropdown menus, an error message will appear stating The dimensions of this 
image are different from the other image. Do you want to change to this new image for colocaliza-
tion analysis? Selecting Yes will load the new image, and clear the other image, at which point a 
second channel will have to be selected. Selecting No will not load the new channel, and the chan-
nel loaded for the other image will remain loaded.

Next to each image dropdown menu is a dropdown menu with a color selector. The channel 
selected in this dropdown menu will determine how the channel is displayed in the Coloc Viewer. 
The options are Red, Green and Blue. Once a color is selected for one channel, that color will not 
be available on the dropdown menu for the other channel.

Coloc Viewer

Tools
This section contains tools to manipulate the Colocalization image in the dialog.

•  The zoom controls will zoom the image in and out. The button on the left 
enlarges the image, and the button on the right decreases its size. Holding either of these but-
tons down will continue to either increase or decrease the image’s size, depending on which 
button is being pressed. The dropdown menu displays the image size, relative to its original 
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size as a percentage. Alternatively, it is possible to either select a predetermined percentage 
from the dropdown menu, or manually enter a percentage into the textbox.

•  The crop buttons allow the user to draw a region of interest in the 
colocalization image in the dialog. For more information on how to use crop tools, see page 
108.

The image on the left side of the dialog displays the two selected channels (in the colors selected) 
and shows the colocalized areas in white. If the image has been enlarged such that it no longer fits 
in the allotted space, scroll bars will appear on the bottom and right to allow the user to scroll to 
all areas of the image.
Directly below the Coloc Viewer, are the controls to display and move the Coloc Viewer through 
the slices, or display all of the slices.
Checking the All Slices checkbox above the scroll bar will display all slices, and the scroll bar and 
textbox will become inactive. To reactivate the scroll bar and textbox, uncheck the All Slices 
checkbox.
The textbox on the left side of the scroll bar displays the slice number being displayed in the 
Coloc Viewer. A user can also enter a desired slice number into the textbox, and that slice will 
then be displayed.
The scroll bar can be used to move through the slices sequentially by clicking on the pointer and 
dragging it from side to side. The slice number in the text box will update when the scroll bar 
stops moving.

2D Histogram

The 2D Histogram displays the intensity distribution for the two channels. The brighter an area is, 
the higher the occurrence of that intensity. The left side of the graph represents Image 1 and the 
bottom represents Image 2. Within the histogram are two lines forming an angle, with boxes at the 
ends of them, which act as sliders. These lines create an intensity mask. Only the intensities that 
fall between the two lines will be displayed. The top line controls the displayed intensities for 
Image 2 in the Coloc Viewer. The bottom line controls the displayed intensities for Image 1 in the 
Coloc Viewer. To move the sliders, place the cursor over the slider (box) and the cursor will turn 
into a hand. Left click on the slider, then move either up and down, or left to right.
Color Map
The Color Map selection changes the color map of the 2D Histogram. The options available are 
Hot and Cool.

Intensity Range

The Intensity Range frame displays the intensity ranges of each image. This frame is not editable.

ROI

The ROI frame contains the controls and statistics for the Region of Interest in the Coloc Viewer. 
To add an ROI, use one of the crop tools mentioned in the Crop Tools section.
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Along the top of the ROI frame are the statistics that are gathered on the ROIs.
The first ROI listed is always the Active ROI. If no ROI has been drawn, then the Active ROI will 
be the entire Coloc Viewer.
Add
Clicking this button will add an ROI that has been drawn using the crop tools to the statistics 
table.
Delete
The Delete button will delete the selected ROI(s). Multiple ROIs can be selected by either click-
ing on the first and last ROIs to be deleted while holding the shift button, or clicking and dragging 
from the first to the last ROI to be deleted.
Save Statistics
Clicking the Save Statistics button will save the statistics as a .txt file. A Save As browser will 
appear, in which the user can navigate to the desired directory and name the file. Clicking Save 
will complete the save.

Generate Coloc Image

Clicking this button will generate the image showing the colocalized areas based on the intensity 
ranges set up in the 2D Histogram. This new image can be saved as an independent file.

Close

Clicking this button will close the Colocalization dialog box.

Help

Clicking this button will bring up the Online Help menu, opened to the section on Colocalization.

(1) From the File menu option, select open and navigate to the Multi-Channel folder. Open 
colorpollenc.tif.

(2) From the Analysis menu at the top of the screen, select Colocalization.

(3) For Image 1, select colorpollenc.tif (Channel 1), with Red selected as the color next to it, 
and for Image 2, select colorpollenc.tif (Channel 2), with Green selected as the color next to it.

(4) Move the maximum and minimum intensities for both images. Notice how the colocalized 
areas change in the Coloc Viewer.

(5) Now move the Slice scroll bar back and forth. Notice how the Coloc Viewer changes as 
the slices change. Now click the All checkbox. All slices will now be displayed, as well as the 
colocalization in all of the slices.
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(6) Click on the Coloc Viewer inside the image, and drag out a rectangle, creating an ROI. 
Click Add. The statistics for the selected ROI will be loaded into the statistics window. Create 
another ROI and click Add to load it into the statistics window.

(7) Click Save Statistics. Name the file statistics1.txt and click Save.

(8) Highlight the first ROI by clicking on it, then click the Delete button.

(9) Click Generate Coloc Image. A new image will open, displaying the colocalized areas. 
Open the Slice Viewer from the new image. Scroll through the slices, noticing how the colocal-
ized areas change.

(10) Close all images before moving on to the next section.

Image Algebra

Note: This section applies to users of AutoVisualize only.

This function allows various mathematical operations to be calculated using two volumes. The 
volumes must be in the AutoVisualize file type, and must have the same dimensions. The avail-
able Image Operations are: Addition, Subtraction, Multiplication, Division, AND, OR, and XOR. 
If Subtraction is selected, the Second Image will be subtracted from the First Image. If Division is 
selected the First Image will be divided by the Second Image. The two original files will remain 
intact, and a new data file will be created with the processed results. To use the AND, OR and 
XOR one of the datasets must be optically sliced (in a Slice Viewer projection), in the XY view 
and segmented. 

(1) Navigate to the Widefield directory and open the Pollen.deb dataset. Generate an XZ Max 
projection. 

(2) From the Widefield directory open the PollenPlus5.deb dataset.

(3) From the Analysis menu select Image Algebra. When the Image Algebra box appears 
make PollenPlus5.deb the First Image and Pollen.deb the Second Image. The Scale for both the 
First and Second Image will be left at 1. This is the default value. The Constant Value field will be 
inactive.

Note: To add a Constant Value to an Image, select None for the Second Image and enter a number 
in the Constant Value field. The Constant Value is for intensity offset. Every pixel’s intensity will 
be either decreased (by entering a negative number) or increased (by entering a positive number) 
by the Constant Value number. 

(4) Select Subtraction from the Operation drop-down menu, and click Calculate.

AutoVisualize will subtract the Pollen.deb dataset from the PollenPlus5.deb dataset, creating a 
new file. 
March, 2004                     Page 189



AutoQuant Imaging, Inc.                   Manual and Tutorials
(5) The resultant dataset, Untitled#.avz, may now be saved as PollenPlus4.deb.

(6) Please close all views before going on to the next section.

Segmentation

Note: This section applies to users of AutoVisualize only.

Segmentation is a method by which a region of interest within a dataset is identified for a subse-
quent operation, such as: measurements of surface areas, volumes, or intensity statistics. 

The Segmentation function allows you to specify a criterion by which certain pixels from your 
original dataset are selected as a region of interest and represented as a binary file. There are two 
methods of segmentation, Automatic and Manual. Automatic Segmentation utilizes one of two 
methods, Fixed Threshold or Adaptive Threshold to select specific pixels of the dataset. Manual 
segmentation utilizes labeling techniques to select specific pixels of the dataset.

Automatic Segmentation

(1) From the Multi-Channel folder open the TobaMC.tif dataset.  A dialog box will appear 
with the question “The program has detected properties that indicate this dataset MAY contain an 
old AutoQuant Proprietary Multi-channel TIFF. Is this true? ....” Select Yes.

(2) From the Analysis menu, select Segmentation and choose Automatic Segmentation. The 
Segmentation Parameters box will appear.

Note: When selecting Automatic Segmentation from the Analysis menu you will notice that all of 
the Labeling functions are inactive. This is because as will be explained in the next section, in 
order to use Manual Segmentation, a dataset must be in an XY Slice Viewer projection.
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The two methods for Automatically segmenting a dataset are: the Fixed Threshold and the Adap-
tive Threshold methods. The Fixed Threshold, which is the default, allows you to specify the 
lower and upper boundaries of the threshold, that is, the Minimum and Maximum Threshold val-
ues. The pixels that fall within these boundaries retain their value and are turned white; all other 
pixels are blackened out. The Adaptive Threshold compares a pixel with its neighboring pixels 
and selects those which are above a specified value and are turned white; all other pixels are 
blackened out. In both cases the end result is a binary (black and white) image.

(3) Leave the default, Fixed Threshold, as active.

(4) Adjust the Minimum and Maximum Threshold Values by either sliding the scroll bars or 
by typing in a value in the corresponding text box. 

(5) Click on the Apply to All Slices button. Observe the segmented image. 

Note: The Apply to All Slices option is active with 2D Projections of the image. The Apply to All 
Slices and the Apply to Current Slice options are both active when the dataset is in a Slice Viewer 
projection.
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(6) You may change the Threshold value again. The check next to the Change Threshold 
Parameters indicates that you may do this. Clearing the check next to Change Threshold Parame-
ters locks the threshold values.

(7) To view the original image at any time click the Press and Hold to view the Original 
Image button. This allows you to view the original image momentarily while you are clicking the 
button. Releasing it brings back the segmented image.

(8) To return to the original image click the Restore button.

Note: When your dataset has uneven illumination or an irregular background the Fixed Thresh-
old method is not suitable. Use the Adaptive method in these cases.

Note: Do not close TobaMC.tif: Max Projection. Please continue on to the next section.

Manual Segmentation

In order to segment a dataset manually, the image must be in an XY orientation and in a Slice 
Viewer projection. The labelling features for performing a manual segmentation are Apply Label, 
Apply Seed Fill Label, Undo Label, Highlight Labels, Combine Labels, Remove Label, Combine 
Label with Automatic Segmentation, Load Labels and Save Labels.

Apply Label

This function will Label a selected region within your dataset. 

(1) If the TobaMC.tif: Max Projection is not open from the previous section, navigate to the 
Multi-Channel folder and open the TobaMC.tif dataset.  A dialog box will appear with the 
question “The program has detected properties that indicate this dataset MAY contain an old 
AutoQuant Proprietary Multi-channel TIFF. Is this true? ....” Select Yes.

(2) Create a Slice Viewer of the dataset. Scroll to slice 22, and select a region of interest simi-
lar to the one shown below using the Select Region Ellipse tool. 
 

March, 2004                     Page 192



AutoQuant Imaging, Inc.                   Manual and Tutorials
Note: The Select Region tools are as follows: Rectangle, Ellipse, Polygon, and Freehand. You 
may select from any of these when you want to label regions of interest in a dataset. 

(3) Under the Analysis menu select Segmentation and click on Apply Label. The Label 
Object dialog box will appear. Select Apply to given slice range and set the “From slice” to 17 and 
set the “to slice” to 32.

(4) Leave the default names of New:1 for the “Label As” and the “Category” fields. Click on 
the Apply button. AutoVisualize will apply the New:1 label to the region of interest on slices 17 
through 32.

(5) Click on the Slice Viewer and draw out an ellipsoid region in the lower right-hand corner 
of the image. Make sure this region does not touch the previously selected region. Again, in the 
Label Object box, select Apply to given slice range and set the “From slice” to 1 and set the “to 
slice” to 16.

(6) Verify that the name of the new label is New:2 for the “Label As” (change if necessary) 
and the “Category” fields. Click on the Apply button. AutoVisualize will apply the New:2 label to 
the region of interest on slices 1 through 16.

(7) Scroll through all the slices in the Slice Viewer to view the two Labels that were applied. 

Note: You may also choose to apply a label to all the slices in the stack by selecting the Apply to 
all slices button. 

(8) Close the Label Object box. 

Note: Do not close the TobaMC.tif: XY Slice Viewer. Please continue on to the next section.

Apply Seed Fill Label

This function allows you to do automatic labelling to a single channel of a dataset as well as a 
grayscale image.

(1) Select Green Channel from the View Menu. Select Apply Seed Fill Label from the Seg-
mentation menu under the Analysis menu. The Segmentation Parameters box will appear.

(2) Set the Minimum Threshold Value (%) to 30 and click the Apply to All Slices button. The 
dataset will be automatically segmented.

(3) Move your cursor over a white region of the segmented dataset. The cursor will become a 
crosshair. Click your left mouse button to select that region for Seed Fill (automatic labelling). 
The Label Object box will appear. Click on the Apply button.
The Seed Fill region will be outlined in blue. 
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(4) Close the Label Object box and the Segmentation Parameters box. 

Note: Do not close the Labeled TobaMC.tif: XY SLICE VIEWER (GREEN) dataset. Please con-
tinue on to the next section.

Undo Label

This feature lets you remove the last Label placed on the dataset or the last set of Labels com-
bined. To utilize this function select Undo Label from the Segmentation menu, and AutoVisualize 
will remove the last placed label on the dataset.

Note: Do not close the Labeled TobaMC.tif: XY SLICE VIEWER (GREEN) dataset. Please con-
tinue on to the next section.

Highlight Labels

This function colors the area within a Label with a pastel overlay. The overlay helps in viewing 
the area within the Label. There are 5 different color overlays that the system will cycle through 
depending on the Label Number. The pastel color overlays appear in the following number order 
1 = Blue, 2 = Magenta, 3 = Green, 4 = Yellow, 5 = Red.

(1) From the Analysis menu select Segmentation and click on Highlight Labels. The High-
light Labels box will appear. Click in the box to the left of the number 1 Label. The Label #1 area 
will show a blue pastel overlay (see section Apply Label if you have closed the dataset from the 
previous section).

(2) Close the TobaMC.tif: XY SLICE VIEWER (GREEN). The Exit box will appear with the 
question “Do you want to save the segment results?” Select No.

Combine Labels

This feature allows you to join two or more overlapping Labels in a dataset. You may choose 
either of the two Label Categories to place the new combination Label in or you may make a com-
pletely new one. In order to combine labels the label edges must be touching.
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To Combine Labels do the following:

Note: Make sure the edges of the separate Labels are touching when you draw the labels out.

For this tutorial we are using the TobaMC.tif: XY SLICE VIEWER (MULTI-CHANNEL) 
dataset.

(1) Scroll to slice #2. Using the Ellipse Select Region tool, draw an Ellipse similar to the one 
shown above in the upper left-hand corner of View #1. From the Segmentation menu select Apply 
Label.   Select the Apply to given slice range and set the slice range from 1 through 18. Click 
Apply.

(2)  Scroll to slice #12. Using the Polygon or Freehand Select Region tool, draw a polygon 
similar to one shown above in View #2. If you use the Polygon Select Region tool, every time you 
would like to change the direction of the line, you must click within the view to anchor the line at 
a pivot point. From the Segmentation menu select Apply Label. Set the Apply to given slice range 
from 8 through 24. Click Apply.

(3) Scroll to slice #24. Using the Rectangle Select Region tool, draw a Rectangle similar to 
the one shown above in the bottom right-hand corner of View #3. From the Segmentation menu 
select Apply Label.   Select the Apply to given slice range and set the slice range from 16 through 
32. Click Apply.

(4) Scroll to slice #16. From the Segmentation menu select Combine Labels. The Label 
Object box will close automatically, and the Combine Labels box will appear. The Combine field 

Object Labeling

                         View # 1                     View # 2                      View # 3
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will usually contain the lower numbered Label, in this case number 1. The With field will contain 
the second Label number. The Category value can be designated by you. The default value for 
Category is 1.

(5) Click OK and AutoVisualize will connect the first two overlapping labels. 

(6) Select Combine Labels again and AutoVisualize will now connect the first combined 
Labels with the third Label (the Rectangle). The Combine Labels dialog box will have the same 
number values as displayed above.

The resulting triple combined Label will appear similar to the view shown below.

Note: In order to observe the combined labels scroll to slice number 16, 17, or 18.

Remove Label

This feature allows you to choose which labels you would like to remove from the dataset. To uti-
lize this function select Remove Label from the Segmentation menu. When the Remove Label 
dialog box appears you can select the Label number(s) of the Label(s) you would like removed. 
Clicking the Remove button will remove the selected Label(s). 

You may close all views before going on to the next section.
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Combine Label with Automatic Segmentation

To utilize the Automatic Segmentation function and the Manual Segmentation function together, 
you must first either manually label the dataset and then choose Automatic Segmentation or vice 
versa. Once both functions have been applied to the dataset, select the Combine Label with Auto-
matic Segment feature, and AutoVisualize will create the new dataset. This dataset will consist of 
voxels with values that are above the Automatic Segmentation Minimum Threshold Value and are 
also contained within the manually labeled regions. 

(1) Open the greenTobaMC.tif dataset from the Multi-Channel folder. Create a Slice Viewer 
of the dataset. Select the Freehand Select Region tool and trace out a shape similar to the one 
shown below. 

(2) From the Segmentation menu select Apply Label and choose Apply to all slices. Click the 
Apply button.

(3) From the Segmentation menu select Automatic Segmentation. The Segmentation Parame-
ters dialog box will appear. Using the Fixed Threshold, set the Minimum Threshold Value to 35% 
and click the Apply to Volume button. The labeled area will appear with a colored outline. You 
may add another label by drawing another region out and clicking Apply in the Label Object box. 
The new label will be outlined in a color different from the previous one. 

(4) Close both the Segmentation Parameters box and the Label Object box.

(5) From the Segmentation menu select Combine Label with Automatic Segmentation. Auto-
Visualize will combine the manually applied Label(s) with the Automatic Segmentation Fixed 
Threshold dataset and display the resulting Combined Label dataset. The resulting dataset is com-
promised of only those manually applied labels that fall within the automatically segmented 
dataset.
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This view shows the areas of the selected region that are above the Automatic Minimum Thresh-
old Value and contained within the manually Labeled area.

Load Labels 

This function allows you to load a previously saved Label file. You must have previously saved 
the Labels as a (*.seg) file. 

(1) To Load labels from backup, you must have the dataset that the Labels file will be loaded 
onto, already open.

(2) From the Segmentation menu select Load Labels, navigate to the directory where you 
have saved your *.seg file. Select the *. seg file and click on the Open button. AutoVisualize will 
display only the Labels from the *.seg file on the dataset.

Note: This operation will remove any previously unsaved labels in the current image.

Save Labels

This feature allows you to save the Labels for a dataset in a *.seg file. This file can then be 
reloaded onto a dataset at a later time. 

(1) From the Segmentation menu select Save Labels. A dialog box will appear prompting you 
for the file name and file location (this is the location where the Label(s) file will be saved). After 
entering a file name (i.e. Triple Label segment) and clicking the Save button the dataset will be 
saved as a *.seg file. This file will be of the same dimensions as the raw image.
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Save Segmentation/Selected Labels

This feature saves the dataset with the Labels as an image in a TIFF file format. If your dataset is 
in a Slice Viewer Projection and you have changed either the gamma, brightness, or flip settings a 
box will appear with the question Save data as shown? Selecting No will discard the gamma, 
brightness and flip adjustments. Selecting Yes will keep the gamma, brightness and flip adjust-
ments. A second box will appear with the question Do you wish to export as multiple files, each 
of a single slice. You may save the Labels as a single TIFF file or as multiple TIFF slices. 

Please close all datasets before going on to the next section.

Measurement 

Line Length

This function allows you to obtain line length measurements from the dataset by drawing lines on 
any view. Open a view you would like to draw lines on. From the Analysis menu select Measure-
ment and click on Line Length. An Intensity Profile Along Line box will appear. Start by select-
ing from the Line Mode options (Straight Line, Piecewise Line, or Freehand Line). Left click the 
mouse within the view and move the cursor. When using the Piecewise Line mode, left clicking 
again will terminate the current line segment and initiate a new one. The Intensity Profile Along 
Line box will show the data properties for the line(s) being drawn. The distance of the line seg-
ment or the entire string of segments (Piecewise Line) are displayed at the bottom of the Intensity 
Profile Along Line box. To stop drawing a line double click the left mouse button. After you have 
stopped drawing lines, you may erase all previously drawn lines by left clicking the mouse button 
within the view.

In the Intensity Profile Along Line box, the Maximum intensity and the Minimum intensity will 
be displayed along with the Line Distance and the Angle. The Intensity Profile is a graphical dis-
play of the intensity values of the voxels in the image that the current line spans.

Note: For multi-channel datasets, the Intensity Profile Along Line will display colored lines (red, 
green, and blue) each of which represents its respective channel color. For example, the red line is 
the relative intensity values with respect to the Max. and Min. intensity of the image’s Red Chan-
nel. The orientation of the intensities is relative to the image, not the start and endpoint of the line. 
When in the Slice Viewer, the Intensity Profile only displays intensities values for a single slice for 
the line being drawn. At the bottom of the Intensity Profile Along Line box the Angle displays the 
angle in degrees between the last line drawn and the current line. This works only in the Piece-
wise Line mode.

To disable the Line Length selection, click on Done or click the Line Length icon on the Toolbar.

Note: The distances displayed will be in microns per pixel. This applies to the angles also.
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Three Dimensional Line Lengths

You may calculate line lengths and the angle between lines in all three dimensions by following 
this procedure: 

(1) The image must be in a Slice Viewer.

(2) Left click and draw the first desired line. Then left click again to start a new line. You may 
then change the current slice by clicking the right or left arrow key on your keyboard, causing the 
line to be drawn through several slices. 

The Intensity Profile Along Line box will display the Line Distance under the histogram display.

If the Slice Viewer for other views (for example XZ, ZY) is displayed, AutoVisualize will auto-
matically draw the current line in the other optical views. This allows you to get a better feel for 
where the line you are drawing actually is located. When drawing the line and cycling through 
slices, the line in the other views will also move.

Note: To measure angles, Piecewise Line must be selected in the Line Mode frame.

Statistics

This function provides you with specific statistical information about a dataset. The Statistical 
Information displayed will be the following: Min. Intensity, Max. Intensity, Total Number of Vox-
els, Sum of Voxel Intensities, Average Intensity, Standard Deviation, Variance, ROI (Region Of 
Interest) area, ROI perimeter, and a Histogram of ROI of Current View. You can obtain statistical 
information about the dataset in any view, except for Montage view and Movie view.

(1) Open the TobaMC.tif dataset from the Multi-Channel folder.

(2) Under the Analysis menu, choose Measurement and select Statistics or click on the Statis-
tics icon. A Statistics dialog box will appear.

The Statistics box displays various Statistics, which have been calculated from the active view. 
The Statistics displayed will depend on what Projection type was chosen, whether the image is in 
a Slice Viewer, or if the image was Segmented. 

If the image is in a Slice Viewer and/or Segmented, in addition to all the statistical information, 
the Statistics dialog box will also allow you to select the Slice Range from which you would like 
to collect your statistics. Your range can be a Single Slice, Multiple Slices or All Slices.

In both cases a Histogram of ROI of Current View is displayed to the left of the Statistical Infor-
mation box. The grayscale values (the intensity values) are displayed as a percentage along the X 
axis. Above the histogram is the Select Channel box for colored datasets. This feature is not visi-
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ble for grayscale datasets. For a color dataset you may view the statistics for any of its Channels 
or All Channels by selecting the appropriate option from the Select Channel list box.
Three-Dimensional Statistics
Three-dimensional statistics may be calculated when an image is in a Slice Viewer projection.
To calculate three-dimensional statistics, click on the Multiple Slices button or the All Slices but-
ton. When the Multiple Slices button is clicked, a Calculate 3D Statistics dialog box will appear 
prompting you to specify the Starting Slice number and the End Slice number from which the sta-
tistics are to be calculated. Clicking on the All Slices button will preempt entering the range of 
slices, and all the Optical Slices will be used. AutoVisualize will then perform the calculations on 
the selected volume. Selecting Single Slice will cause AutoVisualize to analyze the displayed 
slice (two-dimensional) only.

Please close all views before going on to the next section.

Surface Area and Volume

This feature allows you to measure the Surface Area and Volume of the selected image. The view 
of the image must be in the XY projection, in a Slice Viewer, and be Segmented.

(1) Open the Pollen.deb dataset from the Widefield folder. Create a Slice Viewer Projection.

(2) Automatically segment the dataset using a Min. Threshold value of 75%.

(3) From the Analysis menu select Measurement and click on Surface Area and Volume.
The Measurements box will appear showing the Volume and Surface Area calculations.

(4) If you would like to keep your measurements for future work, you may save them as a text 
file. Click on the Save as Text File button and the Export Measurement box will appear. 
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Object Counting/Tracking

Note: This feature is only available as an added plug-in. Contact your dealer for purchase infor-
mation.

Note: It is imperative that the image information is correct in order to get accurate statistics/mea-
surements.
The Object Counting/Tracking mode allows the user to segment, count, and track up to eight 
classes of objects, and countless individual objects within each class, as well as calculate statistics 
on their physical properties and movements. The Object Counting/Tracking feature can be 
accessed from the Analysis menu option on the main menu. A dataset need not be opened to 
launch the Object Counting/Tracking, as it can be opened from the Object Counting/Tracking 
module.
If a dataset is already opened and Object Counting/Tracking is selected from the Analysis menu, 
there will be an option to Use all images open on desktop, Use active image open on desktop, and 
Load new volume/time series. When selecting Use all images open on desktop, make sure that all 
of the images have the same dimensions, otherwise, it will compromise the application’s ability to 
properly count and track the objects.

Automatic Segmentation and Counting

The Automatic Segmentation and Counting button will perform automatic segmentation and 
counting on the opened dataset, on all opened volumes. Using this option will not allow for multi-
ple object class definitions.

Segment

The Segment Frame contains the controls used to segment the dataset. The dataset must be seg-
mented before it can be counted.
Current Volume
The Current Volume button will segment the current volume, based on the most recently applied 
segmentation settings. If no segmentation parameters have been applied, then the default settings 
will be used.
All Volumes
The All Volumes button will segment all opened volumes, based on the most recently applied seg-
mentation settings. If no segmentation parameters have been applied, then the default settings will 
be used.
Manual
The Manual button allows the user to manually modify the segmentation of the dataset. 3D 
datasets must first be segmented by clicking either the Current Volume or All Volumes button 
before entering the Manual mode.
Manual Segmentation
In the Manual Segmentation dialog, the user can use the mouse to add or subtract segmented area 
from a segmented dataset. To do this, hold down the left mouse button while moving the mouse 
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over the desired area to be added or subtracted from the segmented dataset. Essentially, use the 
mouse to draw on (or erase) the segmented data. Release the mouse button when done adding/
subtracting area.
Manual Segmentation
When Manual Segmentation is selected, use the mouse to draw an outline around an object to be 
added to the segmented data. Do this by holding down the mouse button while tracing an outline 
around the object. Once the outline is complete, release the mouse button, and the entire area 
within the outline will become colored, indicating that it has been segmented.
The Manual Segmentation option is not available when segmenting a 3D dataset.
Mode
The Mode frame contains the control buttons to select whether the segmented area is increased or 
decreased.

• Add - Clicking this button will add more area to the segmented region by 
placing the cursor in the region where segmented area is to be added, then holding down the left 
mouse button and scrolling over the desired area.

• Erase - Clicking this button will erase area from the segmented region by 
placing the cursor in the region where segmented area is to be erased, then holding down the left 
mouse button and scrolling over the desired area.
XY Brush Size
The XY Brush Size frame contains three different size options for manually modifying segmenta-
tions. The larger the brush size, the more area will be added or erased (based on the Mode 
selected) in the segmentation. In the Z Brush Size frame, the size of the brush will determine the 
depth of the segmentation (how many z-slices will be segmented).
Finish

• Accept Changes - Clicking this button will accept and save the changes 
that have been made to the segmentation of the dataset.

• Undo Changes - Clicking this button will undo all changes that have been 
made since the last time Accept Changes was clicked.

• Close - Clicking this button will save the changes made to the segmenta-
tion, and return to the Object Counting dialog.
Use Recommended Expert Settings
Checking this button will use the recommended expert settings when performing segmentation on 
the dataset. To change the expert settings, deselect Use Recommended Expert Settings then click 
the Go To Expert Settings button.
Go To Expert Settings
Clicking this button will open the Segmentation and Counting Expert Settings dialog box. The 
settings for segmentation can be changed here.
Segmentation and Counting Expert Settings
Perform Background Equalization
Checking this box will perform Background Equalization on the dataset before segmenting it. For 
more information on Background Equalization, see page 117. The default for this feature is 
checked.
Use Noise Removal
Checking this box will perform Noise Removal on the dataset before and after segmenting it. This 
consists of a preprocessing smoothing of the image, followed by a postprocessing analysis and 
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removal of particles determined to be too small to be valid objects. The default for this feature is 
checked.
Use Wavelet PreProcessing
Checking this box will perform Wavelet PreProcessing on the dataset before segmenting it. This 
is strictly a preprocessing feature, and will create a somewhat similar effect of the Noise Removal 
feature, though not quite as accurate, though much faster. The default for this feature is 
unchecked.
Threshold
The Threshold frame contains the controls to set the thresholding for the dataset.

• Look For - This feature determines what type of objects to look for in the 
dataset, the options are Bright Objects, Dark Objects and Gray Objects. Each object has a default 
threshold setting.

• Use Automatic Threshold - Checking this box will set the Upper and 
Lower Threshold limits to the defaults based on the type of object selected in the Look For drop-
down menu option. With the Use Automatic Threshold checked, the Upper and Lower Threshold 
controls will be disabled.

• Upper Threshold - This sets the upper threshold for the dataset.
• Lower Threshold - This sets the lower threshold for the dataset.
• Set Threshold for All Volumes - Clicking this button will set the selected 

thresholds for all volumes. If the Upper and Lower Thresholds are changed from the default val-
ues, this button must be clicked, otherwise, the default threshold settings will be used.
Segment Current
Clicking this button will segment only the current volume.
Segment All
Clicking this button will segment the entire dataset (all volumes).
Close
Clicking this button will close the Segmentation and Counting Expert Settings dialog, and return 
to the Object Counting dialog.

Select Object Classes

This frame contains the controls to create and define object classes to be counted. Up to 8 differ-
ent classes of objects can be defined. Alternatively, the No Training (Count All) checkbox can be 
selected which will direct the application to count all objects, with no class definitions or deter-
mining characteristics.
No Training (Count All)
Checking this button will direct the application to count all objects, with no class definitions or 
determining characteristics. When this box is checked, all other buttons in the Select Object 
Classes frame will be disabled.
Perform Training
Checking this button will activate the Add/Define/Redefine Classes and the Load Classes buttons 
so that object classes can be created or loaded.
Current Classes
This box displays the classes which have already been defined. As classes are added, they will 
appear in this box.
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Add Classes/Define Classes/Redefine Classes
Clicking this button will open the Object Classes for Counting dialog, in which the classes to be 
counted can be created and defined. The name of this button will change based on whether the 
Perform Training option is selected, and whether there are already classes defined.
Object Classes for Counting
This dialog contains the controls to select objects and create a training set for use in counting all 
objects in a dataset.
Object Information
In this frame, enter the name of each object class to be created into the textbox. Once the name is 
entered into the textbox, click Define Object. Up to eight separate objects can be defined. Once 
the Object Selection process has begun (described below) it is not possible to move back to this 
step without undoing all steps in the Object Selection step, so make sure that all desired object 
classes have been defined before moving on.
Object Selection
In this frame, as object classes are defined, they appear in the menu within this frame. To select 
objects to associate with an object class, highlight that object class in the menu, then click on the 
objects within the 3D Viewer that best represent the physical attributes of that class. As objects 
are selected in the 3D Viewer, they will become colored. To deselect a selected object, click on 
that object again. To select objects for a new object class, click on the new object class in the 
menu, and click on the objects within the 3D Viewer that best represent the physical attributes of 
that class. Repeat this for each object class that has been defined.

• Delete Entry - This button will delete an object class from the menu. The 
Deselect All button must be pressed before clicking the Delete Entry button.

• Deselect All - This button will deselect all objects for all object classes.
Feature Selection
In the Feature Selection frame, the pertinent features (those that differentiate an object class) are 
selected and calculated.

• Select All - This button selects all of the available features. By default, all 
features are selected, so this button is disabled until one of the features becomes deselected.

• Deselect All - This button will deselect all selected features.
• Calculate Statistics - This button will calculate statistics for each of the 

chosen features.
• 2D Features - This lists all of the available 2D features. For this section, it 

is imperative that the image information is correct in order to accurately calculate statistics.
• 3D Features - This lists all of the available 3D features. For this section, it 

is imperative that the image information is correct in order to accurately calculate statistics.
Feature Display
This section displays the statistics calculated on the selected features once the Calculate Statistics 
button is clicked. The statistics will appear in spreadsheet form.

• Save Training Sets - Clicking this button will allow the user to save the 
data for the object definitions. This can save time for future experiments if defining the same type 
of objects. Each object will be saved as a separate .csv file.
Ok
Clicking Ok will load the training data back into the Object Counting dialog. If the training data 
has not been saved, a message suggesting to save the training sets will appear. Clicking Yes will 
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open the Directory to Save Training Set dialog. Clicking No will close the Object Classes for 
Counting dialog and reopen the Object Counting dialog.
Cancel
Clicking the Cancel button will close the Object Classes for Counting dialog without saving or 
loading any training data. Counting will not be able to be performed until the training data is 
loaded.
Help
Clicking the Help button will launch the Online Help system, opened to the topic for Object 
Classes for Counting.
Load Classes
This button allows the user to load a previously saved set of classes. Clicking this button will open 
a browser. Navigate to the directory of the desired dataset, then double-click the dataset to load it.
Clear Classes
Clicking the Clear Classes button will clear all classes that have already been loaded.
Save Data
Clicking this button will allow the user to save the data for the object definitions. This can save 
time for future experiments if defining the same type of objects. Each object will be saved as a 
separate .csv file.

Count Objects

This frame contains the controls to count and save the segmented dataset, either as an entire vol-
ume, or single volumes at a time.
Separate Touching Objects
Clicking this button will separate objects that segmenting did not fully separate. It does this by 
stripping away layer by layer until the objects are disconnected in order to differentiate them, then 
it rebuilds them to their original size.
Current Volume
Clicking the Current Volume button will count all objects in the designated classes in the currently 
displayed volume.
All Volumes
Clicking the All Volumes button will count all objects in the designated classes in all opened vol-
umes.
Save Current Volume
Clicking the Save Current Volume button will save the current segmented and counted volume for 
later viewing. A Save As dialog will open in which the filename and type can be entered to save 
the dataset.
Save All Volumes
Clicking the Save All Volumes button will save all segmented and counted volumes for later view-
ing. A Save As dialog will open in which the filename and type can be entered to save the dataset.
View Current Statistics
Clicking the View Current Statistics button will open a new dialog, Object Counting Results, with 
the statistics for the current volume. The statistics displayed are based on the defining characteris-
tics set up in the Select Object Classes procedure.
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View All Statistics
Clicking the View All Statistics button will open a new dialog, Object Counting Results, with the 
statistics for all volumes. The statistics displayed are based on the defining characteristics set up 
in the Select Object Classes procedure.
Object Counting Results
The Object Counting Results dialog contains the statistics on each object found, including all of 
the defined object classes, as well objects which do not fit into any of the defined classes. These 
objects will be classified as Invalid.

Change Type
Clicking this button allows the user to change an object from being classified as one type to 
another. For instance, if there are three classes of objects defined (for the purpose of this example, 
the classes are named A, B and C), and an object is assigned to class A but should be assigned to 
class B, click on the desired object, then click on Class B in the Change Type menu. Click on the 
Change Type button. That object will now be classified as Class A, and will take on the color of 
that class.
Export Features
The Export Features button allows the user to save the statistics into a .csv file for further analy-
sis.
To Tracking>>
Clicking this button in the Object Counting dialog will open the Object Tracking dialog. Once this 
button is clicked, there is no way to return to the Object Counting dialog. It is advised that the sta-
tistics be saved from the Object Counting phase before moving on to the Object Tracking phase.
Close
The Close button closes the Object Counting Results window.

Tracking

This dialog contains the controls used to track the objects counted in the Object Counting dialog. 
To perform Tracking, the dataset must first be segmented and counted, as detailed in the previous 
section.
Track
The Track frame contains the controls to perform and modify the tracking feature.
Auto (All)
The Auto (All) button will automatically track all counted objects. The 3D Viewer will display the 
counted objects, along with color-matched bars indicating the paths that they take in the time-
series.
Before tracking, the Tracking Tolerance dialog will appear.
Distance Tolerance
This slider sets the threshold for the distance an object can move and remain in a track. It is based 
on a percentage of the length of the object's radius. Thus, if the threshold is set to 300%, then any-
thing that moves more than 300% the length of its radius will be overlooked as an object within 
that track.
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Feature Tolerance
This slider sets the threshold for the amount that the selected features can change between 
datapoints. If an object changes more than the set threshold, it will be considered a new object, 
and will not be included within that track.

Auto (Partial)
The Auto (Partial) button allows the user to select which objects to track. Once this button is 
clicked, the Choose Objects to Track dialog will open up. Before clicking this button, ensure that 
all objects that need to be counted are being displayed. If not, in the View Data... frame, select As 
Time Point, which will allow you to scroll through the time points to a frame that contains the 
desired objects.
Choose Objects to Track
The Choose Objects to Track dialog is launched from the Auto (Partial) button. In it are the con-
trols to select which objects to track.

• View Classified - This option displays the dataset as a segmented dataset.
• View Original - This option displays the dataset in its original, non-seg-

mented display.
• Distance Tolerance - This slider sets the threshold for the distance an object 

can move and remain in a track. It is based on a percentage of the length of the object's radius. 
Thus, if the threshold is set to 300%, then anything that moves more than 300% the length of its 
radius will be overlooked as an object within that track.

• Feature Tolerance - This slider sets the threshold for the amount that the 
selected features can change between datapoints. If an object changes more than the set threshold, 
it will be considered a new object, and will not be included within that track.
Left click on the objects to be tracked. Once all objects are selected, click Track.
Manual/Modify
Clicking the Manual/Modify button opens the Manual Track dialog, wherein tracks can be added, 
deleted and modified.
Manual Track
The Manual Track dialog contains the controls to create, delete, and modify tracks. If an object is 
erroneously included within a track, it can be deleted or switched with a different object here. 
Additionally, in some instances, multiple tracks can be merged into one track.

• Track Menu - On the right side of the Manual Track dialog is the Track 
Menu. It contains a listing of all of the tracks in the dataset. As tracks are added and deleted, this 
menu will be updated. Clicking on a track within the Track Menu will make the tracking line for 
that track become thicker in the 3D Viewer. Additionally, to rename a track, click on it once to 
highlight it, then click again and the name will become editable (do not double click quickly). 
After changing the track name, click <Enter> on the keyboard.

• Add Track - This button will add a track to the Track Menu. No objects will 
be assigned to that track until objects are added to that track manually. This is done by highlight-
ing the track to add objects to in the Track Menu, then clicking on the object to add to the track in 
the 3D Viewer. Once an object is selected, scroll to the next time frame by clicking the right scroll 
arrow on the bottom of the Manual Track dialog. Click on the next object to add to that track in 
the 3D Viewer, and repeat this for each frame.

• Delete Track - This button will delete the highlighted track in the Track 
Menu, as well as the 3D Viewer. The objects will remain, but they will no longer be associated 
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within a track. To delete a track, highlight it in the Track Menu by clicking on it, then click the 
Delete button. Only one track can be deleted at a time.

• Delete Rest of Track - Clicking this button when a track is selected will 
delete the rest of the track, including the selected time frame.

• Delete Current Object - Clicking this button will delete an object from a 
track. To do this, click on the object to be removed in the 3D Viewer, then click the Delete Cur-
rent Object button in the Manual Track dialog.

• Merge - The Merge button allows two separate tracks to be merged 
together. This would be done if, for instance, Track 1 tracks an object in frames 1-3, while track 2 
tracks the same object in frames 4-6. Highlight the two tracks to be merged in the Track Menu, 
then click Merge. The two tracks will become one continuous track, and will be classified as the 
track that is listed highest on the Track Menu (if Track 2 and Track 4 are merged, they will now be 
called Track 2, and Track 4 will have no objects associated with it).

• Undo - The Undo button will undo the last action that was performed. This 
button only goes back one action, and becomes inactive once it is used, until another action is per-
formed (i.e., cannot continually step backward through multiple actions).
View Data...
The View Data frame contains two options for how to view the data in the 3D Viewer.

• As Time Point - This displays the data as individual time points, with only 
one displaying at a time. In this mode, it is possible to scroll through the time points by using the 
controls at the bottom of the 3D Viewer.

• As Time Series - This displays all of the time points at once, overlaid on 
one another. In this mode, there is no ability to scroll through each time point, as they are all 
already displayed.
View Track Lines
Checking the View Track Lines checkbox will display lines which follow the paths of each object. 
The color of these lines will match the object’s color which they are tracking.
Feature Selection
In the Feature Selection frame, the pertinent features (those that differentiate an object class) are 
selected and calculated.
Select All
This button selects all of the available features.
Deselect All
This button will deselect all selected features.
Calculate Statistics...
This button will calculate statistics for each of the chosen features and open the Track Statistics 
dialog.
Track Statistics
This dialog is launched by clicking the Calculate Statistics... button, and it displays the statistics 
of the tracked objects. Only those features selected in the 2D Features, 3D Features and Tracking 
Features will be displayed. Clicking on an object within the Track Statistics dialog (in the spread-
sheet) will highlight that object in the 3D Viewer.
The Dropdown menu above the spreadsheet contains each of the tracks, as well as an option for 
all. Only the track(s) selected in this dropdown menu will be highlighted in the 3D Viewer and 
displayed in the spreadsheet.
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• Export Features - This button will open Save As dialog, in which the statis-
tics can be saved to a .csv file.

• Close - This button will close to Track Statistics dialog.
2D Features
This lists all of the available 2D features. For this section, it is imperative that the image informa-
tion is correct in order to accurately calculate statistics.
3D Features
This lists all of the available 3D features. For this section, it is imperative that the image informa-
tion is correct in order to accurately calculate statistics.
Tracking Features
This lists all of the available features relative to the movement of the tracked objects. For this sec-
tion, it is imperative that the image information is correct in order to accurately calculate statis-
tics.
Movie
Generate Movie
The Generate Movie button will open the Time-Lapse Movie Generator dialog. The dialog dis-
played is an abbreviated version of the Time-Series Movie Maker dialog described on page 173. 
For more information on the functionality of this feature, refer to that section.
Cancel
Clicking the Cancel button will close the Time-Lapse Movie Generator dialog without creating or 
saving a movie.
Help
Clicking the Help button will open the Online Help file for the Time-Lapse Movie Generator.

Tutorial for Object Counting

(1) From the Analysis menu, select Object Counting/Tracking.

(2) A Windows Browser will open. Navigate to the Object Counting folder in the Tutorial 
images. Open Nitella1.tif. A message will appear asking if you would like to load the entire 
sequence, click on Yes. Another message will appear asking if you want each file to be a time 
frame, click on Yes. Once the dataset has finished loading in the Import Cell Counting Time Series 
dialog, click on Ok.

(3) In the Segment frame, click on the All Volumes button. This will segment all of the vol-
umes.

(4) In the Select Object Classes frame, select Perform Training, then click the Define Classes 
button. This will open the Object Classes for Counting dialog.

(5) In the text box in the Object Information frame, type in Class A. Click the Define Object 
button, then the Done button.

(6) In the Object Selection frame, highlight Class A in the textbox by clicking on it.
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(7) Select an object that is completely detached from the rest of the image, and is round, then 
click on that object with the mouse. Once selected, the object will change color. Repeat this step 
for as many objects as can be located in the 3D Viewer. To deselect an object that was mistakenly 
selected, click on it again.

(8) In the Feature Selection frame click Deselect All, then, under 2D Features, click on Area 
and Circularity.

(9) Click on the Calculate Statistics button. The Feature Display frame will be populated with 
each selected object’s location and statistics on each figure that was selected in the Features 
Selection frame (in this case, the Area and Circularity of each object).

(10) Click on Save Training Sets. A Directory to Save Training Set... dialog will appear. Ensure 
that it is set to the Object Counting Folder, then type trainingset1 into the file name textbox. Click 
Save. Click on Finish, this will bring you back to the Object Classes for Counting dialog.

(11) In the Count Objects dialog, ensure that the Separate Touching Objects box is unchecked.

(12) Click on the All Volumes button in the Count Objects frame. This will count all of the 
objects in all opened volumes, coloring each found object with a different color or shade of color.

(13) Click on the View All Statistics button. This will display the location and pertinent statis-
tics (in this case, the Area and Circularity) of each object found to match the criteria set forth in 
Steps 5-8.

(14) In the Object Counting Results dialog box, click the Export Features button. A Save As 
dialog will open. Ensure that it is set to the Object Counting folder, then type objectscounted1 into 
the File Name text box, then click Save. Click Close in the Object Counting Results dialog to 
close it.

Leave all datasets and dialog boxes open

Tutorial for Object Tracking

Note - This tutorial assumes that the Tutorial for Object Counting has already been completed.

(1) In the Object Counting dialog box, click on the To Tracking>> button. This will open the 
Tracking dialog box.

(2) Click on the Auto (All) button. This will track all of the counted objects through all of the 
time points. Note the colored dots and lines (which match, but are darker than the color that was 
assigned in the Counting feature). The dot denotes the center of the object at each time point, and 
the line connects each time point for each object.

(3) Select all of the Tracking Features (Displacement, Velocity and 
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Acceleration). Click the Calculate Statistics button. The Track Statistics dialog will open, con-
taining all of the statistics about each of the counted objects. In the Tracking dialog, there is a text-
box that lists all of the objects tracked as Track 1, Track 2 etc. Click on Track 1, notice that only 
one object in the 3D Viewer is colored, and only one set of statistics appears in the Track Statistics 
dialog.

(4) Click the Export Features button in the Track Statistics dialog. Name the file 
trackingfeatures1 then click Save. This will save the statistics to a .csv file. Click Close to close 
the Track Statistics dialog.

(5) Click the Generate Movie button. An abbreviated version of the Time-Lapse Movie Gen-
erator dialog will open. For more information about the Time-Lapse Movie Generator.

(6) Leave all of the defaults as they are, then click the Generate Movie button. The movie may 
appear behind the 3D Viewer and the Time-Lapse Movie Generator dialog, try moving these two 
dialogs if the generated movie does not seem to appear.

(7) Click the Rock button  then click the Play button . The movie will play, show-
ing the objects moving.

(8) Click the Cancel button to close the Time-Lapse Movie Generator dialog. Click the Finish 
button in the Tracking dialog. Click the X in the upper-right hand corner of the Untitled 0 window 
to close the generated movie. On the message that will pop up, asking you to save the movie, click 
Yes, then name the movie trackingmovie1.
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Windows

Cascade

This feature places all the open dataset views in overlapping and offset positions from top to bot-
tom of the viewing window.

Tile Horizontally 

This function stacks horizontally the open datasets in the window. Closed or minimized windows 
will not be tiled (displayed). To end the tiling, click on each dataset and select the desired size 
from the zoom box.

Tile Vertically

This function stacks vertically the open datasets in the window. Closed or minimized windows 
will not be tiled (displayed). To end the tiling, click on each dataset and select the desired size 
from the zoom box.

Close All 

This function allows the closing of all open views, whether active or not, and all docked (datasets 
are minimized with only part of their title bar showing) views all at once. 

Window List

This feature lists all current views on the screen.
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Help 

AutoQuant Help

This feature provides a help window opened to the table of contents.

Contents

This feature provides a help window in the form of a table of contents (unlike Search for Help On, 
where it is more like an index).

Search for Help On 

This feature allows you to obtain help by searching for Key words or by selecting descriptive 
techniques.

Check for Update

AutoQuant’s products incorporate an AutoUpdate feature. It is configured to check for updates 
once a month if your machine is connected to the internet. If you would like to check for an 
update before that, select Check for Update from the Help menu. You will be prompted to click 
OK to search the internet for updates. If you do not have a LAN connection, but are using some 
other internet connection, you will be prompted to click Configure to configure your internet set-
tings. Any internet connections available on your machine will be listed in the Use Dial Up Con-
nection drop down menu. Select the service you wish to use, then click OK. This will take you 
back to the original dialog box, at which point you can click OK again. AutoUpdate will now 
search for any available updates.

About 

This feature shows the version and copyright information about the product.
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Frequently Asked Questions

Q: How does AutoDeblur perform an accurate deconvolution without a measured point-
spread function (PSF)?

A: AutoDeblur's adaptive blind deconvolution automatically extracts point-spread functions from 
the raw image dataset. It does this by analyzing the spatial frequencies that make up the raw 
image volume and creating one (or more) PSF’s that are based on this information. 
Because the performance of a microscope varies across the field of view and (especially) along 
the optical axis, AutoDeblur will often automatically derive several PSFs to process a single 
image volume. This assures that results are accurate, even though the optical system (scope, cover 
slip, immersion medium, mounting medium, specimen) is not linear. Blindly restored PSFs are 
also more accurate than empirically measured PSFs because they are free from noise contamina-
tion, and are based on the distortion actually present within the dataset, rather than when the PSF 
was measured.

Q: Can I process 2D images and time-lapse movies?

A: Yes. AutoDeblur contains an iterative blind deconvolution for use on 2D images. It is for 
researchers who do not have a Z-motor, or, who wish to improve resolving power of their standard 
2D images, or, who want to improve resolving power in time-lapse movies.

Q: Can I process many images as a batch?

A: AutoDeblur contains functions that permit you to set up a batch of images that will then be 
sequentially processed. After setting up the parameters for your deconvolution, you may choose 
to place the image into a queue that you launch at a later time. This is useful for laboratories who 
do a lot of imaging and for researchers performing time-lapsed observations of 3D volumes. 
These laboratories can set up their images to process a batch of images overnight, and have them 
all ready for analysis in the morning.

Q: How can I easily inspect my images before and after deconvolution?

A: Not only does AutoDeblur contain five different types of deconvolution (adaptive 3D blind, 
nearest-neighbors, no-neighbors, inverse filtering and 2D deconvolution), but it also provides 
many different ways to visualize the raw and processed images. AutoDeblur enables a 3D dataset 
to be visualized using several different projections and orientations. Each volume can be viewed 
from XY, XZ and ZY orientations as a maximum, minimum, summed, or voxel gradient projec-
tion, or as individual optical slices. No other package currently on the market combines these 
powerful processing tools with an environment for visualizing the results.

Q: Can I process images that were acquired with a confocal microscope?

A: Yes. Confocal microscopes (conventional, two-photon and spinning-disk) are effective at 
reducing the scatter from deep tissues. In practice, the z resolution is not good compared to the x, 
y resolution. Resolution along the z-axis is typically 0.5 to 3 microns. This means that structures 
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are elongated along the z-axis. Applying AutoDeblur to a confocal image stack improves the z-
resolution dramatically - often achieving beyond the theoretical 0.5 micron limit. The signal-to-
noise ratio of the deconvolved images is greatly improved, and poor signal-to-noise is otherwise 
common with confocal microscopes, especially in live cell imaging and where photobleaching is 
a problem. 

Q: What types of image files are supported by AutoDeblur? 

A: AutoDeblur supports most common image formats, including 8, 12, 16 bit TIFF’s, Universal 
Imaging's STK, BioRad's PIC, Leica's native files, BMP’s, AVI’s, Olympus Fluoview, raw 8, 12, 
16 integer, 32 bit floating point data, and others.

Q: Can AutoDeblur handle the saturated portions of my image volumes?

A: Yes. Not only can AutoDeblur handle images that contain saturated areas, it can often recover 
information from within these saturated sections. 
This is possible in situations where there are non-saturated areas nearby the saturated areas. The 
blur in the nearby non-saturated region contains information about the saturated region which 
AutoDeblur restores. The degree to which this is effective depends on the size of the saturated 
area and the numerical aperture of the lens. 
Of course, according to good laboratory practice it is always best to avoid saturation, but this 
property of the algorithm makes data collection and experiment design much easier since the 
avoidance of saturation is now a flexible requirement and no longer an absolute requirement.

Q: Are noisy, poor signal-to-noise images going to be problem for AutoDeblur?

A: AutoDeblur is able to process extremely noisy images and deliver restored image sets with 
very little noise. Noisy images are common with a confocal microscope, an intensified camera or 
whenever low light is used to minimize bleaching.

Q: How many iterations should I apply? How do I know I have performed sufficient itera-
tions? What happens if I perform too many iterations?

A: Start with the rule of thumb: With the Use Recommended Expert Settings box checked, for 
widefield and brightfield use 10 iterations, for confocal, two-photon, and spinning disk, use 10 
iterations.
If by inspecting the images you are satisfied with the resolving power, stop. If you want still better 
resolving power, increase or double the numbers. Repeat this increasing until you are satisfied 
with the resolving power. You will know you went too far if you notice obvious noise and arti-
facts, which will be clear because structures will be shown which clearly cannot be present and 
which do not have remnants seen in the raw images. If you notice such noise and artifacts, cut the 
number of iterations in half. With some experience, 3 trials should be sufficient to determine the 
number of iterations necessary for your experimental setup and then all similar samples, having 
identical conditions (sample type, lens, magnification, z-spacing), should use the same number of 
iterations. These 3 trials can be done in a few minutes by cropping a small ~64x64 section and 
experimenting with that section before deconvolving the whole volume.
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Q: How do I know the restored features are real?

A: By looking at the raw and deconvolved images side-by-side, compare to see if details are visi-
ble in both. A structure, if it is real, will appear in the raw image, although it will be more difficult 
to see due to having low contrast, noise and blur.

Q: When do artifacts appear?

A: Artifacts such as “ringing” and “mottling” appear if the wrong parameters have been entered, 
or if there is excessive noise. Dead or hot pixels can also cause artifacts. Using the Data Correc-
tion utilities can eliminate these problems.

Q: How close together should my optical slices be?

A: The optimal setting has them spaced equal to the depth of field, for both widefield and confo-
cal. This rule of thumb is flexible if other experimental constraints warrant a compromise.

Q: What should I do after I load my dataset?

A: Next, go to Deconvolution – Deconvolution Settings - Standard Settings and fill in any entries 
that have not been previously entered, including the type of deconvolution you want to perform. 
Then go to Deconvolution - Start 3D Deconvolution to begin your deconvolution. 

Q: How are saturated pixels handled?

A: Saturated pixels are handled by a proprietary algorithm which, heuristically, treats them as 
unknown data points. A special algorithm uses the blur information surrounding the saturated pix-
els to infer the information that should have otherwise been provided by the saturated pixel.

Q: When should I use optical density or attenuation correction?

A: Use optical density correction if you notice a flicker in your optical sections. You will notice 
this flicker by creating a XZ View (View menu --> Single View --> XZ) and a Sum Projection 
(Visualization menu --> Sum Projection). If it is present, the flicker will be obvious, so when in 
doubt you may assume there is no flicker. Flicker looks like dark horizontal lines through your 
dataset. Use attenuation correction if you notice that the overall brightness of your picture 
becomes progressively dimmer as you penetrate deeper into the sample. Your dataset should be in 
a XZ View and the need for correction will be indicated by having a bright top and dark bottom.

Q: When do I check “Phase content expected”?

A: This is mainly used for brightfield samples, which have not been stained and are viewed by 
closing down the condenser aperture on the microscope. This can create for certain types of trans-
mitted light brightfield samples a phase character. These types of samples cause a refraction of 
light passing through them, rather than a simple absorption of light. This type of sample is recog-
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nized when (1) it is a transmitted light brightfield dataset, and (2) you see regions in the image 
which are brighter than the background surrounding the sample. By checking “Phase Content 
Expected” fine detail in the specimen will be preserved.

Q: How do I deconvolve my dataset faster?

A: First, try the Inverse Filter under the Deconvolution menu. This usually provides results in a 
few minutes. It only works with widefield and not with confocal. Secondly, experiment with a 
cropped ~64x64 section before deconvolving the whole volume. Also set the Deconvolution Per-
formance to Best Medium Fast. Finally, make sure that you have maximized the amount of free 
memory on your computer.

Q: How is blind deconvolution different from nearest neighbors and inverse filter? When 
should I use each algorithm?

A: The Blind Deconvolution is an iterative-constrained algorithm that in most cases (not all) pro-
vides the best resolving power, including the resolving power along the z axis. The Inverse Filter 
is a fast linear method that gives remarkable deconvolutions with widefield dataset. It does not 
work with confocal dataset. With some types of samples, especially those that have fine low con-
trast staining, it gives even better results than the blind deconvolution. Use the Inverse Filter if 
speed is the most important consideration or if the sample has fine low contrast detail that is 
important to see.   The Nearest Neighbor is the fastest deconvolution. Its main advantage is speed. 
It provides images typically within seconds. It is a linear method. Use the Nearest Neighbor algo-
rithm for quick feedback or for enhancing pictures for presentations, but be careful about interpre-
tation of the images because it is not as robust against artifacts and noise as are the Blind 
Deconvolution and Inverse Filter.

Q: Why do all the features in my deconvolved dataset look darker than before?

A: The deconvolution will increase the dynamic range of the dataset as a result of removing the 
blur. When an image is displayed on-screen, it is auto-scaled between the maximum and mini-
mum intensities. Therefore, the background features will appear darker on-screen. Use the bright-
ness and gamma controls to better observe the features in the dataset.

Q: Why won't my images load into Photoshop?

A: This is because you may have saved the images in a format that is not compatible with Photo-
shop. Save the images as TIFF and when asked by the program if you want to “export as multiple 
files,” answer “Yes.”
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Appendices

Table of Z Spacings (Z Step Sizes)

DOF = Depth of Field                                                      Wavelength (λ) = 0.50µm

Table 1: 

Numerical 
Aperture (NA)

Step Size for Oil
     η = 1.515

Step Size for Water
      η  = 1.333

Step Size for Air
      η =  1.00

0.2 18.83 16.61 12.37

0.3 8.3 7.33 5.43

0.4 4.6 4.08 2.99

0.5 2.95 2.57 1.87

0.6 2.02 1.76 1.25

0.7 1.458 1.256 0.875

0.8 1.094 0.935 0.625

0.9 0.824 0.713 0.443

1.0 0.663 0.552 0.250

1.1 0.528 0.429 Undefined

1.2 0.424 0.330 Undefined

1.3 0.339 0.242 Undefined

1.4 0.267 Undefined Undefined

1.5 0.192 Undefined Undefined
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Table of Parameters

Table 2: 

File Name Numerical 
Aperture

Refrac-
tive 
Index

Modality X, Y, and Z      
Dimensions (Pixels)

   X, Y, and Z Spacing 
         (Microns)

FitcDapi_crop.tif 1.4          1.515 Widefield 90 120 50 0.07 0.07 0.15 

FitcDap_crop2d.tif 1.4          1.515 Widefield 90 120 1 0.07 0.07 0.15 

Blue_Green.stk 1.4          1.515 Widefield 90 120 50 0.07 0.07 0.15 

FitcDapi.decon.tif 1.4          1.515 Widefield 90 120 50 0.07 0.07 0.15 

Malaria_Red.tif 1.3          1.518 Widefield 202 243 60 0.1299 0.1299 0.3043

Malaria_Green.tif 1.3          1.518 Widefield 202 243 60 0.1299 0.1299 0.3043

Malaria_Blue.tif 1.3           1.518 Widefield 202 243 60 0.1299 0.1299 0.3043

Pollen.deb 0.7          1.515 Widefield 90 80 110 0.357 0.3636 0.4    

Colensc.tif 1.4 1.5 Widefield 256 256 1  2D dataset

Brain.avz  --  -- MRI 256 256 64  --  --  --

Hip.avz  --  -- CT scan 512 512 90 0.9 0.9 4.8

SmallHip.avz  --  -- CT scan 128 128 120 3.6 3.6 3.6

RotatedHip.avz  --  -- CT scan 128 128 120 3.6 3.6 3.6

Vicera.avz  --  -- CT scan 128 128 120 3.6 3.6 3.6

Skinless.avz  --  -- CT scan 128 128 120 3.6 3.6 3.6

HipMovie.avm Movie CT scan 128 128 120 3.6 3.6 3.6

VoxelTLB.avm Movie Brightfield 130 130 41 0.279 0.279 1.0

TLBview 1.3 1.515 Brightfield 198 208 64 0.653 0.0653 0.4

Star.0 0.25         1.0 Brightfield 494 348 46 0.6897 0.6897 8.0

Star.lt0 0.25         1.0 Brightfield 494 348 1 0.6897 0.6897 8.0

Star.bs1 0.25         1.0 Brightfield 494 348 1 0.6897 0.6897 8.0

Star.bs2 0.25         1.0 Brightfield 494 348 1 0.6897 0.6897 8.0

Starfish_crop2.deb 0.25         1.0 Brightfield 128 128 54 0.6897 0.6897 8.0

TobaMC.tif 1.4 1.515 Confocal 128 128 32  0.23 0.23 0.4

Neuron.deb 0.8           1.515 Confocal 384 512 64 0.94 0.94 1.0

Neuron _crop1.deb 0.8           1.515 Confocal 128 128 64 0.94 0.94 1.0

RedNuc 1.3           1.33 Confocal 128 512 64 0.07 0.07 0.15 
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Toolbar Icons

File Toolbar Icons

Time Series Data 1.32 1.4502 Widefield 256 256 23 .32 .32 .4783

Test.tif 256 256 1

Test_parameter.set  A file containing datasets parameters

Triple label segment.seg  A file containing datasets labels

Volume & Surface Area.text  A text file of the measurements for Surface Area & Volume of a 
dataset.

Table 2: 

File Name Numerical 
Aperture

Refrac-
tive 
Index

Modality X, Y, and Z      
Dimensions (Pixels)

   X, Y, and Z Spacing 
         (Microns)
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Visualization Toolbar Icons

View Toolbar Icons
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Analysis Toolbar Icons

Statistics Toolbar Icons

Zoom Toolbar Icon
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Numerics
12 bit data (*.*) 59
12 bit swapped (for UNIX) (*.*) 59
16 bit data (*.*) 59
16 bit swapped (*.*) 59
1D Deblur

XY/YZ Deconvolution 158
2D Deconvolution 145
2D Deconvolution Box 146
2D Deconvolution Results box 147
2D images 215
2D Slice Deconvolution 158

XZ Slice 158
2-Photon Data 55

Sampling Criterion 55
32 bit float (*.*) 59
3-D Data Collection

Avoiding Backlash and Hysteresis 45
Bias and Flatfield Frames 45
Bottom of Sample 36
Confocal Data 51
RS-170 Cameras 40, 46
Setting Exposure,Gain,Offset 38
Setting Number of Slices 37
Signal to Noise Ratio 54
Spatial Calibration 48
Top of Sample 36
Vibration Control 50

3-D Data Set 27

A
About 214
About AutoDeblur 214
Acceptor Quantum Yield Qa

FRET 179
Accurate deconvolution 215
Add

Import-multi channel data 60
Adjust All box 150
Algebra 189
Alignment 35

Channel to Channel 124
Manual 121

All Channels 147
All Slices 110
Alpha 86
Anaglyph 83
Anchor 89
Appendices 219
Application of AutoDeblur Deconvolution Package 30
Apply 93

Manual Alignment 123
Apply Seed Fill Label 193
Apply to all slices 110

Apply to current slice only 110
Apply to given slice range 111
Around 91

Freely 75
Object 75

Attenuation Correction 116
Depth Attenuation 117
Excitation Light Absorption 116
Fluorescent Emission Light Absorption 116
Photobleaching 116

Auto Rotate 81, 87
AutoDeblur

Installation 16
Software and Hardware Requirements 16
Starting 19

AutoDeblur File (*.deb) 58
AutoDeblur Files (*.deb) 58
Automatic Alignment

Noise Thresholding 120
Automatic Segmentation and Counting

Object Counting/Tracking 202
AutoQuant

Federal I.D. 25
Incidental Damages 21
Warranties 21

AutoVisualize File (*.avz) 58
Available data sets

Import multi-channel data 60
Axial Sampling Distance 37
Axial Smearing 31
Axis

Best Axis 76
X, Y, Z axes 76

Axis menu 75

B
B(Sl2/Sh2)

Ratiometrics 184
Backlash 45
Bad Pixel Treatment 128

Settings 128
Bad Pixel Treatment Settings

Median 128
Bandlimit 33
Basic Principles Underlying the AutoDeblur System 34
Batch 215

Cancel 163
Delete 163
Help 164

Best Focus 168
Bias 34
Bias Fields 126
Bias Frame 35, 46
Bias Frames 45
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Bin factor
Isosurface 99

Bio-Rad PIC (*.pic) 59
Bitmap File (*.bmp) 59
Black Level 40, 41
Blind (adaptive) deconvolution 145
Blind Deconvolution Methods

No PSF 33
Blue Channel 107
Blur

Nonisotropic 31
Bottom of the Scan 36
Bottom Slice 36
Brightness 86

C
Cascade 213
CCD

Camera Shutter 45
Charge Integration Time 45
Cooled CCD Camera 45
Cooled CCD Cameras 45
Dark Current 45
Flatfield Non-uniformity 45
Frame Averaging 40
RS-170 Cameras 46
Well Capacity 39

Center of Mass 88, 89, 92
Change

Import multi-channel data 60
Change Frame Delay 177
Change intensities

Import multi channel data 61
Changing a Color Map 105
Channel menu

All Channels 107
Blue Channel 107
Green Channel 107
Red Channel 107

Channel specification
Import multi-channel data 61

Channel to Channel
Alignment 124

Channels
Slice Viewer 107

Check for Update 214
CHOICE OF LAW 25
Clear List 163
Close 57

Manual Alignment 123
Close All 213
Collecting Optical Sections 36
Colocalization 186
Color Map 105

Color Map menu 79
Color Maps Tab 95
Color Selection 79
Color selection 147
Colors 83
Combine

Manual Alignment 122
Combine Label with Automatic Segmentation 197
Combine Labels 194
Concatenate Movies 176

Movie List 177
Confocal image 28
Confocal Microscopes

Molecular Dynamics 53
Sarastro 53

Constrain Rotation Group 90
Constrained Maximum Likelihood 33
Contents 214
Control Movie Points frame 93

End 93
Mid 93
Opposite Path 94
Start 93

Control Panel 81
Controls

Manual Alignment 123
Cooled CCD Cameras 38
Cooled CCD Correction Setting

Exposure Times tab. 127
Cooled CCD Data

Starfish Data 126, 127, 128
Cooled CCD Data Correction

Browse 128
Cooled CCD Settings

Dimensions 127
Exposure Times 127

Copy Deconvolution Settings 161
COPYING RESTRICTIONS 22
Copying Restrictions 22
Copyright 1995 - 2001 22
COPYRIGHT NOTICE 25
Copyright Notice 22
Correct Aspect 81, 87
Correct XZ/ZY Aspect Ratio 71
Correcting Cooled CCD Data 128

Data Correction 128
Launch 128

Correcting Data (Cooled CCD) 125
Correcting for Depth Attenuation 116
Count Objects

Object Counting/Tracking 206
Create 2D dataset

Import multi channel data 61
Create 3D dataset
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Import multi channel data 61
Create Movie 79, 95
Creating a Movie 171
Creating Three Orthogonal Views 68
Critical Measurement 64
Crop

Cropping a Sub-field 109
Crop Dimensions 111
Crop Icon

Cropping a Sub-field 109
Crop Rectangular Prism 130
Crop The Stack 108
Cube Surface 74, 85
Current Color Maps frame 95
Current Rotation frame 89

Angle 89
Round 90

Current View 80

D
Damages 21
Dark Current 34
Darkness 86
Data Correction 124, 126

Cooled CCD 128
Cooled CCD Data Correction 125

Data to Save box 151
Deblurring

Oversampled 31, 37
Deblurring Data

Inverse Filtering 152, 156
Nearest Neighbors or No Neighbors 156

Deblurring Subfields
Cropping 108

Deconvolution Menu
1D Deblur 158
AutoDefault 153
Expert 137
Standard 133

Deconvolution menu 146
Process Current Slice 157

Deconvolution Parameters 147
Deconvolution Performance 136
Dendritic Spines 31
Depth Of Field 27, 37
Depth of the Sample 37
DIC 118
Dichroic Mirror 41, 46
Differential Interference Contrast 118
Direct Eye Viewing 41
Display Floor 81, 87
Display light

Isosurface 99
Display Range 86

Display Slice 76
Distance Tolerance

Object Counting/Tracking 207
DOF 37
Dye Pair’s Foster Distance R0

FRET 180
Dynamic SubVolumes 139

E
Edit Menu 164
Electrophysiology Probes 31
ENFORCEMENT OF TERMS 24
Excitation Shutter 41
Expert Settings

Warning 136
Explanations of 3D Previewer Menus 73
Exposure 38
Exposure Time 38
Extend Depth 112
Extend Slices 112

F
Feature Selection

Object Counting/Tracking 205, 209
Feature Tolerance

Object Counting/Tracking 208
File

Exit 66
Open 56
Print 65

File Menu
Close 57
Open 56, 64, 106, 117

File menu
Save As 110

File Names
Numeric Suffix 43

Filename Prefix box 151
Files

Recent Files List 66
First Guess 140

Flat Sheet 140
Fix plane 77
Fix to Screen 91
Flat Field 126
Flat Field Non-Uniformity 46
Flat Sheet 140
Flatfield Correction 34
Flatfield Frame 35, 46
Flatfield Frames 45
Flatfield Non-Uniformity 46
Flatfield Slide 46
Flicker

Manual Alignment 122
Flip (Horizontal, Vertical) 105
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Flip Plane 77
Fluorescence 41
Fluorescent Microspheres 32
Fluoview (*.tif) 59
Foster Distance 180
Frame Averaging 43
Frame Grabber Cards 40
Frame Grabbing 38
Frames/sec 94
FRET 178

Acceptor Quantum Yield Qa 179
Dye Pair’s Foster Distance R0 180
FRET Conversion Factor G 179
Specified Cross Talk 179
Subtract Background 179

FRET Conversion Factor G
FRET 179

Further Processing of a Data Set 149

G
Gain 38, 40, 41

Adjustment 40
Gamma 86
Gaussian Smoothing

Ratiometrics 185
GENERAL 25
Generate datasets

Import multi channel data 61
Generating Different Views and Projections 67, 167
Go to Origin 76
Go to Point 78
Go To View 76
GOVERNING LAWS 24
GRANT OF LICENSE 22
Grayscale box 150
Green Channel 106, 107
Grynkiewicz Equation for Ion Concentration

Ratiometrics 183
Guidelines for Collecting 3-D Image Data 35

H
Haze 27
Height Map 74
Help 214
Help Topics 214
Highlight Labels 194
Histogram 39, 41
Histogram of Data Intensity 200
Histogram of ROI of Current View 200
histogram stretching intensity filter 104
Hourglass

Central Radius 138
How are saturated pixels handled 217
How do I know the restored features are real 217
How many iterations 216

How to Use the Manual 15
Hysteresis 45

I
Image Algebra 189
Image Alignment

Projection 122
Two Views 122

Image Appearance Group 84
Image Aspect (Retain Aspect Ratio, Stretch Aspect Ra-

tio) 70
Image Info 147
Image Macro 130
Image Macro Operation Order 130
Image Size 113
Imaris 58
Immersion Medium 37
Impalement Sites 31
Import channel

Import multi-channel data 60
Import multi channel data

Create 2D dataset 61
Create 3D dataset 61
Generate datasets 61
Remove 61

Import multi channel dataChange intensities 61
Import Multi-channel data

Add 60
Import multi-channel data

Available data sets 60
Change 60
Channel specification 61
Import channel 60
Load channels 60
Select all 60
Select data 60

Important Features of the AutoDeblur System 33
Importing Multi-Channel Data 60
improved morphometry 29
Intensified CCD 33
Intensity Profile Along Line box 200
Introduction 27

3D Deconvolution 27
Inverse Filter 152

Deconvolution Menu 153
Inverse Filtering 152

Nearest Neighbors or No Neighbors 152
Invert Data 117
Invert View 104
IPLab (*.*) 59
Isosurface 74, 99

Bin factor 99
Display light 99
Lighting 99
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Reset 99
Shadow 100
Thresholds 100
Wire frame 99

Iteration(s) to Save box 151
Iterative Method 33

J
Jansson Van Cittert 33

K
Kd

Ratiometrics 184

L
Launch Imaris 58
LCD Glasses 84
Least Squares 33
License

US Government 25
Lighting

Isosurface 99
Likelihood Function 34
LIMITATION OF LIABILITY NOTICE 24
Limitation of Liability Notice 21
Line Mode 199
Load channels

Import multi-channel data 60
Load Settings 66
Loop Mode 78

M
Magnetic Tape 16
Magneto-Optical disks 16
MANUAL 22
Manual Alignment 121

Apply 123
Close 123
Combine 122
Controls 123
Flicker 122
Reposition 123
Resize 123
Rotation 123
Slice Control 123
Slice Status Box 123
Undo 123
Zoom 122
Zoom Step 122

Manual Input 89
Manual input 92
Manual Segmentation 192

Apply Label 192
Select Displayed Label 198

Maximum Likelihood 33
Maximum Projection 167

Measure 199
Median setting 128
Microscope

Condenser 35
Condenser NA 36
Eyepiece 41
Fine Focus Knob 44
Fluorescence Excitation Lamp 35
Graduations 44
Horizontal Vibrations 51
Iris Diaphragm 36
Lamp Brightness Control 40
Micrometers Per Revolution 44
NosePiece Focusing Microscope 45
Objective NA 36
Relative Motion 50
Rigid Platform 51
Stage Focusing Microscope 45
Trans-Illumination Lamp 35

Microscopes
Confocal 30
Transmitted-Light Brightfield 30
Widefield Epi-Fluorescence 30

Microsphere 32
Mid Point Active 78
Minimum Projection 167
Modality Box 134, 142, 153
Modeling Assumptions 33
Montage View 69
Montage view 69
morph 175
Movie

Time-Series 173
Movie menu 77
movies

rotating morph 175

N
Nearest Neighbors 156
Nearest Neighbors Method 33
Neutral Density Excitation Filter 40
New Dimension 112
Noise 33
Noise Reduction 33
Noise Threshold

Automatic Alignment 120
Noisy 216
Nonnegative Image Values 33
Number of Columns 69
Number of Rows 69
Number of Slices 37
Numerical Aperture 37, 134, 142, 153

O
Object Center 92
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Object Center frame 88
Object Counting/Tracking 202

Automatic Segmentation and Counting 202
Count Objects 206
Distance Tolerance 207
Feature Selection 205, 209
Feature Tolerance 208
Object Information 205
Object Selection 205
Separate Touching Objects 206
Tracking 207
Training 204
Wavelet Processing 204
XY Brush Size 203

Object Information
Object Counting/Tracking 205

Object Selection
Object Counting/Tracking 205

Object Tab
Dynamic SubVolumes 138
XY-Montaging 137
Z-Montaging 138

Oblique menu 76
Oblique Slice frame 91

Display Oblique Slice 91
Oblique Tab 91
Off 82
Offset 38, 40, 41
Open 145
Open an Image

one optical slice warning 146
Opening an Image 145
Operation Settings

Files 65
Operations frame of the Image Macro 130
Opposite Path 79
Optical Density Correction 113
Optical Density Correction (Also known as Shutter/

Lamp Flicker Correction) 113
Adverse laboratory condition 116
Arc Lamp Flicker 116
Instabilities in Power Supply 116

Optical Sections 27
Optical Slices 217
Optics

Drift 45, 46
Dust 45
Misalignments in the optics 45, 46
Optical train 45

Optics Alignment 35
Options 81
Options menu 81
Origin 92
Original View 78

Ortho Slices 89, 92
Orthogonal Slices 74, 84
Orthogonal Slices frame 88
Out-of-band noise 33
Overview

Collecting Images 35
OWNERSHIP OF SOFTWARE AND MEDIA 23

P
Page Setup 65
Parallel Slice 92
Performing Image Enhancements 103
Perspective View 82, 87
PGM (*.pgm) 59
Phase content expected 217
Photobleaching 32, 41
Photomultiplier 30
Piecewise Line 199
Pixel Sizes 48
Planeoffocus 27
Play Movie 77
Playing a Movie 57
Point Spread Function 27, 32
point-spread function 215
Poisson Modeling 33
poor signal-to-noise 216
Pre-amplifier Bias 45
PreProcessing Menu

Attenuation Correction 114
Crop 109
Depth Attenuation 114
Optical Density Correction 114

Preset Views frame 90, 91
Probe 79
Probe Concentration 34
Processing an Image 147
Processing Current Slice 156
Processing Many Data Sets 34
Processing Stack 157
Projection 85

Image Alignment 122
Projection menu 75
Properties Group 87
PSF

Experimental Measurement 32
Missing Cone 33

PSF Compensation 147

Q
QuantumPhoton Noise 31
Quick Movies 77

R
R0 180
Ratiometrics 183
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B(SI2/Sh2) 184
Gaussian Smoothing 185
Grynkiewicz Equation for Ion Concentration 183
Kd 184
Rmax 183
Rmin 184
Viscosity 185

Rayleigh Depth Of Field 37
Rayleigh Width 31, 37
Red Channel 106
Refractive Index 37, 134, 142, 153
Remove

Import multi channel data 61
Remove Label 196
Render Range (Maximum, Minimum) 86
Rendering 65, 84
Reposition

Manual Alignment 123
Reset

Isosurface 99
Resize

Manual Alignment 123
Resize Factor 113
Resize Methods 113
Resizing an Image 112
Resolution 33
Resolution Improvement 33
Results Dialog box 148
Reverse 80
Reverse Document Contrast 117

(Different from Invert) 117
Rmax

Ratiometrics 183
Rmin

Ratiometrics 184
Rock Mode 78, 95
Rotate 76, 89
Rotate Object frame 90

Axis 90
Rotate X Axis 78
Rotate Y Axis 77
Rotated Volume 80
rotating morph 175
Rotation

Manual Alignment 123
Rotation Tab 89
Roughness Penalty 137
RS-170 Cameras 40, 46

S
Sample

Depth 37
Nonhomogeneity 32
Refractive index 32

Saturated Image 39
Saturated Pixels 41
saturated portions 216
Saturated Regions 38
Saturation

Detection 39
Save All Labels For Backup 198
Save As 58
Save Current 85
Save Current Settings As 66
Save Current View 59
Save menu 80
Save Segmentation/Selected Labels as an Image 199
Saving a Processed Data Set 150
Saving Individual Channels As Separate Stacks 58
Scan

Actual Axial Distance of 36
Reversing Direction 45
Thickness of the Scan 37
Top and Bottom 36

Screen 76
Search for Help On 214
Segment 190
Select all

Import multi-channel data 60
Select data

Import multi-channel data 60
Select Region 108
Selecting a Region Of Interest 146
Separate Touching Objects

Object Counting/Tracking 206
Set End Point 78
Set Mid Point 78
Set Start Point 78
Set Step Angle 78
Setting the Exposure, Gain and Offset 38
Setting the Top and Bottom of the Sample, and of the

Scan 36
Setting the Top and Bottom of the Scan 37
Settings/Stereo Tab 97
Setup 17
Shadow

Isosurface 100
Shock

Control 51
Sources 51

Single View 67
Skip Slices 69
Slice by Slice Cropping 110

All Slices 110
Slice by Slice 110
Slice Range 110

Slice Control
Manual Alignment 123
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Slice Status Box
Manual Alignment 123

Slice Viewer 110, 169
Smoothed raw image 140
Smoothing Factor 147
Software

Copying Restrictions 22
Duplication 25

Software License Agreement 22
SOFTWARE USE RESTRICTIONS 23
Spacing (Microns) 63
Spatial Calibration 48
Specified Cross Talk

FRET 179
Standard Settings 133

Save Interval 135, 142
Total Iterations 135, 142
X-Spacing 64
Y-Spacing 64
Z-Spacing 64

Start 160
Statistical Information displayed 200
Statistical Optimality 33
Statistics 200
Step Angle 94
Stereo Mode 82
Stereo View 70, 87
STK (*.stk) 59
Stop Movie 77
Sub-resolution Microspheres 32
Subtract Background

FRET 179
Subvolume 88, 89, 92
Subvolume frame 87
Sub-Volume Overlap 139
Subvolume Tab 87
Sum Projection 167
Super Res Factor 147
Surface Area and Volume 201

Segmented 201
Slice Viewer 201

T
Table of Parameters 220
Table of Z Spacings (Z Step Sizes) 219
TERM 25
TERMINATION 24
The Brightness and the Darkness values 104
The Output File Format 136
The Region Selection Tools(Shape tools) 108
The Save Interval

Rules of Thumb 136
Three Dimensional Line Lengths 200
Thresholds

Isosurface 100
TIFF (*.tif) 59
Tile Horizontally 213
Tile Vertically 213
time-lapse 215
Time-Series Movie 173
Total Iterations 135, 147
Tracking

Object Counting/Tracking 207
Training

Object Counting/Tracking 204
TRANSFER RESTRICTION 24
Trans-Illumination Lamp 46
Transparency 87
Triple View 68
Tutorials for File Menu Items 56
Tutorials for PreProcessing Menu Items 108
Tutorials for the View Menu Items 67
Tutorials for Visualization Menu Items 167
Two Views

Image Alignment 122

U
Undo

Manual Alignment 123
Undo Label 194
Uninstalling 20
United States copyright laws 22
Unsaturated Image 39
Update

AutoUpdate 214
US and International laws 22
US GOVERNMENT RESTRICTED RIGHTS 25

V
Vibration Control 35, 50
Vibration Sources 51
Vibrations

Air table 50
Anti-Vibration Table 50
From Cooling Fans 51
Relative Motion 50
Shock 51

Video Gain 40
Video-Rate CCD 128
View 67, 73

XY 67
XZ 67
ZY 67

View menu 73
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